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USB-CPLD DEVELOPMENT SYSTEM MEGAPROLOGIC
User Manual

The EPT MegaProLogic development system provides an innovative method of
developing and debugging programmable logic code. It also provides a high speed data
transfer mechanism between an Arduino board and a host PC. The MegaProLogic
development system provides a convenient, user-friendly work flow by connecting
seamlessly with Intel’s Quartus Prime software. The user will develop the code in the
Quartus Prime environment on a Windows Personal Computer. The programmable
logic code is loaded into the CPLD using only the Quartus Prime Programmer tool and
a standard USB-C cable. The Active Host SDK provides a highly configurable
communications interface between Arduino and host. It connects transparently with the
Active Transfer Library in the CPLD code. This Active Host/Active Transfer
combination eliminates the complexity of designing a USB communication system. No
scheduling USB transfers, USB driver interface or inf file changes are needed. The EPT
USB-CPLD development system is a unique combination of hardware and software.

Circuit designs, software and documentation are copyright © 2023, Earth People

Technology, Inc

Microsoft and Windows are both registered trademarks of Microsoft Corporation.
Altera is a trademark of the Altera Corporation. All other trademarks referenced herein
are the property of their respective owners and no trademark rights to the same are
claimed.

http://www.earthpeopletechnology.com
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1 Introduction and General Description

The Earth People Technology USB-CPLD development system hardware consists of a
High Speed (480 Mb/s) USB to Serial bus chip and a CPLD. The USB interface
provides both JTAG programming of the CPLD and a Serial Communications transfer
path. The software consists of the Active Host SDK for the PC. The firmware includes
the Active Transfer Library which is used in the CPLD to provide advanced functions
for control and data transfer to/from the Arduino.

THE EARTH PEOPLE TECHNOLOGY USB CPLD
DEVELOPMENT SYSTEM

ACTIVE HOST

e S
ACTIVE HOST SDK
ENDTERMS e

ACTIVE TRANSFER ARDUINO CODE
LIBRARY USERS CODE
USERS CPLD CODH COMMUNICAES
COMMUNICATES WITH CPLD
WITH HOST USIN
ENDTERMS

The user’s Arduino code is developed to perform particular functions required by the
user (such as reading a temperature sensor). The code is downloaded to the
microcontroller using the Arduino IDE system provided as part of the microcontroller
development system. The MegaProLogic USB-CPLD Development System allows
users to write HDL code (either Verilog or VHDL) that will implement any digital logic
circuit. The user’s HDL code is compiled and synthesized and packaged into a
programming file. The programming file is programmed into the CPLD using the JTAG
channel of the USB to Serial chip, the FT2232H.The Active Host SDK contains a dll
which maintains device connection, polling, writes and includes a unique receive
mechanism that automatically transfers data from MegaProLogic when data is ready. It
also alerts the user code when the dll has stored the transfer and the data is available to
the software GUI (graphical user interface). Users do not need to interface with the
USB Host Driver or any Windows drivers. They need only to include the Active Host
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dll in their projects. The Active Transfer Libraries must be included in the CPLD
project to take advantage of the configurability of the Active Host SDK. All of the
drivers, libraries, and project source code are available at
www.earthpeopletechnology.com .

1.1 Test Driving the Active Host Test Application

The MEGAPROLOGIC board comes pre-loaded with the EPT_Transfer_Test HDL
project in the CPLD. This project allows the user to test out the functions of the Active
Host API and the board hardware.

9« | CUlly\Products\Earth Peaple Technelogy\MEGAPROLOGIC_USB_CPLD_PROJECT_4.0_DVD\Projects_Active

olly » Products » Earth People Technology * MEGAPROLOGIC_USB_CPLD_PROJECT 4.0_DVD » Projects_ActiveHost_B4Bit » EPT Transfer_Test » EPT Transfer_Test > bin » x64 » Debug

® O Mame Date madified

To test drive the application, connect the MegaProLogic to the Windows PC using Type
A to USB-C cable. Load the driver for the board. See the section EPT Drivers for
instructions on loading the MegaProLogic driver. If the USB driver fails to load, the
Windows OS will indicate that no driver was loaded for the device.

Next, open a Windows Explorer browser. Browse to the
Projects_ActiveHost_64Bit\EPT_Transfer_Test\EPT_Transfer_Test\bin\X64\Debug\
folder on the MEGA_USB_CPLD_PROJECT_4.x_DVD. The application should load
with a Windows form.

Page



http://www.earthpeopletechnology.com/

@ TEAR'I;HPE|C)PLE
& B n o o g vy

USB CPLD Development System User Manual

8} EPT_Transfer_Test - (m] p g
[ ~] [ Open
Dis-Connected
Transfer Controls LED Controls
Send Byte: | 255 Address [ 2|  Receive Bite LED's
= LED 1 LED 1 LED 1
Green Red Blue
= o LED 2
Multiple Byte: 55 88 LED 2 LED 2
Green Red Bloe
LED3 LED3 LED3
Green Red Blue
PushButton Controls Slide Switch
Switches Siide Slide LED 4 LED 4 LED 4
Switch Switch Green Red Blue
1 2
GPIO Controls

OK Cancel

With the application loaded, select the EPT Serial Communications x board from the
dropdown combo box.
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o) EPT_Transfer_Test - [m] X
] Open
PTITAG Blaster 0 3
EPT Serial Communications 0 Dis Connected
Traks BT . LED Controls
4 LED's
Send Byte: [ 255] Address | 2|  Receive Bjte
LED1 LED1 LED1
Green Red Blue
LED 2
Muttiple Byte: 55 88 LED 2 LED 2
St Red Blue
LED3 LED3 LED3
Green Red Blue
PushButton Controls Slide Switch
Switches Slide Slide LED 4 LED 4 LED 4
Switch Switch Green Red Blue
1 2
GPIO Controls
Hi
Lo

O Infinite
@® Single

OK Cancel

Next, click on the Open button.
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a5l EPT_Transfer_Test - m] X

EPT Serial Communications O

Dis-Connected
Transfer Controls LED Controls
3 LED's
Send Byte: | 255 Address | 2|  Receive Byte
- LED 1 LED 1 LED 1
4 Green Red Blue
5 LED 2
Multiple Byte: 55 88 LED 2 LED 2
Green Red Blue
LED 3 LED 3 LED 3
G Red Bl
PushButton Cortrols Side Switch el > =
Switches Slide Slide LED 4 LED 4 LED 4
Switch Switch Green Red Blue
1 2

GPIO Controls

O Infinite
@ Single

OK Cancel

The “Device Connected” label should be seen to indicate the Windows App is now
connected to the MegaProLogic.
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o5l EPT_Transfer_Test = m] X
EPT Serial Communications 0 v e Close
Transfer Controls LED Controls
2 LED:
Send Byte: Address Receive Byte y
o LED 1 o LED 1 on LED 1
Byte N | Green | | Red Biue
3 LED 2
Mutiple Byte: LED 2 LED 2
On | Green |On | poy“ |On | goo
Multi Byte Rt
o LED3 o LED3 on LED3
" | Green ™ | Red Blue
PushButton Controls Slide Switch
Switches Slide Slide LED 4 LED 4 LED 4
Swich | - _| Swich On | Green |O" | Red O | Bue
1 2
Rst Read Rst Blinky!
GPIO Controls
Start Al
|+ |HE]

O Infinite
@ Single

Click on one of the LED buttons in the middle of the window. The corresponding LED
on the MegaProLogic board should light up.
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o) EPT_Transfer_Test - m] X
IEPT Serial Communications 0~ ‘ Ope: Close
Device Connected
Transfer Controls LED Controls
Send Byte: Address Receive Byte LEDS
LED 1 0 LED 1 LED 1
Byte On | Green [O" | Red |7 | Bie
g LED 2
Mutiple Byte: LED 2 LED 2
On | Green|[OF | |req * |00 | Boe
Muti Byte =
o on]| LED3 LED3 [ | LED3
" | Green " | Red Blue
PushButton Controls Slide Switch
Switches Slide Slide LED 4 LED 4 LED 4
Swtch | - _ | Switch On | Green [O7 | Red || Bue
1 2
Rst Read Rst Blinky!
GPIO Controls
Start = = IR
oE Lo
O Infinite n
@® Single

STECHNOLOG : 1} =
.-' EPT-SMST-AP-M " 2 i - Sl

= 3 - R0 |

/0 YoLT 4 =

OK Cancel

i

iiimli““‘

CACICCR

®
®
®
®
®
LJ
®
®
®
®
®
®
L)

(1] 1/0 voLT
- L& SELECT

for
)
®
©
O
©
®
®©

Clink on the Blinky button for a light show.
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a5 EPT _Transfer_Test - [m] X

|EPT Serial Communications 0+ Close
Device Connected
Transfer Controls LED Controls
Send Byte: [ 25| Address [2]  Receive Byte ' Lo
. LED1 LED1 LED1
Byte On | Green On Red |07 | Blue
[ LED 2
Mutiple Byte: |55 88 LED2 LED2
L On  Green On | pi” On | g0
Mutti Byte Rst
LED3 LED3 LED3
On Green O Red On Blue
PushButton Controls Slide Switch
Switches Slide Slide LED 4 LED 4 LED 4
Swich .| Swtch On | Green |07 | Red | O" | Bue

To exercise the Single Byte Transfer EndTerm, click the “Byte” button in the Transfer
Controls group. Type in several numbers separated by a space and less 256 into the
Multiple Byte textbox. Then hit the Multi Byte button. The numbers appear in the
Receive Byte textbox.
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o EPT Transfer Test - o X 85 EPT Transfer Test — O X
EPT Seal Commurvcations 0 Cose EPT Serial Communications 0 v s
Devce Comected Device Connected
Transter Controls LED Cortrols Transfer Controls LED Controls
Send Byte: | 255 Address | 2|  Receive Byte e Send Byte: | 255| Address [ 2| | Receive Byte |. 255 L
LED1 LEDY LED1 LED1 LED 1 LED1
O | Geen |0 | Red O | Bue O | Gren || Red |00 | Bue
ED2 LED2
Mutple Byte: [55 82 - LED2 LED2 Mutiple Byte: LED2 LED2
On | Gren On | pig® On | pod On | Gren |OFf | p2g%|On | goo
M Bte = Mt Byte =
&) 2 (o] 2 ] 22 (] 2 ]
PushButton Controls Side Swich PushButton Controls Side Swich
Swtches Sude Side LED4 LED 4 LED4 Switches Side Side LED 4 LED 4 LED 4
Swech Swich O | Gren |97 Red || Bue Swich | - | Swich O | Green |0 Red |0
1 2 1 2
Ret Resd Rt Binky! Rt Read st Binky!

GPIO Controls
Statt

O Infinte
@© Singe

oK Cancel

To exercise the Block Transfer EndTerm, click the “Start” button in the GPIO Controls
group. The MegaProLogic will sample the state of each Input pin of the CPLD that is

connected to a board edge connector. The Transfer Test Window will display the results
of each pin, Hi or Lo
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85! EPT_Transfer_Test - o X
|EPT Serial Communications 0 | Close
Device Connected
Transfer Controls LED Controls
Send Byte: | 255| Address | 2|  Receive Byte 2
— T o LED1 LED1
Byte On | Green |On ;E(?‘ On | Bue
] LED 2
Mutiple Byte: |55 88 LED 2 LED 2
l On | Green On Red On Blue
Muti Byte Rst
LED3 LED 3 LED3
On Green On Red On Blue
PushButton Controls Slide Switch
Switches Slide Slide LED 4 LED 4 LED 4
Swtch Swich O | Gren |O" | Red | O" | Bue
1 2
Rst Read Rst Blinky!
A H
{1+ BT

The results of each pin are displayed next to the image of the MegaProLogic in separate
buttons.
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85! EPT_Transfer_Test

- ] X
{EPT Serial Communications 0 Close
Device Connected
Transfer Controls LED Controls
Send Byte: 255! Address D‘ Receive Byte LED's
— - LED 1 LED 1
Byte On | Green On lﬁid?] On | Bue
[ecega LED 2
Muttiple Byte: |55 88 LED 2 LED 2
l ] On | Green (On | p=y“|On | pgoo
Multi Byte Ret
LED3 LED3 LED3
On Green On Red On Blue
PushButton Controls Slide Switch
Switches Slide Slide LED 4 LED 4 LED 4
Switch | . . Switch On | Green |97 | Red |O" | Bue
1 2
Rst Read Rst Blinky!
GPIO Controls
AAANAARNARN AR AR nn
m oy
B L

fif o 5 55 Goe PO

— e 44444
EJ_ ’F ¢ v‘ C ' €

*"*—-:lT i SELECT o | i
@‘ e b
b wisi 3% U yowry s v fiiiiiid a0 s

OK Cancel

Use a jumper cable to connect between +3.3V and any of the Input pins to see the
display detect a high on the selected pin.
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20000

cecopr000

OPL!
TECHNOLOGY

EPT-SNS7-AP-M

o) EPT_Transfer_Test - m} X
iEPT Serial Communications 0 v Close
Device Connected
Transfer Controls LED Controls
Send Byte: | 255 Address [ 2|  Receive Byte LED
7 = LED1 LED1
Byte On | Green On hig‘ On | Bue
| LED2
Muttiple Byte: |55 88 LED 2 LED2
L H On | Green On 4" |On | goo
Mutti Byte Rst
On LED3 On EESJ On léife)J
PushButton Controls Slide Switch
Switches Slide Siide LED4 LED 4 LED4
Swich | - .| Swich On | Green |9 | Red |07 | Bue
Switch 2 1 2
Pressed
Rst Read Rst Blinky!
GPIO Controls
AARNAARAARN AAAAARAARN AN
m oy
[+ T

1 10 voLT
o o g i STLLCT
—

OK Cancel
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Click on the “Infinite” radio button and “Start” to see a simple logic analyzer.
[m} X

o) EPT _Transfer_Test -

EPT Serial Communications 0 v Close
Device Connected
Transfer Controls LED Controls
Send Byte: [ 255] Address | 2|  Receive Byte LED's
. . LED1 LED1 LED1
Byte On | Green On Red On | Bie
] LED 2
Mutiple Byte: |55 88 LED 2 LED 2
L J On | Green On | pli® On | g0
Muti Byte Rst
LED3 LED3 LED3
On | Green (9" | Red |97 | Bue
PushButton Controls Slide Switch
Switches Slide Slide LED4 LED4 LED 4
Swtch | .| Swich On | Green |97 | Red |7 | Bue
Switch 2 1 2
Pressed
Rst Read Rst Blinky!
GPIO Controls
AAAAAAARN AARAAARAARN AR
oy
|+ [NT]

OK Cancel

Press the PCB switches on the MegaProLogic to view the Switch Controls in action.
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85! EPT_Transfer_Test - [m] X

|EPT Serial Communications 0 | Close
Device Connected
Transfer Controls LED Controls
Send Byte: | 255] Address [ 2]  Receive Byte LD
— : LED 1 1 LED 1
Byte On | Guen O | Red ' |00 ] Bie
(55 7 1 LED2
Muttiple Byte: (55 88 LED2 LED2
L | On | Green On pi” On | pgoo
Muti Byte =
LED3 LED3 LED3
On Green On Red On Blue
PushButton Controls Side Switch
Switches Side Side LED 4 LED4 LED 4
Swich | _| Swich O | Geen |97 | Red |97 | Ble
Switch 2 1 2
Pressed
Rst Read Rst Blinky!
GPIO Controls
AMAANANARANARN ARNAARAARNARN nn
"
L

OK Cancel

Page

17



@ !EAR'I;HPE|OPLE
& 6 n o o g vy

USB CPLD Development System User Manual

1.2 MEGAPROLOGIC

The MegaProLogic board is equipped with an Altera 5M570 CPLD; which is
programmed using the Quartus Prime Lite software. The CPLD has 570 Logic Elements
which is equivalent to 440 Macrocells. An on board 66 MHz oscillator is used by the
EPT Active Transfer Library to provide data transfer rates of up to 0.1 Mega Bytes per
second. Thirty Two I/0O’s from the CPLD are attached to five 8 bit transceivers to
provide 5 Volt compatible I/0’s. These 74LVVC245 bidirectional voltage translator/bus
transceivers are controlled by one enable and direction bit per transceiver. This means
the direction of the individual bits of each transceiver cannot be selected; the direction
is selected for all eight bits per transceiver. There are four RGB LED’s, two Slide
Switches, two PMOD Connectors and two Push Buttons that are controllable by the
user code. The hardware features are as follows.

Intel 5SM570 in the TQFP 100 pin package

FT2232H USB to Serial Interface chip

66 MHz oscillator for driving USB data transfers and users code

Five 74LVC245 bidirectional voltage translator/bus transceiver

32 user Input/Outputs
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e Four RGB LED’s accessible by the user

e Two PCB switches accessible by the user

e Two Slide Switches

e Two PMOD Connectors

e All connectors to stack into the Arduino 2560 Mega

MEGA BLOCK DIAGRAM

—l

T
—\| snzarvcazasa |/A—\
8BITBUS
T LEVEL \,_|/
g\ SN74LVC4245A TRANSLATOR
s ot 6 36 PIN
m ]  LeveL DIR_6 HEADER
emavs | SN74Lvca2asa TO TRANSLATOR
e LEVEL T
TRANSLATOR =
o4
DIR_4
| |
| 8BITBUS PMOD 2
1 1 —_ —
FT245 BUS -
o : | =
(I | —
FT2232H I\ SN74LVC4245A 10 PIN
S e 8BITBUS 8 BIT 5V COMPATIBLE
TO HOST/PC {158 ussom | USB \ TAGSIGNATS / LEVEL /| HEADER
EoNn; ‘ TRANSLATOR
vBus o1
s —t
EEPROM f—— DR
. S
| 3 ?
33 EE 171 |
| — m |
——————\| sN74LVCa2a5A 8PIN
33V [LW 8BITBUS LEVEL 8BITSVCOMPATIBLE ) -\ DER
ALTERA _— TRANSLATOR
b or2
5VT03.3V 5VTO1.8V T 5M570 e
POWER POWER oscillaror———1F cPLo """ TO ARDUINO
| SUPPLY SUPPLY
| c,:v,:‘;‘:l Y
HEADER 8 PIN
8BITBUS SN74l|.:‘::E4LZ45A 8 BIT 5V COMPATIBLE HEADER
SML-LX0404 TRANSLATOR
| CHIP —or3
@ DIR_3
| SML-LX0404 8BITBUS PMOD 1
CHIP
e
7
SML-LX0404
CHIP
@ L SWITCHES
SML-LX0404 -
CHIP
@ .
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PMOD

SLIDE CONNECTOR
SWITCHES

ARDUINO CONNECTORS

ARDUINO
,,,,, { Y ¥ ® - CONNECTOR
y # L G

USB TO : T O .....
SERIAL CHIP : .

66MHZ i F - o Eoncfita
OSCILLATOR . £

PUSH
BUTTON
RGB LEDS

1/0 VOLT

PMOD
SELCT ARDUINO CONNECTORS

CONNECTOR

1.2.1 Serial USB Communications

The MegaProLogic USB-CPLD Development system connects an FT2232H Dual High
Speed USB (480 Mbits/sec) chip to the CPLD. The CPLD uses a dedicated channel on
the FT2232H for high speed transfers to the PC. Using the EPT Active Transfer
Library, sustained speeds of 0.1 Mbytes/sec can be achieved. The transfers are bi-
directional.

The FT2232H chip provides a means of data conversion from USB to serial/ parallel
data and serial/parallel to USB for data being sent from the CPLD to the PC. Channel A
is configured as a JTAG bus and Channel B is configured as a single COM Port. CPLD
Programming commands are transmitted via the JTAG bus (channel A). Channel B has
one dual port 4Kbyte FIFO for transmission from Host PC to the CPLD, it also has one
dual port 4Kbyte FIFO for receiving data from the CPLD to the Host PC.
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SERIAL COMMUNICATIONS PATH

— 7/ \

A el
( UART BUS

I | [

—2BP oy pro3aH

UsB ALTERA5M570 CPLD
USB INTERFACE
CONN USBDM

\ JTAG SIGNALS

The Serial Communications with the MegaProLogic is handled easily using the Active
Host API. The Active Host SDK is provided as a dll which easily interfaces to
application software written in C#, C++ or C. It runs on the PC and provides transparent
connection

MEGA

HOST APPICATION 5M570 CPLD

TRIGGER
ENDTERM

TRANSFER
ENDTERM

BLOCK ENDTERM

ACTIVE
TRANSFER
LIBRARY

TRIGGER ENDTERM

ACTIVE <': UsB

=
Hasy DRIVER [\Z2BE

DLL

TRANSFER ENDTERM

BLOCK ENDTERM

it

from PC application code through the USB driver to the user CPLD code. The user code
connects to “Endterms” in the Active Host dll. These Host “Endterms” have
complementary HDL “Endterms” in the Active Transfer Library. Users have seamless
bi-directional communications at their disposal in the form of:

e Trigger Endterm
e Transfer Endterm
e Block Endterm

User code writes to the Endterms as function calls. Just include the address of the
individual module (there are eight individually addressable modules of each Endterm).
Immediately after writing to the selected Endterm, the value is received at the HDL
Endterm in the CPLD.
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1.2.2 Host PC Connection
The MegaProLogic includes an LED that signifies the connection of the board with the
Host PC. The connect LED has the word “CONNECT” in silkscreen next to the LED.
This LED will only light up once the Host PC has correctly enumerated the USB
device (FT2232HQ chip). When this LED is lit up it can tell the user three things:

e Power has been applied to the MegaProLogic via USB

e The FT2232HQ chip is working properly

e The Host PC has found the appropriate driver and will communicate with the

MegaProLogic
CONNECT LED

0 L

i ) EPT-SMST- AP
e 2 vl
= :::

<, G (T

10NN T2 7= T )

1.2.3 PMOD Connectors

The MegaProLogic includes two PMOD Connectors. These two connectors are located
towards the rear of the board.
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PMOD 2
CONNECTOR

[UEE— |

~44§ﬂ‘ .

TECHNO LOG
| EPT-5M57-AP-M"
el 3 A
2 E oul
= LIOMONTE
* o
CP - i'.!':\"‘:
e (XS
<3V || POWER 8 _
b |

PMOD 1
CONNECTOR

The PMOD pinouts follows the standard pinout. Pin 1 is located in the upper right when
facing the connector.

VCC GND 8 signals

VCC is +3.3V and the Inputs and Outputs of the 8 signals are +3.3V only. The eight
I/O’s are connected directly to FPGA pins and can be designated as any
communications standard.
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PMOD
I2C Type1 Type2 Type3 Typed

The PMOD have the following connections to the MAX 'V chip:
PMOD Pin Number Signal Name MAX V Pin Number
1-1 LB31 69
1-2 LB29 67
1-3 LB27 64
1-4 LB25 61
1-7 LB30 68
1-8 LB28 66
1-9 LB26 62
1-10 LB24 58
2-1 LB39 84
2-2 LB37 82
2-3 LB35 78
2-4 LB33 76
2-7 LB38 83
2-8 LB36 81
2-9 LB34 77
2-10 LB32 75

1.2.4 Inputs and Outputs

There are 32 Inputs/Outputs which are selectable between +3.3V and +5 Volt. IMP1 is
used to select which voltage the 32 Inputs/Outputs are set to.
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1/ovoLT
SELCT

The 1/0’s are organized as three 8 bit directional ports. Each port must be defined as
input or output. This means that all 8 bits of a port will point in the same direction,
depending on the direction bit of the transceiver. The direction bit can be changed at
any time, so that a port can change from input to output in minimum setup time of 6
nanoseconds. Each port also has an enable pin. This enable pin will enable or disable
the bits of the port. If the port is disabled, the bits will “float”.

1.2.5 User LEDs

The User LEDs are four RGB LEDs. These LEDs are SML-LX0404 chips and are for
use only with +3.3V.
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13 e 8
] E
o

/0 VOLT

‘;___" it
g1 ) (2
——i H

3.3V —I [PONER &

RGB LEDS

The SML-LX0404 chip is a current sink and are connected to pins on the MAX V
CPLD. The anode is connected to +3.3V. The series resistors are calculated for current
limiting based on +3.3V.

Aa7O CELD SML-LX0404

CHIP

PXX ARA__ G N

PXX _J\/\/\,_B_MJ

Each series resistor uses a 220 Ohm in a resistor array. In order to light up the each
LED, the user code must assert a zero on the associated signal for the LED. To turn off
the LED, assert High Z on the signal.
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The LED RGB signals are organized on the following pins from the MAX V chip:

LED Number Signal Name MAX V Pin Number
D1 LED GREEN 1 N 57
D1 LED BLUE 1 N 56
D1 LED RED 1 N 55
D2 LED GREEN 2 N 54
D2 LED BLUE 2 N 53
D2 LED RED 2 N 52
D3 LED GREEN 3 N 51
D3 LED BLUE 3 N 50
D3 LED RED 3 N 49
D4 LED GREEN 4 N 48
D4 LED BLUE 4 N 47
D4 LED RED 4 N 43

1.2.6 User Push Buttons

The MegaProLogic includes two push button switches. Both are momentary contact
switches. They include a 1uF cap to ground to debounce both switches.

1
I

Page
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PUSHBUTTON
SWITCH 1

-------------

.......

...........

i I
PUSHBUTTON
SWITCH 2

Component Net Name Pin on CPLD Signal in EPT
Project Pinout

Swi1 SW_USER_1 20 SW _USER_1

SW2 SW_USER_2 21 SW_USER_2

1.2.7 Slide Switches

The MegaProLogic includes two slide switches. Both are full contact switches. They
include a 1uF cap to ground to debounce both switches.
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SLIDE SWITCHES

PR e 75

CHNOLOGY

13
B EPT-SM57-AP-M"
2 E el

“— i SELECT
. e SELEC .

i

/0 VOLT

e . w
=
3.3V |

» wiponer 8 1*]il]

| e == |\
| Dt

Component Net Name Pin on CPLD Signal in EPT Project Pinout
SW3 SLIDE_SWITCH 1 | 16 SLIDE_SWITCH_1

SW4 SLIDE_SWITCH 2 | 17 SLIDE_SWITCH 2

1.2.8 JTAG

The MegaProLogic uses the second channel of the FT2232H chip as a dedicated CPLD
programming port. The CPLD must be programmed via JTAG signals and the
FT2232H has built in JTAG signals. The CPLD can be programmed directly from
Quartus Prime Lite by using the “jtag_hw_mbftdi blaster.dll”. Just click on the
Programmer button and select the EPT-Blaster.
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FT245 BUS

USB DP

USB FT2232H
CONN USB DM USB INTERFACE ALTERA 5M570 CPLD

I —d

JTAG PROGRAMMING PATH

JTAG SIGNALS

1.3 Active Host EndTerms

The Active Host SDK is provided as a dll which easily interfaces to application
software written in C#, C++ or C. It runs on the PC and provides transparent connection

HOST APPICATION HOSTOS | 5M570 CPLD

ACTIVE

USER APPLICATION TRIGGER
ENDTERM TRANSFER

Cit WINDOWS FORM LIBRARY

|
|
|
ACTIVE |
C++ CONSOLE TRANSFER b uss | \
C CONSOLE ENDTERM i HDOLSLT \‘—[‘/ DRIVER USBBﬁV TRANSFER ENDTERM

TRIGGER ENDTERM USER CODE

~ 8BITDATABUS

6 BIT CONTROL BUS

|

BLOCK ENDTERM , : BLOCK ENDTERM
|
|

from PC application code through the USB driver to the user CPLD code. The user code
connects to “Endterms” in the Active Host dll. These Host “Endterms” have
complementary HDL “Endterms” in the Active Transfer Library. Users have seamless
bi-directional communications at their disposal in the form of:

e Trigger Endterm
e Transfer Endterm
e Block Endterm

User code writes to the Endterms as function calls. Just include the address of the
individual module (there are eight individually addressable modules of each Endterm).
Immediately after writing to the selected Endterm, the value is received at the HDL
Endterm in the CPLD.

Receiving data from the CPLD is made simple by Active Host. Active Host transfers

data from the CPLD as soon as it is available. It stores the transferred data into circular
buffer. When the transfer is complete, Active Host invokes a callback function which is
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registered in the users application. This callback function provides a mechanism to
transparently receive data from the CPLD. The user application does not need to
schedule a read from the USB or call any blocking threads.

1.4 Active Transfer EndTerms

The Active Transfer Library is a portfolio of HDL modules that provides an easy to use
yet powerful USB transfer mechanism. The user HDL code communicates with
EndTerms in the form of modules. These EndTerm modules are commensurate with the
Active Host EndTerms. There are three types of EndTerms in the Active Transfer
Library:

e Trigger Endterm

e Transfer Endterm

e Block Endterm
They each have a simple interface that the user HDL code can use to send or receive
data across the USB. Writing to an EndTerm will cause the data to immediately arrive

TRIGGER ENDTERM

ACTIVE TRANSFER SINGLE TRANSFER
LIBRARY ENDTERM

USER CODE

BLOCK ENDTERM

at the commensurate EndTerm in the Active Host/user application. The transfer through
the USB is transparent. User HDL code doesn’t need to set up Endpoints or respond to
Host initiated data requests. The whole process is easy yet powerful.

2 EPT Drivers

The MegaProLogic Development system requires drivers for any interaction between
PC and the board. The communication between the two consists of programming the
CPLD and data transfer. In both cases, the USB Driver is required. This will allow
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Windows to recognize the USB Chip and setup a pathway for Windows to
communicate with the USB hardware.

2.1 USB Driver

The MegaProLogic uses an FTDI FT2232H USB to Serial chip. This chip provides the
USB interface to the PC and the serial/FIFO interface to the CPLD. The FT2232H
requires the use of the EPT USB driver. To install the driver onto your PC, use the
CDM212xxx Folder. The installation of the FTDI 2.12.28 driver is easily accomplished
by double clicking the CDM21228_Setup.exe.

Locate the CDM212xxx folder in the Drivers folder of the MegaProLogic Development
System CD using Windows Explorer.
; 9 =

Home Share View

« v » ThisPC » Windows (C:) » Jolly » Products » Earth People Technology » UNOPROLOGIC_USB_CPLD_PROJECT 4.0.DVD » Drivers
UNOPROLOGIC_USB_CPLD_PROJECT_4.0_DVD ~ ] Mame -
Documentation CDM212364
Drivers EPT_Blaster

CDM212364

EPT_Blaster
Projects_ActiveHost_64Bit

ActiveHost_1.0.0.11

EPT_Data_Acquistion

UnoProbyzer
EPT_Data_Collector
EPT_Transfer_Test

NE
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% = | C\olly\Products\Earth People Technology\DUEPROLOGIC_USB_FPGA_PROJECT_4.0_DVD\Drivers\EPT_Seri
home | share view
Cut "7 New item ~ ] Open Select all
] X . vi B
™ Copy path £ Easy access - Edit Select none
Pinto Quick Copy Paste Move Copy Delete Rename  New Properties
(((((( | Paste shorteut  to- o = Tolder = o Histary Invert selection
Clipboard Organize New Open Select
« A > ThisPC > Windows (C:) » Jelly > Products > Earth People Technology > DUEPROLOGIC_USB_FPGA PROJECT 40 DVD » Drivers » EPT Serial Driver v O Search EPT_Serial _Driver
v Earth People Technology A O Name

DSO_100M_DEV_SYS_PROJECT.2.2_DVD
DUEPROLOGIC_USB_FPGA_PROJECT_3.0.DVD
v DUEPROLOGIC_USE_FPGA_PROJECT 40 DVD

® CDM21228 Setup.exe

Documen tation

EPTITAG Blaster
EPT Serial Driver
Projects_ActiveHost
Projects_Arduino
v Projects HDL
EPT_4CES_AF_Data_Collector
EPT 4CE6_AF_Platform_Demo ol

Double click on the *.exe file and select the default settings when the software tool
queries the user.

Plug in the MegaProLogic device into an available USB port.

Windows will attempt to locate a driver for the USB device. When it does not find one,
it will report a error, “Device driver software was not successfully installed”. Ignore this
error.

If Windows cannot load a driver for the MegaProLogic, a notification window will
inform the user that the driver load has failed for the device.
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€

£ Search DVD RW Driv...

==\ Manage

a0 Device Manager == (eg] X

File Action View Help
cAU R 2hall ¢ ol size

v B DESKTOP-HIMPOLM -
I.i Audio inputs and outputs

I
(=N}

® Cameras
[ Computer
a Disk drives
[ Display adapters
= DVD/CD-ROM drives
i Human Interface Devices
Dvi =@ IDE ATA/ATAPI controllers
2l 1) & Jungo Connectivity
= Nef =] Ke.ybnards . :
@ Mice and other pointing devices
2items [ Monitors =
e 7 7 Network adapters B - %
K7 Other devices -
H Bl USE <> Serial Converter (]
Jil USB <-> Serial Converter
&« b ﬁ Ports (COM & LPT) Search Earth People ...

o [ |
)

[ U]

<

1 Print queues

= P Type ~

| s B ..

P
[ Processors 2 M File folder
7 Security devices

B Software devices M File folder

b i Sound, video and game controllers il File folder

M S Storage controllers I File folder

v

a . B Suctem devirec It File folder

PErvmer = = = = File folder
Perflogs UNO_SERIAL_GRAPH_TOOL_PROJECT_1.5_CD =3
s £x Setting up a device o

UNOMAX_CPLD_SYSTEM_PROJECT_2.7_DVD

UNOPROLOGIC2_USB_CPLD_PROJECT_2.6_DVD We're setting up 'Us8 <-> Serial
Program Files (x86) Converter'.

g
=

Program Files

17 items 1itermn zelected

If the driver is successfully installed, Windows will inform the user. The user can check
Device Manager to ensure the correct driver was installed for the MegaProLogic. The
MegaProLogic will show up as two COM Ports under the “Ports (COM &LPT)” under
the Device Manager.
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% Device Manager - | X
File Action View Help
= @ HE =

~ & DESKTOP-QSIQ3HI ~
Iy Audio inputs and cutputs
% Batteries
5| Biometric devices
3 Bluetooth
® Cameras
[ Computer
s Disk drives
L@ Display adapters
8 Firmware
@l Human Interface Devices

=2 Keyboards

L I Memory technology devices

w Mice and other pointing devices

[ Menitors

Ij] Network adapters

H Portable Devices

~ & Ports (COM &LPT)

§ USE Serial Port (COM1D)
W USB Serial Port (COMS)

= PTINT qUenes

= Printers

I Processors

B9 Security devices

[3 Sensors

BE Cofhware comnnnen e

When this is complete, the drivers are installed and the MegaProLogic can be used for
programming and USB data transfers.

2.2 JTAG DLL Insert to Quartus Prime Lite

The JTAG DLL Insert to Quartus Prime Lite allows the Programmer Tool under
Quartus to recognize the MegaProLogic. The MegaProLogic can then be selected and
perform programming of the CPLD. The file, jtag_hw_mbftdi_blaster.dll must be
placed into the folder that hosts the jtag_server for Quartus.

2.2.1 Installing Quartus

You can download the Quartus Prime Lite by following the directions in the Section
Downloading Quartus.

If you don’t need to download Quartus, double click on the QuartusLiteSetup-

XXX.XXX.XXX-windows .exe (the xxx is the build number of the file, it is subject to
change). The Quartus Prime Lite Edition will start the installation process.
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INTEL" QUARTUS" PRIME

Development Suite

Olnstalling Quartus Prime Lite Edition (Free) 20.1.0.711 = a X
Setup - Quartus Prime Lite Edition (Free) 20.1.0.711

Welcome to the Quartus Prime Lite Edition (Free) 20.1.0.711 Setup Wizard.

The Quartus Prime software requires that your system have sufficent physical RAM to compile designs
targeting spedific devices. You can check the "Memory Recommendations™ section in the "Quartus Prime
Software and Device Support Release Notes™

(https:/fwww.intel.com/content www/us /e g e fit-rn.html) for detailed
memory requirements for a particular device,

For more information about Intel FPGA software, go to
https://www.intel.com/content/www /us/enfproducts fprogrammable. html.

< Back Next > Cancel

When the install shield window pops up click “Yes” or if needed, enter the
administrator password for the users PC. Click “Ok”

Next, skip the “Download Quartus” section. Go down to the “Quartus Installer” section
to complete the Quartus installation.
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2.2.2 Downloading Quartus

The first thing to do in order build a project in Quartus is to download and install the
application. You can find the latest version of Quartus at:

Intel FPGA Quartus Prime Lite

You will first need to apply for an account with Intel. Then use your login and password
to access the download site. Click on the Download Windows Version.

Products Solutions Support UsA (english) @ Sienin & Q

Download Center for FPGAs

Design Software
Embedded Software Quartus Prime Lite Edition
Release date: June, 2020 - . -
Latest Release: v20.1 Ilanjtel Quartus’ Prime
Licensing esign Software

Programming Software Selact edition:

Drivers Select release:

Board System Design
. ¢
T e e Operating System @ ®/ Windows O f§ Linux
Legacy Software

& The Quartus Prime Lite Edition Design Software, Version 20.1 includes functional and security updates. Users should
keep their software up-to-date and follow the technical recommendations to help improve security. Additional security
updates are planned and will be provided as they become available. Users should promptly install the latest version upon
release.

«' The Quartus Prime Lite Edition Design Software, Version 20.1 is subject to removal from the web when support for all
devices in this release are available in a newer version, or all devices supported by this version are obsolete. If you would
like to receive customer notifications by e-mail, please subscribe to our subscribe to our customer notification mailing list.

The next page will require you to sign into your “myAltera” account. If you do not have
one, follow the directions under the box, “Don’t have an account?”
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intel' USA (English) @ Sienin & Q

By signing in, you agree to our Terms of Ser

Sign In M Remember me
Forgot your Intel username or password?
Do you work for Intel? Sign in

Don't have an Intel account? Sign up here for a
basic account.

Once you have created your myAltera account, enter the User Name and Password. The
next window will ask you to allow pop ups so that the file download can proceed.
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intel' USA (English) @ My Intel &

10 LP, Cyclone IV, Cyclone V, MAX Il, MAX V, and MAX 10 FPGA. More

Combined Files Individual Files Additional Software

Download and install instructions: More
Read Intel FPGA Software v20.1 Installation FAQ
Quick Start Guide

The Combined Files download for the Quartus Prime Design Software includes a number of additional
software components. A list of files included in each download can be viewed in the tool tip (What's
Included?) to the right of the description. The Complete Download includes all available device families.
To achieve a smaller download and installation footprint, you can select device support in the Multiple File
Download section, or select components in the Individual Files and Additional Software tabs.

Quartus Prime Lite Edition Software (Device support included) what's included?

Quartus-lite-20.1.0.711-windows.tar °
Size: 5.9 GB MD5: COC68444E85C9A1DBAF2F24A76F62680
**Nios Il EDS on V requires Ubuntu 18.04 LTS on Windows Subsystem for Linux (WSL), which
requires a al installation.
** Nios Il EDS requires you to install an Eclips

Note: The Quartus Prime software is a full-featured EDA product. Depending on your download speed,

Click on the download icon.

USA (English) @ My Intd

Quick Start Guide

The Combined Files download for the Quartus Prime Design Software includes a number of additional
software components. A list of files included in each download can be viewed in the tool tip (What's
Included?) to the right of the description. The Complete Download includes all available device families.
To achieve a smaller download and installation footprint, you can select device support in the Multiple File
Download section, or select components in the Individual Files and Additional Software tabs.

Quartus Prime Lite Edition Software (Device support included) what's included?

Quartus-lite-20.1.0.711-windows.tar 0

Size: 5.0 GB MD5: COC68444E85C9A1DBAF2F24A76F62680

** Nios Il EDS on Windows requires Ubuntu 18.04 LTS on Windows Subsystem for Linux (WS5L), which
requires a manual ins tion.

** Nios Il EDS requires you to install an Eclipse IDE manually.

Note: The Quartus Prime software is a full-featured EDA product. Depending on your download speed,
download times may be lengthy.
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This will start the download.

Products Solutions

Support

Quartus-lite-20.1.0.71...t...

0.0/5.9 GB, 32 mins left

(intel,

The Combined Files download for the Quartus
software components. A list of files included in
Included?) to the right of the description. The i
To achieve a smaller download and installation
Download section, or select components in the

Quartus Prime Lite Edition Software (Device

Quartus-lite-20.1.0.711-windows.tar
Size: 5.9 GB MD5: COC68444E85C9A1DB

** Nios Il EDS on Windows requires Ubuntu 18.04
requires a manual installation.
** Nios Il EDS requires you to install an Eclipse 1DI

MNote: The Quartus Prime software is a full-feat
download times may be lengthy.

» System Requirements

¢  Documentation Links

+ Software Support

The file is 5.9 GB, so this could take a couple of hours depending on your internet
connection. When download is complete, store the *.tar file in a directory on your PC.
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| 9 = | C\Jo yi\Downloads\Altera_Intel_FPGA\Cuartus Prime 20
Home Share View

« v s ThisPC » Local Disk (Ct) » Jolly » Downloads » Altera_Intel FPGA s Quartus Prime 20.1
Code_FPGA L MName Date modified
Documents
Th
Downloads
Allegro

Altera_Intel_FPGA
Quartus Prime 16 *
Quartus Prime 17.1
Quartus Prime 18.1
Quartus Prime 20.1

AtmosFX

Camtasia

FTDI

HyperSerialPort

E l = | C\Users\nelso\Downloads

File Home Share View

+ ‘ » ThisPC » Local Disk (C:) » Users » nelso » Downloads

[ This PC ~

MName

P 3D Objects ~ Today (1)
[ Desktop D Quartus-lite-20.1.0.711-windows.tar
5 Documents et wee T T
¥ Downloads Label-501986027.pdf
J‘! Music

. ~ Last week (1)
&= Pictures

) Label-501432798.pdf
m Videos
., Local Disk (C) v Lastmonth (18)

Use a tool such as WinZip to Extract the *.tar file.
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2 BB mv___—- te-20.1.0.711-windows - WinZip Evaluation Version - 21 days left

Unzip/Share Edit Backup Toals Settings View Help Buy Now

(e ———— i ip befor al
W ﬁlf:lc‘fatgevglﬂlp?e TOE;{QEL:;TEISMHM shop. gﬂ'*eﬂtrgﬂﬁ
Files # + . .
‘ Quartus-lite-20.1.0.711-windows.tar
< Files >

Recent Zip Files

=y Quartus-lite-20.1.0.7....tar
" | Quartus Prime 20.1

components
Type: Folder

Date rodified: 6/6/2020 6:33 PM

readme.bxt
Type: Readme Document

i Date modified: 6/6/2020 7:09 PM
Browse & Manage Files ate modifie

Size: 851 KB =+ 851KB

== F it Fold
\puuaf Trequent Fowders setup.bat
Type: Windows Batch File

Date modified: 6/6/2020 7:09 PM
Size: 1.07 KB + 1.07KB

a

[. This PC

648 GB free of 930 GB
lﬁ Network

"=y Shared Files
=

1N

Add Cloud

[ 3 item(=)

Zip Filez 11 item(s), 5.90 GB

Actions
Unzip All Files

& Unzip to: v

-Muartus-lite-20.1...

Convert & Protect Files
‘When adding files to this Zip file:

a Encrypt .
E] Reduce Photos
& Remoave Info

E‘_ Convert Photos
% Convert to PDF

&.,E Combine PDFs

_I_ ‘Watermark

The tool will unEack all files.

Extracting ModelSim5etup-20.1.0.711-windows.exe

..........................................

2.2.3 Quartus Installer

When the unpacking finishes from the previous section, double click the setup.bat file

in the download folder.
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C\Jolly\DownloadshAltera_Intel_FPGA\Quartus Prime 20.1

File Home Share View

” U oy Cut " x I % Mew item =

4 Open Bﬂsalecta\l
Edit

Wi Copy path =) Easy access - 15 Select none
Pinto Quick Copy Paste _ Move Copy Delete Rename New Properties
access E] Paste shortcut to to - falder - 43 History DD Invert selection
Clipboard Organize Mew Open Select
“ v 4 » ThisPC » Local Disk (C:) » Jolly » Downloads » Altera_Intel FPGA » Quartus Prime 20.1
Quartus Prime 16 2 MName Date modified Type
Quartus Prime 17.1 components 8/8/2020 12:58 PM File folder
Quartus Prime 18.1 . Quartus-lite-20.1.0.711-windows.tar 8/8/2020 12:25 PM WinZip File
> Quartus Prime 20.1 Text Docurment
3y AtmosFX Windows Batch File
» Camtasia
> FTDI

> HyperSerialPort

Click “Next” on the Introduction Window.
L Installing Quartus Prime Lite Edition (Free) 20.1.0.711 = O

Setup - Quartus Prime Lite Edition (Free) 20.1.0.711

Welcome to the Quartus Prime Lite Edition (Free) 20.1.0.711 Setup Wizard.

The Quartus Prime software requires that your system have sufficdent physical RAM to compile designs
targeting specific devices. You can check the "Memory Recommendations™ section in the "Quartus Prime
Software and Device Suppart Release MNotes™

(https: { fwww.intel. comjcontentfwww fus fen fprogrammable fdocumentation flit-rn.himl) for detailed
memory requirements for a particular device,

For more information about Intel FPGA software, go to
https:/fwww.intel.comfcontentwww us fen/products/programmable, html,

< Back Mext = Cancel
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Click the checkbox to agree to the license terms. Then click “Next”.

L Installing Quartus Prirme Lite Edition (Free) 20.1.0.711

License Agreement ‘ intel)

You can view the full license agreement at the link below or use —install_lic option from command-ine to get the license agreement
files before the installation. You must accept the terms of the agreement before continuing with the installation.

http: /ifpgasoftware.intel. com/eula/

QUARTUS PRIME AND INTEL FPGA IF LICENSE AGREEMENT, VERSION 20.1 ~

Intel, Quartus and the Intel logos are trademarks of Intel Corporation
or its subsidiaries in the US and other countries. Any other
trademarks and trade names referenced here are the property of their
respective owners.

DO NOT DOWNLOAD, INSTALL, ACCESS, COPY, OR USE ANY PORTION OF THE

LICENSED SOFTWARE UNTIL YOU HAVE READ AMD ACCEPTED THE TERMS AND

CONDITIONS OF THIS AGREEMENT. BY INSTALLING, COPYING, ACCESSING, OR W
£ >

(®) 1 accept the agreement
Do you accept this license?
() 1 do not accept the agreement

InstallBuilder
< Back Mext = Cancel

Click “Next” and accept the defaults.

At the Select Products Window, de-select the Quartus Prime Supbscription Edition by
clicking on its check box so that the box is not checked. Then click on the check box by
the Quartus Prime Lite Edition (Free).
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L3 Installing Quartus Prime Lite Edition (Free) 20.1.0.711

Select Components

Select the components you want to install

=3 Quartus Prime Lite Edition (Free)

Quartus Prime (includes Nios II EDS) (9313MB)
- Quartus Prime Help {508, 4MEB)

=l Devices

W Arria IT {536, 5MB)
Cydone IV (516.3MB)
. Cydone 10 LP {293.5ME)

Cydone V (1434.3MB)

[ Max 11V (13. 1ME)

- [#] MAx 10 FPGA (360.3MB)

. [] ModelSim - Intel FPGA Starter Edition (Free) (4318.8ME)
- [J Modelsim - Intel FPGA Edition (4318.8ME)

Installs Arria II device support. (536.5MB)

InstallBuilder

< Back Mext =

Cancel

Click “Next” to accept the defaults
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L3 Installing Quartus Prime Lite Edition (Free) 20.1.0.711

Ready to Install intel.

Summary:

Installation directory: C:intelFPGA_lite)20.1
Required disk space: 16760 MB
Available disk space: 657364 MB

InstallBuilder
< Back Mext = Cancel

Click “Next” to accept the defaults
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v Installing Quartus Prime Lite Edition (Free) 20.1.0.711

Installing ‘ intEI)

Wait while Setup installs Quartus Prime Lite Edition (Free) 20.1.0.711

Instaling
Unpacking files
InstallBuilder
< Back Next = Cancel
Wait for the installation to complete.
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Mailings Review View Help Y Installing Quartus Prime Lite Edition (Free) 20.1.0.711

t= 4T, A
=5 BT 4aBbC e
LE = I§ - Q - Emphag
|
=
Raragapt B | Wait while Setup installs Quartus Prime Lite Edition (Free) 20.1,0.711
! ' ) ' | Installing
Es "
S —— % Installing ModelSim - Intel FPGA Starter Edition (Free)...
* Quartud I Web FdEoe (Feee) (nchades Mod T EDS)
* HodeSm-Aken Staner E000 (Fres] bl
S ]
=) 7

St Qs 12,0

et Qpears 1l Subscrmtion License
reate Deskiog Pty

1 Guartan T Wb Esiton (Fre]) and Hios I SAT | Mios I G004 Togihan
1 ModeSmAken Statw Edton (e}

W' Installing ModelSim - Intel FPGA Starter Edition 20.1.0.711

e v

he O

Installing
Installing ModelSim - Intel FPGA Verilog model files. ..

:ation. |

DVD. |

ar to (

ets » Earth People Technology » EPT USS-CPLD Developenent Syt

inkibrary v Hew folder
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L3 Installing Quartus Prime Lite Edition (Free) 20.1.0.711 = O
Quartus Prime Lite Edition (Free) 20.1.0.711 Installation Complete

Setup has finished installing Quartus Prime Lite Edition (Free) 20.1.0.711.
Launch USB Blaster II driver installation

Create shortcuts on Desktop
Launch Quartus Prime Lite Edition
] Provide your feedback

< Back Finish Cancel

Click “Ok”, then click “Finish”. The Quartus Prime is now installed and ready to be
used.
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& Quartus Prime 20.1 Lite Edition ®

Thank you for installing the Quartus Prime software - the #1 in performance and productivity. To
upgrade to a full featured edition, please

https://fwww.intel comfcontent/www/us/en/products/programmable htmlL

Select one of the following licensing options to continue:

Select one of the following options

(O Buy a Quartus Prime software license

(O) Run the Quartus Prime software

() Add an IP license file [for users who have purchased IF)

OK Cancel

2.2.4 Adding the EPT_Blaster to Quartus Prime

Close out the Quartus Prime application. Locate the \Drivers\EPT_Blaster folder on the

EPT FPGA Development System DVD.
Home Share View

<« L » ThisPC » Local Disk(C:) » Jolly » Products » Earth People Technelogy » DUEPROLOGIC_USEB_FPGA_PROJECT 2.8 DVD » Drivers » EPT Blaster »
~ DUEPROLOGIC_USB_FPGA_PROJECT_ 2.8 DVD G Name - Date modified Type
Documentation x64 5/27/2012 8355 PM File folder
e Drivers
EPT_2.08.24

~ EPT_Blaster
x64
Projects_ActiveHost
Projects_Arduino
Projects_HDL
Quartus_18.1_Prime

Tutorials W

Follow these directions:

1. Open the
C:\..\MEGAPROLOGIC_USB_CPLD_PROJECT_x.x_DVD\Drivers\EPT_Blas
ter\x64 folder.

2. Select the file “jtag_hw_mbftdi_blaster.dll” and copy it.

3. Browse over to C:\intelFPGA _lite\xx.x\quartus\bin64.
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4. Right click in the folder and select Paste
5. Click Ok.
6. Open the Quartus Prime application.

| N B - | CAintelFPGA _lite\20.1\quartus\bin64

File Home Share View
« v s ThisPC » Local Disk (C:) » intelFPGA_lite » 20,1 » quartus » bing4
v 20.1 ~ Name Date modified Type
devdata [ jam2_apijam JAM File
ip [ ] jam2_icjam JAM File
licenses | jtag_atlantic.dll Application exten...
logs 1% jtag_client.dll Application exten...

%] jtag_hw_mbftdi_blastertd.dll
%] jtag_hw_pli-blaster.dIl

maodelsim_ase Application exten...

Application exten...

niosZeds
[ jtag_hw_usb-blaster.dll Application exten...
M quartus | jtag_pli-blaster_vpi.dil Application exten...
& b [#] jtagconfig.exe Application
cemmen [85] jtagserver.exe Application
drivers w 1% legality_lab.dll Application exten...

The DLL is installed and the JTAG server should recognize it. Go to the section
“Programming the FPGA” of this manual for testing of the programming. If the driver
is not found in the Programmer Tool->Hardware Setup box, see the JTAG DLL Insert
to Quartus Prime Troubleshooting Guide.

2.3 Active Host Application DLL

Download the latest version of Microsoft Visual C# Express environment from
Microsoft. It’s a free download.

https://visualstudio.microsoft.com/vs/express/

Go to the website and click on the “+” icon next to the Visual C# Express.
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O @ B htips;//visualstudio.microsoft.com/vs/express,

Bx * @ (s

[ CheckEmail G Google @ YouTube [ Yshoo @ GoogleMaps [ EPT [ Banks [ Electronics £ Mews [ Music 3 Pay [0 Markets [ Reference [ Knowledge [ Tickets

u Microsoft | Visual Studio  Visual Studio 2019 Features . Editions ~ Downloads  Suppert ~  More Free Visual Studio AllMicrosoft ~ 0O

Visual Studio Express

Download Visual Studio Community for a fully-featured and extensible IDE; An
updated alternative to Visual Studio Express.

Download Community 2019

Learn more about Visual Studio Community >

Click on the “Express 20xx for Windows Desktop” hypertext.

[ORE £ https://visualstudio.microsoft.com/vs/express/

[

D Check Email & Google B YouTube m Yahoo % Google Maps [F7] EFT 7 Banks [ Electronics B News [ Music £ Pay [ Markets ] Reference

Help me choose. | am a...
Choose from the options below to see what version of Visual Studio is right for you

lam a...

Still want Visual Studio Express?
Express 2017 for Windows Desktop

Supports building managed and native desktop applications.*

Express 2015 for Windows Desktop

Supports the creation of desktop applications for Windows.

The download manager file will download the “WDEXxpress.exe” file.
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O 5 https://visualstudio.microsoft.com/vs/express/

D Check Email & Google B YouTube Yahoo ) Google Maps B EPT FEJ Banks FJ Electronics B3 MNews B3 Music B Pay B Markets

Still want Visual Studio Express?
[Express 2017 for Windows Desktop

Supports building managed and native desktop applications*

Express 2015 for Windows Desktop

Supports the creation of desktop applications for Windows.

Express 2015 for Web

Create standards-based, responsive websites, web APIs, or real-time online experiences using ASPNET.

Express 2015 for Windows 10

Provides the core tools for building compelling, innovative apps for Universal Windows Platform. Windows is required.

vs_WDExpress (2).exe
Dq Cpen file

Rigﬁ click on the WDEXxpress.exe.
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Still want Visual Studio Express?

Express 2017 for Windows Desktop

Supports building managed and native desktop applications *

Express 2015 for Windows Desktop

Supports the creation of desktop applications for Windows.

Expre

Create ¢

Expre
Provide

ws_WDExpress (2)4
Cpen file

b

Open

Always open Tiles of this type sites, web APls, or real-time online

Show in folder J

Copy download link ) _ ) _
2elling, innovative apps for Univer:

Click the “Continue” button.

Visual Studio Installer

Before you get started, we need to set up a few things so that you
can configure your installation,

To learn more about privacy, see the Microsoft Privacy Statement.

By continuing, you agree to the Microsoft Software License Terms.

Continue

Next, follow the on screen windows and accept the default answers.
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L& Microsoft Visual C# 2010 Express Setup L=LE]
| == QO Visual C# 2010
Express

Welcome to the Microsoft Visual C# 2010 Express installation wizard. Microsoft Visual C# 2010
Express is a fun, simple and easy-to-learn development tool for C# programmers interested in
creating Windows Forms, Windows Presentation Foundation (WPF) as well as dass libraries and
console-based applications. This wizard will guide you through the installation process. If this
product requires any prerequisites that are not currently installed on this computer, you will be
able to install those prerequisites as well.

Help Improve Setup

You can submit information about your setup experiences to Microsoft. To
participate, check the box below.

[¥] Yes, send information about my setup experiences to Microsoft Corporation.

i) For more information, click Privacy Statement

Click “Next”, accept the license agreement. Click “Next”.

L7 Microsoft Visual C# 2010 Express Setup =) X
2 s . Micrpsoft*
en i QO Visual ¢ 2010
Express

Installation location cannot be changed. Click here for more information.

Install in folder:

C:\Program Files

| Studio 10.0\ Browse

The following items will be downloaded and installed:
+ Microsoft Visual Studio 2010 Express Prerequisites x64
s Microsoft Visual C# 2010 Express

Disk space requirements: C: 767 MB
Total download size: 47 MB

[ < Previous H Install > H Cancel ]

Visual C# 2010 Express will install. This may take up to twenty minutes depending on
your internet connection.

Page

56



@ !EAR'I;HPE|OPLE
& B n o o g vy

USB CPLD Development System User Manual

[} Microsoft Visual C# 2010 Express Setup = P9
Microsafts
SRR QO Visual C# 2010
Express

Microsoft Visual C# 2010 Express has been installed successfully.

i) Visit Microsoft Update to download the latest service packs and security updates.

Exit

The installed successfully window will be displayed when Visual C# Express is ready
to use.

To use the Active Host Application Software, the Active Host DLL and the ftd2xx DLL
must be included in the Microsoft Visual project. The Active Host Application Software
will allow the user to create a custom applications on the PC using the EndTerms to
perform Triggers and Data Transfer to/from the MegaProLogic. The methods and
parameters of the Active Host DLL are explained in the Active Host Application
section. Locate the \Projects_ActiveHost_64Bit and \Projects_ActiveHost_32Bit folders
on the MegaProLogic Development System CD.

2 Save As . :§
@@" <« Earth People Technology » EPT USB-CPLD Development System Searc USB-CPLD Develo |
1 Organize v New folder = o
4 Earth People Technology = Name

4 || EPT USB-CPLD Development 5
SRLD Development Sysiem Arduino_IDE

“ Hide Folders

Arduino_IDE

I. Documentation

Drivers
Projects_ActiveHost_32Bit
Projects_ActiveHost 64Bit
Projects_Arduino
Projects_HDL
Quartus_Programmer

File name: RedBoard-v06.zip

Documentation

Drivers

. Projects_ActiveHost_32Bit

Projects_ActiveHost_64Bit
Projects_Arduino
Projects HDL
Quartus_Programmer

Save as type: | ALZip ZIP File (*zip)
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Locate the Projects_ActiveHost_64Bit in the MegaProLogic Development System
using Windows Explorer.

. « Earth People Technology » EPT USB-CPLD Development System b Projects_ActiveHost 64Bit b

Includein library Share with v New folder Al @
Earth People Technology * Name . Date medified Type Si
EPT USB-CPLD Development System
ActiveHost 1.0.08 2/12/20138:22AM  File folder
Arduino_IDE
EPT_570_AP_Data_Collector 212/20138:23AM  File folder
il EPT Transfer_Test 212/20138:23AM  File folder
o EPTActiveHostConsoleClient 212/20138:23AM  File folder

s_ActiveHost 32Bit
s_ActiveHost 64Bit

Locate the Projects_ActiveHost_64Bit \ActiveHost_1.0.0.8\Bin folder and copy the
ActiveHost64.dll and the ftd2xx64.dll.
Bk

K3\ w)~ | < EPTUSB-CPLD Development System » Projects ActiveHost 648t » ActiveHost 1008 » Bin
Organize v Include in library v Share with v Burn New folder =~ 0 @
4 | Earth People Technology 4| Name ’ Size
4 )| EPT USB-CPLD Development System .
4] ActiveHost64.dil 27k8
Arduino_IDE
4] ftd2o64.dil 2528

Documentation
Drivers
Projects_ActiveHost_328it 3
4 | Projects_ActiveHost 64Bit 3
4 )\ ActiveHost 1008
Bin
EPT_570_AP_Data_Collector
EPT_Transfer_Test
EPTActiveHostConsoleClient

Projects_Arduino

l 2 items State: 2 Shared

Save the DLL’s in the bin\x64\Release folder of the user project under the Microsoft C#
Express project. See the Active Host Application section of the MegaProLogic
Development System User Manuals for instructions on how to add the dll to the
Microsoft C# Express project.
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<« Projects ActiveHost 64Bit » EPT Transfer_Test » EPT_Transfer_Test » bin » x64 » Release

Organize = [ Open with... Bum MNew folder = [l @
4 | Projects_ActiveHost 64Bit 4 Name : Date modified Type Size
> | ActiveHost 1.00.8
%) ActiveHost64.dll Application extens... 27k8B
- [E7] EPT Transfer Test.exe Application 28 KB
- &) EPT_Transfer Test.pdb Program Debug D... 44KB
- [27] EPT_Transfer_Testwshost.exe on 12KB
- bin 8] EPT_Transfer_Test.shost.exe.manifest 1KB
Debug =
%) frel2odd.dll 252K8B
Releast
B4
| Debug
Releass
obj
| Properties il
2 items selected State: 28 Shared Size: 278 KB Shared with: Everyone; Homegroup
= Date modified: 1/18/2013 3554 PM - 2/2... Date created: 2/28/2013 8:26 PM

3 Active Transfer Library

The Active Transfer Library is an HDL library designed to transfer data to and from the
MegaProLogic via High Speed (480 MB/s) USB. It is a set of pre-compiled HDL files
that the user will add to their project before building it. The description of what the
library does and how to use its components are described in this manual.

ACTIVE HOST EPM570 PLD
APPICATION

TRIGGER IN TRIGGER ACTIVE TRANSFER TRIGGER IN USER CODE
| TRIGGER
TRIGGER OUT LIBRARY TRIGGER OUT
FTD2XX L
Uizl | TRANSFER o} DLL, USB USB BUS TL:‘,‘\";i:ERRt;ﬁT 8BITBUS ARDUINO
TRANSFER OUT DRIVER [V [ |

BLOCK IN BLOCK Bi;%ﬁl(ollh:.r |
BLOCK OUT

3.1 EPT Active Transfer System Overview

The Active Transfer System components consist of the following:
active_serial_library.v
ft 245 state_machine.v
endpoint_registers.vgm
active_trigger.v
active_transfer.v
active_block.v
active_transfer_uart.v
uart_receiver.v
uart_top.v
uart_transmitter.v
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The Active_Serial_Library provides the communication to the USB hardware. While
separate Input and Output buses provide bi-directional communications with the plug in
modules.

L INPUT/OUTPUT PINS —

i

‘ TOP LEVEL

S T

ACTIVE TRANSFER USER CODE
LIBRARY

TRIGGER IN
TRIGGER OUT
TRANSFER IN
TRANSFER OUT
BLOCK IN
BLOCK OUT

The figure above shows how the modules of the EPT Active Transfer Library attach to
the overall user project. The EPT Active_Transfer_Library.vgm, Active_Trigger.v,
Active_Transfer.v and Active_Block.v modules are instantiated in the top level of the
user project. The User_Code.v module is also instantiated in the top level. The
Active_Transfer modules communicate with the User_Code through module
parameters. Each module is a bi-directional component that facilitates data transfer from
PC to CPLD. The user code can send a transfer to the Host, and the Host can send a
transfer to the user code. This provides significant control for both data transfers and
signaling from the user code to PC. The Triggers are used to send momentary signals
that can turn on (or off) functions in user code or PC. The Active Transfer is used to
send a single byte. And the Active Block is used to send a block of data. The
Active_Transfer and Active_Block modules have addressing built into them. This
means the user can declare up to 8 individual instantiations of Active_Transfer or
Active_Block, and send/receive data to each module separately.

3.2 Active Transfer Library

The Active Transfer Library contains the command, control, and data transfer
mechanism that allows users to quickly build powerful communication schemes in the
CPLD. Coupled with the Active Host application on the PC, this tools allows users to
focus on creating programmable logic applications and not have to become distracted
by USB Host drivers and timing issues. The Active Transfer Library is pre-compiled
file that the user will include in the project files.
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TOP LEVEL

(EPT_EPM570_TRANSFER_Test_top.v)

g vy

LIBRARY

TRIGGER

(EPT_ACTIVE_TRANSFER_LIBRARY.v) (ACTIVE_TRIGGER.v)

TRANSFER
(ACTIVE_TRANSFER.v)

BLOCK TRANSFER
(ACTIVE_BLOCK.v)

USER CODE

2222222222222 2222232323321 2222 2222222222222 2222222222222 22223232223

/18

/¥
4 / /8
/1§
gL

/7%
//%
10 /1%
11 /1%
/7%

/18
20 /1%
21 /7%
[/
23 /1%
24 /7%
25 /7%
/1%
2 //#

//E A

e e e e ke e e ke ke ok ke ok ke ok ok ok ke ok ok ok ok ok ok ke ok ok ok ke ok ok ke ke ok ok ke ok ok e ke ok ke e ke ok e e ok ok e e ok e e ke ok ke o ke ke ok ke ke ok ke ok ke bk

o
=
=1

28 //ittididididiitisissdtdtisisiisititsisistesissssisisisdssisisisistssassss
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........................................................................

Elmodule EPT_SM57_AP M4 Top (

input wire CLK_66MHZ,
4z input wire RST,
44 //UART COMMAND BUS

output wire

input wire

UART_OUT,

UART_IN, //From externa

input wire [7:0]) LB_XIOLA, XIOH -- J1
< input wire [2:0]) LB_XIOLC, ETOH == a1
input wire [7:0) LB_XIOCH, 2ol == I3
input wire [7:0] LB_COMM, OMM -- J1
input wire [7:0] LB_AD, //XIOH -- J8
input wire [7:0] LB_IOH, [/XTIOR —— J9

//Transceiver Control Signals

output wire TR_DIR_l,
output wire TR_OE_l,
Instantiate the EPT Library

active serial library ACTIVE SERIAL LIBRARY INST

=] (
.aa (aa),
.UART_OUT (UART oUT) ,
.UART_IN (uart_txd),
.UC_IN (Uc_IN),
.uc_our (uc_out)
// .STATE OUT (active_serial_state_out),
// . TEST_OUT (active_transfer test t)

565 g )

The interface from the library to the user code is two uni directional buses,
UC_IN[22:0] and UC_OUT]J20:0]. The UC_IN[22:0] bus is an output bus (from the
library, input bus to the Active Modules) that is used channel data, address, length and
control information to the Active Modules. The UC_OUT/[21:0] bus is an input bus (to
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the library, output bus from the Active Modules) that is used to communicate data,
address, length, and control information to the Active Modules.

The control bus UART _IN and UART_OUT are used to channel data, and control
signals to the USB interface chip. These signals are connected directly to input and
output pins of the CPLD.

3.2.1 Active Trigger EndTerm

The Active Trigger has eight individual self resetting, active high, signals. These signals
are used to send a momentary turn on/off command to Host/User code. The Active
Trigger is not addressable so the module will be instantiated only once in the top level.

i wire [22+%3-1:0] wuc_out m;

T44 eptWireCR # (.N(Z)) wireOR (UC_OUT, uc out m):

T35 active trigger ACTIVE TRIGGER INST
746 [ {

TG ) uc_clk (CLE_66) ,

T48 Luc_reset (E3T) ,

T .uc_in (UC_TIN) ,

TS LuC_out (uc_out m[ O +: 1)
192 .trigger to host (trigger to host),
TS 3 .trigger to_dewvice (trigger in byte)
TLCELC L } "

To send a trigger, decide which bit (or multiple bits) of the eight bits you want to send
the trigger on. Then, set that bit (or bits) high. The Active Transfer Library will send a
high on that trigger bit for one clock cycle (66 MHz), then reset itself to zero. The bit
can stay high on the user code and does not need to be reset to zero. However, if the
user sends another trigger using the trigger byte, then any bit that is set high will cause a
trigger to occur on the Host side.
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ST B &

L:_l L

80 alway=s @ (TRIGGER _OUT or trigger in reset or reset)
81 = begin
if{lreset)

i
[T T

trigger to host = H

84 else if (trigger_in reset)
trigger to _host = H

el=se if (TRIGGER OUT > )

8 trigger to host = TRIGGER OUT;

- end

I
1 & tn

(ST - I

alway= @ (posedge CLE 66 or negedge reset)

T LT Xy

begin
if({lre=set)

1 & tn
{11
LT

begin
trigger_in reset <= 0;
5 end
else
= begin
C if (trigger to host > 0}

[ T e O SO T TN 1 TN e N 1 TN O O 1 e T O O
1]

(ST IR =]

trigger in reset <= H

L kA

el=e
trigger_in reset <= 0O;
= end

g L G D LA L Qb k3 ORY ORI ORID ORI R ORI ORD ORI ORY ORI ORI ORI ORY ORI ORI ORI ORY ORI ORI ORI ORY R

bl
o s

- enc

So, care should be used if the user code uses byte masks to send triggers. It is best to set
only the trigger bits needed for a given time when sending triggers.

The user code must be setup to receive triggers from the Host. This can be done by
using an asynchronous always block. Whenever a change occurs on a particular trigger
bit (or bits), a conditional branch can detect if the trigger bit is for that block of code.
Then, execute some code based on that trigger.
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i T W Y ¢} 1 o LN
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[ 1 o
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1

[Te S ]

[

=l

alway= @(trigger_in byte or trigger in reset or reset)

begin
if({!'re=et)
begin
trigger_in detect = H
end

else if (trigger in reset)

begin

trigger_in detect = H
end
else if (trigger in byte = )
begin

trigger_in detect = H
end
end

Store the walue of Trigger In
always @ (posedge CLE 66 or negedge reset)
begin
if{lre=et)
begin
trigger in store <= H
trigger_in reg <= H
trigger in reset <= H
end
eglze if (trigger in detect & !trigger in reg)
begin
if{crigger in byte != 0)
trigger in store[7:0] <= trigger in byte][
trigger in reg <= H
end
e€lse if (trigger in reg)

begin
trigger in reg <= H
trigger_in reset <= H
end
else if (!trigger in detect)
begin

trigger_in reg <= H
trigger in reset <= H
end
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3.2.2 Active Transfer EndTerm

The Active Transfer module is used to send or receive a byte to/from the Host. This is
useful when the user’s microcontroller needs to send a byte from a measurement to the
Host for display or processing. The Active Transfer module is addressable, so up to
eight individual modules can be instantiated and separately addressed.

13 active_transfer ACTIVE TRANSFER INST

75 = (

13 uc_clk (CLE_&6),

TE .uc_reset (reset) ,

761 Luc in (UC_IN),

T&2 Luc_out (uc_out_m[ Z* +: 1) .
T&4 .start_transfer (cransfer out reg),

TEe5 .transfer received (transfer in received),
Ta .uc_addr { Y.

T8 .transfer to_host (cransfer out byte),

77 .transfer to device (transfer in byte)

71 - )

To send a byte to the Host, select the appropriate address that corresponds to an address
on Host side. Place the byte in the “transfer to host” parameter, then strobe the
“start_transfer” bit. Setting the “start_transfer” bit to high will send one byte from the
“transfer_to_host” byte to the Host on the next clock high signal (66 MHz). The
“start_transfer” bit can stay high for the duration of the operation of the device, the
Active Transfer module will not send another byte. In order to send another byte, the
user must cycle the “start_transfer” bit to low for a minimum of one clock cycle (66
MHz). After the “start_transfer” bit has been cycled low, the rising edge of the bit will
cause the byte on the “transfer to host” parameter to transfer to the host.

Page

66



@ !EAR'I;HPE|OPLE
8 © n o O g Yy

USB CPLD Development System User Manual

182 [f S/ Transfer byte to Device

184 alway= @ (TEANSFEER OUT EN or reset)

185 [ begin

186 if{lre=set)

187 [4 begin

188 transfer out detect = H

189 = end

130 else

121 [H begin

192 if(cransfer to device reset)

1LEE transfer out_detect = H

154 el=se if(TRANSFER COUT EN)

125 [H begin

196 transfer out byte = TRANSFER CUT BYTE:
157 transfer out detect = H

158 = end

155 e end

20C - end

201

202 I e e
203 Reset transfer to device reset

204 = T
205 alway= @ (posedge CLE_&& or negedge reset)

208 [3 begin

207 if (lreset)

208 [H begin

208 transfer to device reset <= H
210 = end

211 else

212 [ begin

213 if(cransfer out_detect)

214 transfer to device reset <= H
215 else

216 transfer to device reset <= H
217 = end

218 = end

i
b
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To receive a byte, the Active Host will send a byte using it’s dll. The user code must
monitor the transfer_received port. The transfer_received port will assert high for one
clock cycle (66 MHz) when a byte is ready for reading on the transfer_to_device port.
User code should use an asynchronous always block to detect when the
transfer_received port is asserted. Upon assertion, the user code should read the byte
from the transfer_to_device port into a local register.

223 always (@ (posedge CLE &6 or negedge resest)

224 begin
225 if (lres=set)

begin
22 transfer out <=
228 transfer out reg <=

229 transfer out_byte <=

230 = end

231 else

232 = begin

233 jj if{start_ transfer byte & !transfer out)

Z34 = begin

235 transfer out_byte <= TRANSFER HOST BYTE:

236 transfer out reg <=

23 transfer out <=

238 P end

Z35 else if(start_transfer byte & transfer out)
240 [H begin

241 transfer out reg <=

242 transfer out <=

243 r end

a4 else if(!start transfer byte & transfer out)
245 [+ begin

246 transfer out_ reg <=

24 transfer out <=

248 & end

249 = end

250 = end

3.2.3 Active Block EndTerm

The Active Block module is designed to transfer blocks of data between Host and User
Code and vice versa. This allows buffers of data to be transferred with a minimal
amount of code. The Active Block module is addressable, so up to eight individual
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modules can be instantiated and separately addressed. The length of the block to be
transferred must also be specified in the uc_length port.

811 active block BLOCE_TEANSFER INST
812 = {

813 uc_clk (CLE_66) ,

814 .uc_reset (RE5T) ,

815 .uc_in (UC_IN),

816 .uc_out (uc_out_m[ =+ +: 1),
818 .5tart_transfer (block out regq),

818 .transfer received (block in rcvy),

821 .tranzfer ready (block byte ready),
823 -uc_addr { V.

824 .uc_length (BLOCE_COUNT_8),

826 .transfer to host (block out byte),

B27T .transfer to device (block in data),

829 .5TATE OUT (block =tate out),
830 .TEST_BUS (Block out test bus)

gzz - ) :

To send a block, it’s best to have buffer filled in a previous transaction, Then assert the
start_transfer bit. This method is opposed to collecting and processing data bytes after
the start_transfer bit has been asserted and data is being sent to the Host.

Once the buffer to send is filled with the requisite amount of data, the address and
buffer length should be written to the uc_addr and uc_length ports. Set the start_transfer
bit high, the user code should monitor the transfer_ready port. At the rising edge of the
transfer_ready port, the byte at transfer_to_host port is transferred to the USB chip.
Once this occurs, the user code should copy the next byte in the buffer to
transfer_to_host port. On the next rising edge of transfer-ready, the byte at
transfer_to_host will be transferred to the USB chip. This process continues until the
number of bytes desicribed by the uc_length have been transferred into the USB chip.
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542 .
543 lf /{ Registers to start Block Transfer Out

545 always @ (posedge CLE_ &6 or negedge RS5T)

546 begin

227 if('R5T)

S48 = begin

549 bBlock out_reg <= H

550 start_block transfer reg <= H

ik r end

552 else

553 H begin

554 if(start_block transfer & !start block transfer reg)
555 start _block transfer reg <= H

556 else if(start_block transfer reg & !block _out_reg)
557 H begin

558 block out reg <= H

GG r end

560 else if(block out counter >= ELOCK COUNT_ &)
561 [H begin

a2 block out_reg <= H

563 start _block transfer reg <= H
564 r end

565 r end

566 - end

567

s8¢ o -
569 Data for Block Transfer Cut

571 always @ (posedge CLE_66 or negedge R3T)

572 [H begin

573 if(IRET)

574 H begin

S block out counter <= 0;

576 r end

STT else

578 H begin

579 if(block byte ready)

580 H begin

581 block out counter <= block out counter +
582 r end

583 else if(block out counter »>= BLOCE COUNT 8 )
584 [H begin

585 block out counter <= 0;

586 r end

287 r end

588 = end
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To receive a buffer from the Host, the user code should monitor the transfer_received
port for assertion. When the bit is asserted, the next rising edge of transfer_ready will
indicate that the byte at transfer_to_device is ready for the user code to read.

[Add code snippet showing Active Block Module bytes received by the user code]

3.3 Timing Diagram for Active Transfer Methods

The Active Transfer Library uses the 66 MHz clock to organize the transfers to Host
and transfer to Device. The timing of the transfers depends on this clock and the
specifications of the USB chip. Users should use the timing diagrams to ensure proper
operation of user code in data transfer.

3.3.1 Active Trigger EndTerm Timing

15.15 ns
aoc»((ssmuz!lll|||||||l|||||||||||l‘lﬂﬂﬂl—|
H 15.15 ns
TRIGGER HOST (Each Bit) / esns A\ 74 B\
SETUP TIME
Figure xx Active Trigger to Host Timing
15.15 ns|
CLOCK(SGMHzﬂllll||||||||||||||||||||||||||I
45.4 ns
TRIGGER TO DEVICE (Each Bit) / \

Figure xx Active Trigger to Device Timing

3.3.2 Active Transfer EndTerm Timing

15.15 ns
cwcx(asmnz)|||||l|||l|||||||||l|||||||||l||
|, a5 5 3
[ 454 ns T15.15ns 454ns
START_TRANSFER / |/ ~
5.4 ns 5.4 n ._.{
5.4 ns H 5.4 ns
N
TRANSFER_TO_HOST —< >_< >

Figure xx Active Transfer To Host Timing
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CLOCK (66 MHz)
| | | |
[ 301ns "15,15 ns " 30.1ns "

TRANSFER_RECEIVED / \ / \
54 ns 5.4 ns-—-l
5.4ns }‘_' 5.4 ns
TRANSFER_TO_DEVICE—<ﬁ<—\
/

Figure xx Active Transfer To Device Timing

3.3.3 Active Block EndTerm Timing

15.15ns

0

303.1ns 15.15 ns

START_TRANSFER ___/ ’__H
135ns
15.15 ns
TRANSFER_READY | | | | | l | | I | | I |

.4 ns 30.3 n

CLOCK (66 MHz)

0.3 ns

TRANSFER_TO_HOST —< BYTE O >—< BYTE1 >—< BYTE 2 >—< BYTE3 >—< BYTE4 >—< BYTES >—< BYTE6 >—< BYTE 7 >—
Figure xx Active Block To Host Timing

15.15ns

CLOCK (66 MHz)
. N 15.15ns
1080 ns —al r—
TRANSFER_RECEIVED _/ 15.15ns \

1110 ns

TRANSFER_READY ” ” ﬂ n n L

.4 ns 30.3 n:

0.3 ns

TRANSFER_TO_DEVICE H BYTE O >—< BYTE 1 >—< BYTE 2 >—< BYTE3 >—< BYTE 4 >—< BYTE 5 >—< BYTE 6 >—< BYTE7 >—
Figure xx Active Block To Device Timing
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4 Compiling, Synthesizing, and Programming CPLD

QUARTUS \

DESIGN SOFTWARE

The CPLD on the MEGAPROLOGIC can be programmed with the Active Transfer
Library and custom HDL code created by the user. Programming the CPLD requires the
use of the Quartus Prime software and a standard USB cable. There are no extra parts to
buy, just plug in the USB cable. Once the user HDL code is written according to the
syntax rules of the language (Verilog and VHDL) it can be compiled and synthesized
using the Quartus Prime software. This manual will not focus on HDL coding or proper
coding techniques, instead it will use the example code to compile, synthesize and
program the CPLD.

4.1 Setting up the Project and Compiling
Once the HDL code (Verilog or VHDL) is written and verified using a simulator, a
project can be created using Quartus Prime. Writing the HDL code and simulating it
will be covered in later sections. Bring up Quartus Prime, then use Windows Explorer
to browse to C:\ C:\Users\nelso\Documents\EPT_5M57_AP_M4 Transfer_Test to
create a new directory called: “EPT_Transfer_Test”.
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V1 9 = | CAUsersinelso\Dacuments\EPT_SMS7_AP_M4_Transfer_Test

[~ [

- « T > ThiSPC > Windows (C) » Users » nekso > Documents > EFT_SMS7_AP_M4_Transfer_Test
> dotnet ~ 0O mame
ms-ad
3D Objects
> AppData
> , Application Data
i Contacts
> 4 Cookies

A Documents
EPT_SMS57_AP_M4_Transfer_Test
EPT_SMS7_AP_U2 Transfer_Test

5 a0 My Music
> » My Pictures
> 48 My Videos

Open Quartus Prime by clicking on the icon

(G Quartus Prime Lite Edition
File Edit View Project Assignments Processing Tools Window Help
OrdA-0N0DC A EEHTDrEES SALVES

Project Nawgamr{ 4 Hierarchy

-algs =

% Compilation Hierarchy

Tasks Compilation

Quartus Pri

me
Task i
~ P compile Design
> P Analysis & Synthesis
> P> Fitter (Place & Route)

> P Assembler (Generate programr

y

Date modified Type

¥ Buy Software

This fold

- o x

Search stieacom | @

|IP Catalog g8 x

Device Family MAX W v
. x=

~ i installed 1P
' Project Directory

No Selection Available
~ Library
> Basic Functions
> DSP
> Interface Protocols
> Processors and Peripherals
> University Program

@ search forpartner 1P

a S B i aebio 5 A + add.
o m| @& & A F e [88Find. | 08 Fimaned]

; Type ID  Message

i

H

ﬁ System  Processing

100%  00:00:14

Under Quartus, Select File->New Project Wizard. The Wizard will walk you through

setting up files and directories for your project.
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@ Quartus I 32-bit —
Edit View Project Assignments Processing Tools Window Help =)
O new. Crl+ 'I@
& Open... Crl+0 o
R B e e 2T B
Close Ctrl+F4
{2 mew Project Wizard... Now Available
E? Open Project... Ctrl+1 Quartus® Il
Save Project Software v12.0 SP2
[l Close Project
H sae Clrl+s
Save As...
G saveal Cirl+Shift+5

File Properties...

Create  Update 3
Export...

Convert Programming Files. ..

B Page Setup...

B_ Print Preview

& print... crl+p
Recent Files 3 I~
Recent Projects 3

Exit Alt+F4

\_Processing /\_Extra Info /\_Info /% _Warning /\_Critical Warning /\_Error f\_&

Starts the New Project Wizard

At the Top-Level Entity page, browse to the C:\Users\<your
name>\Documents\EPT_5M57_AP_M4 Transfer_Test\EPT_5M57_AP_M4 Top
directory to store your project. Type in a name for your project
“EPT_570_AP_M4_Top”.
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(U New Project Wizard

Directory, Name, Top-Level Entity

What is the working directory for this project?

C:\Users\nelso\Documents\EPT_5M57_AP_M4 _Transfer_Test\EPT_SM57_AP_M4_Top

What is the name of this project?

EPT_SM57_AP_M4_Top

What is the name of the top-level design entity for this project? This name is case sensitive and must exactly match the entity name in the
design file.

EPT_5M57_AP_M4_Top

Use Existing Project Settings...

< Back

Finish Cancel Help

O New Project Wizard
Project Type
Select the type of project to create.
® Empty project

Create new project by specifying project files and libraries, target device family and device, and EDA tool settings
O Project template

Create a project from an existing design template. You can choose from design templates installed with the Quartus Prime software, or
download design templates from the Design Store.

< Back

Finish Cancel Help
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Select Next. At the Add Files window: Browse to the
\Projects HDL\EPT_Transfer_Test \src folder of the MegaProLogic Development
System DVD. Copy the files from the following directory.

9 = | Colly\Products\Earth People Technology\MEGAPROLOGIC_USB_CPLD_PROJECT 4.5 DVD\Projects HDL\EP

- T Earth People Technalogy > MEGAPROLOGIC_USB_CPLD_PROJECT 4.5_DVD » Projects HDL » EPT_SMS7_AP_M4_Transfer_Test

» This PC > Windows (C) » Jolly > Products >
DUEPROLOGIC_USB_FPGA_PROJECT_4.0_OVD * 0O nNeme

EPT 12C Project CD EPT_SMS7_AP_M4_Top

EPT Prajects Folders B Modelsim

MAXPROLOGIC_FPGA_PROJECT 4.0_DVD B sim

MEGAMAX_CPLD_SYSTEM_PROJECT_4.0_DVD src

MEGAMAX_CPLD_SYSTEM_PROJECT 4.5 DVD LS folce
Testbench folde

MEGAPROLOGIC_USB_CPLD_PROJECT_40_DVD
MEGAPROLOGIC_USB_CPLD_PROJECT 4.5 DVD
Documentation
Drivers
Projects_ActiveHost_648it
Projects_Arduino
Projects_HDL
EPT_SMS7_AP_M4_Data Collector
EPT_SMS7_AP_Md_Transfer_Test
EPT_SMS7_AP_M4 _Top
Madelsim

Then paste them in the C:/users/<your
name>/Documents/EPT_5M57_AP_M4 Tranfer_Test\EPT_5M57_AP_M4 Top

folder:

C:\Users\nelso)\Dacuments\EPT_SM5T_AP_Md_Transfer_Test

————— Shar
« v 1 > This PC » Windows (C3 » Users > nelso > Documents » EPT_SMS7_AP_M4 Transfer Test »
dotnet * 0O Name Dal
ms-ad EPT_SMS57_AP_M4 Top 5 M
» 30 Objects Bl Modelsim 910 PM le fold
AppData [ sim le folds
» Application Data [ File fald
Contacts B test File fold
J Cookles Testbench File fald
Documents

EPT_SM57_AP_M4_Transfer_Test
EPT_SMS7_AP_MA_Top
Modelsim
sim
src
test

Testbench

Then go to the “Add Files” page:
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Add Files

Select the design files you want to include in the project. Click Add All to add all design files in the project directory to the project.

Note: you can always add design files to the project later.

File name:

.

FileName Type Library Design Entry/Synthesis Tool HDL Version

Specify the path names of any non-default libraries. |User Libraries...

Select File

Organize =

t [ > ThisPC » Windows (C) » Users > neko »
New folder

.dotnet

ms-ad

¥ 30 Objects

AppData

» Application Data

1% Contacts

. Cookies

v

Documents

EPT_SM57_AP_M4_Transfer_Test
ModelSim
sim
src
test
Testbench

EPT_5M57_AP_U2_Transfer_Test

File name:

Active block.v
Active_transfer.v
Active_trigger.v

Active_Serial_library.v
Endpoint_registers.v

< Back

ModelSim
sim

src

test

Testbench

On the Resource page, click “Select File” and navigate to the folder:

EPT_SMS7_AP_Md_Transfer_Test »
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e FT_245_state_machine.v

e eptWireOr.v
e mem_array.v

e read_control_logic.v

e Serial_clock.v

e Uart_receiver.v

e Uart_transmitter.v

e write_control_logic.v

e EPT 570 AP_M4 Top.v
€ 5 v 4[> MPC » Wendows () » Vst + nco + Docamens

¥ 30 Objects
AppData
s Application Data
17 Contacts
. Cookies
Documen ts
EPT_SM57_AP_M4_Transfer_Test
ModelSim
sim
src
test
Testbench
EPT_SM57_AP_U2_ Transfer_Test

File name: | “write_control_logic.v" "active_block.v

EPT_SMS7_AP_M4_Transfer_Test » src

A [ Name

M active trigger.v 2/2021 4:2
M definev 11/11/2012 12:02 AM
M endpninl_reglﬂq e ]

(Al EPT_sMS7_AP._
Ml eptwireOR.v
Hlad fiipflopay

[ ft_245_state_machine.v 2/25/2021 10:29 PM
[ mem_array.v

Ml muxy

A read_control_logicy

I serial_clock.v

M sync_fifow

S vart_receivery

Ml vart_topy

(Al vart_transmittery

[ write_control_logic.v

"active_control_register.v” "active_serial_library.v” "active_transfer.v” "active_transfer_uarty” "active trigger.v” "definey” v
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* Settings - EPT_S70_AP_Transfer_Test

Category:
General Files
Files
Libraries Select the design files you want to indude in the project. Click Add Al to add all design files in the project directory to the project.
4 Operating Settings and Conditions
Voltage File name: [ea) Add
Temperature
4 Compilation Process Settings Type
Early Timing Estimate {EPT USB-CPLD Development System CD/Projects_HDL/EPT_Transfer_Test/src/nrite_control_logic.v Verllog HOL File
Incremental Compilation JEPT USB-CPLD Development System CD/Projects_HDL/EPT_Transfer_Test/src/read_control_logic.v Verllog HOL File Remove
Physical Synthesis Optimizations JEPT USB-CPLD Development System CD/Projects_HDL/EPT_Transfer_Test/src/mem_array.v Verilog HOL File
4 EDA Tool Settings JEPT USE-CPLD Development System CD/Prajects_HDL/EPT_Transfer_Test(src/eptWireOR.v Veriog HDL File up
Design Entry/Synthesis JEPT USE-CPLD Development System CD/Projects_HOL/EPT_Transfer_Test/src/EPT_S70_AP_UU2 Top.v Verilog HDL File
Simulation JEPT USB-CPLD Development System CO/Projects_HOL/EPT_Transfer_Test/src/active_trigger.vqm Verlog QuartusMa | Dovn
Formal Verification JEPT USB-CPLD Development System CD/Projects_HDL/EFT_Transfer_Test/src/active_transfer_library.vam Verlog Quartus Ma
| Board-Level JEPT USB-CPLD Development System CD/Projects_HDL/EPT Transfer_Test/src/active_transfer.vgm Verilog Quartus Ma| | Preperties
4 Analysis & Synthesis Settings JEPT USE-CPLD Development System CD/Projects_HDL/EPT_Transfer_Test/src/active_block.vam Verilog Quartus Ma
VHDL Input
Verilog HDL Input
Default Parameters
Fitter Settings
TimeQuest Timing Analyzer
Assembler
Design Assistant

SignafTap T Logic Analyzer

Logic Analyzer Interface
PowerPlay Power Analyzer Settings
SN Analyzer

WBuySoftware | [ ok ][ cancel ][ apaly ][ el

Select Next, at the Device Family group, select MAX V for Family. In the Available
Devices group, browse down to 5M570ZT100C5 for Name.
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G New Project Wizard
Family, Device & Board Settings

Device Board

Select the family and device you want to target for compilation.
You can install additional device support with the Install Devices command on the Tools menu.

To determine the version of the Quartus Prime software in which your target device is supported, refer to the Device Support List webpage.

Device family Show in "Available devices' list

Family: MAXV v Package: Any -
Device: [All Pin count: Any v

Target device Core speed grade: | Any hd

O Auto device selected by the Fitter Name filter:

@® Specific device selected in ‘Available devices list [ Show advanced devices

Available devices:

Name Core Voltage LEs UFM blocks -
5M570ZM100C4 1.8v 570 1
5M570ZM100C5 1.8v 570 1
5M570ZM100I5 1.8v 570 1
SM570ZT100A5 1.8v 570 1
5M570ZT100C4 1.8v 570 1
SM570ZT100I5 1.8v 570 1
5M570ZT144C4 1.8v 570 1
SM570ZT144C5 1.8v 570 1
5M570ZT144I15 1.8v 570 1
5M1270ZF256A5 1.8v 1270 1
5M1270ZF256C4 1.8v 1270 1

EMANINICICECE 4 o 1370 1 ¥

< Back Finish Cancel Help

Select Next, leave defaults for the EDA Tool Settings.
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& MNew Project Wizard Iﬁ

. .
EDA Tool Settings [page 4 of 5]
Specify the other EDA tools used with the Quartus II software to develop your project.
EDA tools:
Tool Type Tool Name Format(s) Run Tool Automatically
‘Design Entry/Synthesis §[<None> '] <None = Run this tool automatically to synthesize the|
Simulation <None > x| <None> Run gate-evel simulation automatically after
Formal Verification <None>
(]
I
4 ] r
[ < Back ] [ Mext = ] [ Finish ] [ Cancel ] [ Help ]

Select Next, then select Finish. You are done with the project level selections.
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(U New Project Wizard

Summary

Project directory:
Project name:
Top-level design entity:
Number of files added
Number of user libraries added:
Device assignments:
Design template:
Family name:
Device:
Board:
EDA tools:
Design entry/synthesis:
Simulation:
Timing analysis:
Operating conditions:

VCCINT voltage:

Junction temperature range:

When you click Finish, the project will be created with the following settings:

C:\Users\nelso\Documents\EPT_5M57_AP_M4_Transfer_Test\E
EPT_SM57_AP_M4_Top

EPT_SM57_AP_M4_Top

21

0

nfa
MAX V
SM570ZT100C5

nfa

<None> (<None>)
<None> (<None>)

0

1.8v

0-85°C

Next, we will select the pins and synthesize the project.

4.1.1 Selecting Pins and Synthesizing

With the project created, we need to assign pins to the project. The signals defined in
the top level file (in this case: EPT_5M57_AP_M4_Top.v) will connect directly to pins
on the CPLD. The Pin Planner Tool from Quartus Prime will add the pins and check to
verify that our pin selections do not violate any restrictions of the device. In the case of
this example we will import pin assignments that created at an earlier time. Under
Assignments, Select Import Assignments.
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File Edit

Drd|+

Project Nawgamr{ A Hierarchy

A% MAX V: 5M570ZT100C5
> EB gpT 5M57_AP_UZ_Te

View Project | Assignments

e
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1% Device
Settings

Entity-nstar & Assignment Editor
Fin Planner

Remove Assignments.

I Back-Annotate Assignments.

P Ig!

Assignment Groups

&  Logic Lock Regions Window

Design Partitions Window

Tasks

Compilation

+ v P CompileDesign
> P Analysis & Synthesis

> P Fitter [Place & Route)

> P Assembler [Generate programr

[SEY— e

Task

a| [0 4] 4

Processing  Tools

ARTHPEOPLE

e

Window  Help

Ctri+Shift+E

Cri+Shift+A
Crl+Shift+N

Alt+L
Alt+D

c h n

B TrrFES @LVE

L

0

Quartus Prime

¥ <<Filter>>

‘ 88 Find.. ‘ ‘ﬁ nndum‘

"= Buy Software

O g Yy

o x

Search altera.com (]

|\P Catalog

~ i installed 1P

¥ Library

> DSP

¥ Project Directory
Ne Selection Available

> Basic Functions
> Interface Protocols

> University Program

@ search for Partner P

> Processors and Peripherals

+ Add

Illcmx"‘L <

Type

ID  Message

Messages

System

Processing

Imports assignments from other sources

At the Import Assignment dialog box, Browse to the
\Projects HDL\EPT_Transfer_Test\ EPT_MegaProLogic_TOP folder of the
MegaProLogic Development System DVD. Select the “EPT_5M57_AP_M4_Top.qsf”

file.

Select File

« v

Organize =

+

New folder
MEGAPROLOGIC_USB_CPLD_PROJECT 45 DVD
Documentation
Drivers
Projects_ActiveHost_64Bit
Projects_Arduine
Projects_HDL
EPT_SMS7_AP_M4_Data_Collector
EPT_SMS7_AP_M4_Transfer Test
EPT_SMST_AP_MA_Top
db
incremental_db
output_files
simulation
ModelSim

sim

Name

db
incremental_db
output_files
simulation
L] EPT_SMS7_AP M4 Top.qsf
[ EPT_5MST_AP_M4 Top.sdc

« MEGAPROLOGIC_USB_CPLD_PROJECT 45.DVD » Projects HDL » EPT_SMST_AP_M4 Transfer_Test > EPT_SMST_AP_MA4_ Top

Date modified

1/17/2023 10:36 PM

PM

243PM

Tpe
File folder
File folder
File folder
File folder
QSF File

SOC File

ks
[ Search EPT_SMS7_AP_M4_Top
m @

Size

8KB
axe

File name: | EPT_SMS7_AP_M4_Top.qsf

Page
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Ok Import Assignments X

Specify the source and categories of assignments to import.

File name: LUS B_CPLD_PROJECT_4.5_DVD/Projects_HDL/EPT_5M57_AP_M4_Transfer_Test/EPT_5M57_AP_M4_Top/EPT_5M57_AP_M4_Top.gsf J E Categories...

[ copy existing assignments into EPT_SM57_AP_M4_Top.qsf.bak before importing Advanced...

OK Cancel Help

Click Ok. Under Assignments, Select Pin Planner. Verify the pins have been imported
correctly.

(G Quartus Prime Lite Edition - C:/Jolly/Products/Earth People Technology/UNOMAX_CPLD_SYSTEM_PROJECT_4.0_DVDyProjects_HDL/EPT_SMS7_AP_U2_Transfer_Test/EPT_SMST_AP_U2_Top/EPT_SMST_AP_U2 Top - EPTSMST AP U2 Top  — O X |

File Edit View Project | Assignments Processing Tools Window Help Search aliera.com [ ]

DR[O DY e BoeSr o @4l e

" Settings Cirl+Shift+E.
Project Navigator .\ Hierarchy
itor

Cirl+ShiftsA

‘\P Catalog e x r

- =

Entity:instar g

i\ MAX V: 5M5702T100C5 CirlsshifteN v @ installed 1P
> B8 EpT_5M57_AP_UZ_To. ¥ ProjectDirectory
No Selection Available
Import Assignments. ¥ Library
Export Assignments. > Basic Functions
Assignment Groups. > bsp
& Logic Lock Regions Window AltsL 7 Interface Protocols

. > Processors and Peripherals
uartus Prime ot
@ search for Partner P
Version 20.1

Edition

fa  Design Partitions Window

Tasks Compilation ‘|E 8=

Task ~

« v P Compile Design
> P Analysis & Synthesis w Buy Software

> P Fitter (Place & Route)

> P Assembler (Generate programr

-
>

o B4 [¥ <sFiters> | 88 Fnd. |88 Findnec

Type  ID  Message

[ -

+ Add

|||amx‘»g <

100%  00:00:14

The pin locations should not need to be changed for EPT USB CPLD Development
System. However, if you need to change any pin location, just click on the “location”
column for the particular node you wish to change. Then, select the new pin location
from the drop down box.
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-‘:*‘ Pin Planner - C:/Users/nelso/Documents/EPT_SM57_AP_M4_Transfer_Test/EPT_SM57_AP_M4_Top/EPT_SM57_AP_M4_Top - EPT_SM57_AP_M4 _Top

File Edit View Processing Tools Window Help

— | RepOTt p&x
- »
o
Groups Report
Tasks aex

v I~ Early Pin Plann

ing

I Earty Pin Planning

2>8<KD<])

Top View

Wire Bond

MAXV

5M570ZT100C5

O..QD_ OAV.D..V.A... oo/ \Vbbee

+DBDDOVAVDD/D/ \DDDDDOS . /DDS

(LA Ll L Pl o2 S LTI Ll L

Pin Legend

©

28 x|

Symbol Pin Type

User /O

o L X X J

User assigned |.
Fitter assigned |
Unbonded pad
Reserved pin
DEV_OE

DEV_CLR

DIFF_n output

DIFF_p output

CLK_n
TDI
TCK
T™S
TDO

Filter: Pins: all

[ H P Run 1/O Assignment Analysi
)
I export Pin Assignments.
=VE - .
" < >
IE' X | Named: * v [«»| Edit
&
m a Node Name Direction
»- CLK_66MHZ Input
- LB AD[7] Input
in
= LB _AD[6] Input
- P" = LB_AD([5) Input
H - ®- LB_AD[4] Input
) a = LB_AD[3] Input
= LB_AD[2] Input
(0) = LB_AD[1] Input
[ ] ®- LB_AD[0] Input
m »- LB_COMM[7] Input
»- LB_COMM[6] Input
~ ®- LB_COMM[S] Input
@ - LB_COMM[4] Input
io »- LB_COMM[3] Input
B »- LB_COMM[2] Input
: = LB_COMM[1] Input
Pio| |[® - 3
-»- = LB_COMM([0] Input
= LB_IOH[7] Input
1 2 = LB_IOH[6] Input
& |m- LB_IOH[S] Input
4 K

Location
PIN_12
PIN_42
PIN_41
PIN_40
PIN_38
PIN_36

N (I[N 1N =0 [ [= |=b (o8 | b [=b 1eb [ [=b fob [wbi | [ [mi

1/0 Bank

Fitter Location
PIN_12
PIN_82
PIN_67
PIN_74
PIN_43
PIN_62
PIN_89
PIN_91
PIN_85
PIN_61
PIN_71
PIN_78
PIN_64
PIN_70

1/O Standard
3.3-V L_efault)
3.3-V L. efault)
3.3-V L_efault)
3.3-V L.efault)
3.3-V L efault)
3.3-V L_efault)
3.3-v L.efault)
3.3-V L_efault)
3.3-V L.efault)
3.3-V L.efault)
3.3-V L efault)
3.3-V L_efault)
3.3-V L_efault)
3.3-V L efault)
3.3-V L.efault)
3.3-v L.efault)
3.3-V L.efault)
3.3-V L_efault)
3.3-V L efault)
3.3-V L_efault)

Reserved

Current Strength
16maA (default)
16mA (default)
16mA (default)
16mA (default)
16mA (default)
16mA (default)
16mA (default)
16mA (default)
16mA (default)
16mA (default)
16mA (default)
16mA (default)
16mA (default)
16mA (default)
16mA (default)
16mA (default)
16mA (default)
16mA (default)
16mA (default)
16mA (default)

>| « <

Differential Pair 5trict Pre:

Exit the Pin Planner. Next, we need to add the Synopsys Design Constraint file. This
file contains timing constraints which forces the built in tool called TimeQuest Timing
Analyzer to analyze the path of the synthesized HDL code with setup and hold times of
the internal registers. It takes note of any path that may be too long to appropriately
meet the timing qualifications. For more information on TimeQuest Timing Analyzer,

see

https://ftp.intel.com/Public/Pub/fpgaup/pub/Teaching_Materials/current/Tutorials/\VVHD
L/Timequest.pdf
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Browse to the \Projects HDL\EPT_Transfer_Test \ EPT_MegaProLogic_TOP folder of
the MegaProLogic Development System DVD. Select the
“EPT_5M57_AP_M4_Top.sdc” file.

\ LOGIC_USB_CPLD_PROJECT_4.5_DVD\Projects HDL\EP

> ThisPC > Windows (C) > Jolly > Products > Earth People Technology > MEGAPROLOGIC_USB_CPLD_PROJECT 4.5 DVD > Projects HDL > EPT_SMS7_AP_M4 Transfer Test > EPT_SMS7_AP_M4 Top >

1s\Earth People Te

DUEPROLOGIC_USB_FPGA_PROJECT_4.0_DVD * [ Name

EPT12C Project CD db

EPT Projects Folders incremental_db
MAXPROLOGIC_FPGA_PROJECT 4.0_DVD output files
MEGAMAX_CPLD_SYSTEM_PROJECT 4.0 DVD simulation

EPT_SMS7_AP_M4_Top.qpf
EPT_SMS7_AP_M4_Top.qsf
[ EPT_SM57_AP_M4_Top.sdc
EPT_SMS7_AP_M4_Top_assignment_de

MEGAMAX_CPLD_SYSTEM_PROJECT 4.5 DVD
MEGAPROLOGIC_USB_CPLD_PROJECT_4.0_DVD
MEGAPROLOGIC_USB_CPLD_PROJECT 4.5 DVD
Documentation
Drivers
Projects_ActiveHost_64Bit
Projects_Arduino
Projects_HDL
EPT_SMS7_AP_M4 _Data_Collector
EPT_SMS7_AP_M4 _Transfer_Test
EPT_SM57_AP_M4_Top
ModelSim

sim

Copy the file and browse to
C:\Users\nelso\Documents\EPT_5M57_ AP_M4 Transfer Test\EPT 5M57 AP _M4 T
op directory. Paste the file.

© = | CAUsers\nelso\Documents\EPT_SMS7_AP_M4_Transfer_Test\EPT_SMS7_AP_M4_Top

» ThisPC > Windows (C;) > Users > nelso > Documents > EPT_5MS7_AP_Md_Transfer Test > EPT_SMS57_AP_M4_Top

dotnet ~ O Name
ms-ad &
3 3D Objects

M4_Top.gpf
M4_Top.gst

EPT_SMS7_AP_M4_Top.qsfbak

[ EPT_SMS7_AP_M4_Top.sdc
Documents

EPT_SMS7_AP_Md_Transfer Test
EPT_SMS7_AP_M4 Top

ModelSim

Select the Start Compilation button.
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(Gh Quartus Prime Lite Edition - Ci/Jolly/Products/Earth People Technology/UNOMAX_CPLD_SYSTEM_PROJECT_4.0_DVD/Projects_HDL/EPT_5MS57_AP_U2_Transfer_Test/EPT_SMS7_AP_U2_Top/EPT_SMS57_AP_U2 Top - EPT_SMS7_AP_U2 Top  — o X

File Edt View Project Assignments Processing Tools Window Help P ®
O d M6 D C| epr_sms7_ap vz Top M- X0 °

Project Navigator +\ Hierarchy -als x

IP Catalog pE =
| |

« X =
~ i installed 1P
¥ Project Directory

EntityInstance
A% MAX V- 5M5702T100C5
> BB EpT 5M57_AP_U2_Top
No Selection Available
¥ Library
> Basic Functions
> DsP
> Interface Protocols

> Processors and Peripherals

Quartus Prime oL

Tasks Compilation

Task
+ ¥ P Compile Design
> P Analysis & Synthesis
> P Fitter (Place & Route)

> P Assembler (Generate programr.

v

S B s
By + Add.
a0 &) A [¥ <<Fitters> [ 88Find. | B8 Findnext
Type ID Message
B
&
a
8| system  Processing
100% 00:00:14
&Y c _SMST_AP_MA_Transter_Test/EPT_SMS7_AP_WAA_Top/EPT SMST_AP_MA_Top - €91 SMST AP M4 Top. - o x
File EGt View Project Assignments Processing Tools Window Help [Seareh avera.cor }.
S -\
FHEA ) o Emmm / SO Q> 5 £ O0AVE 9
Project Navigator O\ Henarchy ~0 98 x| © Complation Report - EPT_S5M57_AP_M4_Top ) ® Catalog 98 x
Enoyinetance Table of Contents L o N
4 MAX V: SM5702T100C5 ES Flow Summary | & <<Fiter v & instaliea
8 eer_sms7_ap o Top B2 Fiow Settings Flow Status Inprogress - MonMay 08 2134502023 | v proyecs Directory
= rlow | 2010804711 PR
B Flow Elzpsed Time Revizion Rame EPT_SMS7_AP_ M8 Top i iy
B Fiow 05 Summary Top-level Entty Name  EPT_SMS7_AP_M4 Top
£ Flowlog Famity MKV,
W Anayis 8 Synthesis
© Flow Messsges
© Flow Suppressed Messages
@ Seach for Parner
< >
Tasks Campitation rugex
Task T 2
v
- >
3
% »
[ow >
>
< . > e 3|3 >| LA
.
e O AN AV O8rind. | 88 FindNext
Type I Message Al
° Running quartus erime Analysis & Synthests
o Command: quartus_map --read_settings_files=on --write_settings_files=off EPT_SM57_AP_M4_Top -c EPT_SM57_AP_M4_Top
A 18236 umber of processors has not been specified which may cause overloading on shared machines. Set the global assignment NUM_PARALLEL_PROCESSORS in your QSF to an appropriate value for
© 20030 Parallel compilation i5 enabled and will use 4 of the 4 processors detected

System(2)  Processing (5)

1% +¢ 000002
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If you forget to include a file or some other error you should expect to see a screen
similar to this:

5.1 _Top - EFT_SMST_A% M4 Tom o ox
L]
/OGSO Tr+9OCLOHE 9
Fepor-T s Meree @ |pcams - T
+s T -
o
;;;;; Compiation as
Task
>
i)
. - +
= .
ol O & A A Shriod. 88 Find next
]
= | Type
o 11t ed 1 path he spe
® 1 .
o
o
t
HE
§| srmemer  processing s
% o000

Click on the “Processing” tab at bottom to see the error.
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(b Quartus Prime Lite Edition - C:/Users/nelsc/Documents/EFT_SMST_AP_M4_Transfer_Tes/EPT_SMST_AP_MA4_Top/EPT_SMST_AP M Top - EPT_SMST_AR M4 Top

File Edit View Project Assignments Processing Tools Windaw Help

- ael » s L GSO TP+ 4O QAOH 9

Project Navigatar Hierarchy =|alg® x| @ compiation Report - EPT_SM57_aP_M4_Top [ iP Catalog
[ Table of Cantents FLN 1w summary Y
MAX V: SM570ZT100C5 EH Flow Summary * v @ installed P
. B Flow setogs Flow Stats Flow Faled - Mon M3y 08 13458 2023 |+ projectowectory
B Flow Non-Default Global Settings Quartus Prime Version  20.1.0 Build 711 D6/05/2020 5. Lite Editiol N
B Flow Elzpsed Time Revsion hame EPT_SMST_AP_M4_Top

¥ Library
B Flow 05 sum

Top-level Entity Name  EPT_SMS7_AP_M2_Top SemicFumctions

= FlowLog Family MAX V Dae

Analysis & Synthesis Device SMS70ZT100CS Interface Protocols

O Fiow Messages Timing Models Final Procassors and Parphesals

© Flow Suppressed Messages Uriersity Program

@ search for partner

< >
Tasks Compilation rE8x

Task Tim A
X v P comp

x P Analysis & Synthesis
P Fitte (Place & Route
P Assembler (Generate programming fles)

SYNTHESIS ERROR

P Timing Analysis

>
< - 3 < IR > + add
x » »
alal O A A A O Find. |8 Find Next
a
= | Type message B
o nsta define the specified enti
o
(=]
(<]
- v
#lc >
L sptemi  processingi40)

The error in this case is the missing file “active_serial_library.v”. Click on the
Assignment menu,

Page
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/ Settings - EPT_SM57_AP_M4_Top - u] X

General

Files You can change the top-level entity for the design; however, it is recommended that you create a new revision for

Libraries each entity in order to maintain settings information.
¥ IP Settings
IP Catalog Search Locations Top-level entity: EPT_SM57_AP_M4_Top
Design Templates

Recently selected top-level entities: EPT_SM57_AP_M4_Top b
¥ Operating Settings and Conditions

Voltage Description:
Temperature
¥ Compilation Process Settings
Incremental Compilation
¥ EDA Tool Settings
Design Entry/Synthesis
Simulation
Board-Level
¥ Compiler Settings
VHDL Input
Verilog HDL Input
Default Parameters
Timing Analyzer
Assembler
Design Assistant
Signal Tap Logic Analyzer
Logic Analyzer Interface
Power Analyzer Settings
SSN Analyzer

W Buy Software OK Cancel Apply Help

then select Settings, then select Files. Add the “active_serial_library.v” file from the
database.
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- Settings - EPT_SM57_AP_M4_Top = =]
Category: Device/Board.
General
Files Select the design files you want to include in the project. Click Add All to add all design files in the project
Libraries directory to the project.
IP Settings
IP Catalog Search Locations File name: l ‘ Add
Design Templates <
Operating Settings and Conditions ‘ = - ‘ A
Voltage File Name Type Library Design Entry/Synth | poove
Temperature ../src/write_control_logic.v Verilog HDL File <None>
Compilation Process Settings ../src/uart_transmitter.v Verilog HDL File <None> S
Incremental Compilation ../srcjuart_top.v Verilog HDL File <None> Down
EDA Tool Settings ..Jsrc/uart_receiver.v Verilog HDL File <None>
Design Entry/Synthesis .Isrc/sync_fifo.v Verilog HOL File <None> Properties
Simulation ../src/serial_clock.v Verilog HDL File <None>
Board-Level ../src/read_control_logic.v Verilog HDL File <None>
Compiler Settings .Jsrc/mux.v Verilog HDL File <None>
VHDL Input ../src/mem_array.v Verilog HDL File <None>
Verilog HDL Input ../src/ft_245_state_machine.v Verilog HDL File <None>
Default Parameters ../src/flipflop.v Verilog HDL File <None>
Timing Analyzer ../src/eptWireOR.v Verilog HDL File <None>
Assembler ../src/EPT_SM57_AP_M4 Top.v Verilog HDL File <None>
Design Assistant ../src/endpoint_registers.v Verilog HDL File <None>
Signal Tap Logic Analyzer ../src/define.v Verilog HDL File <None>
Logic Analyzer Interface ../src/active_trigger.v Verilog HDL File <None>
Power Analyzer Settings ../src/active_transfer_uart.v Verilog HDL File <None>
SSN Analyzer ../src/active_transfer.v Verilog HDL File <None>
é.,/srclactive_serial_libraryy Verilog HDL File <None> ;
../src/active_control_register.v Verilog HDL File <None>
../src/active_block.v Verilog HDL File <None>
< >
W Buy Software OK Cancel Apply Help

Click Ok then re-run the Compile process. After successful completion, the screen
should look like the following:

Page

92



@ !EAR'I;HPE|OPLE
& 6 n o o g vy

USB CPLD Development System User Manual

8 Guartus Frima Lite Edition - C/Usorsinelso Dacumonts/EFT_SWIST_AP_MA_Transfer_Tost/EFT_SMST_AP_ b4 Top/EPT_SMST_AP_MA_Top - ERT_SNIST_AP_b4 Top

File Edit View Project Assignments Processing Tools Window Help

THLO T s 2 GEOTrFFOQLOHE 9

oject Navigator Higrarchy ~|Q/g/8 x| & Compilation Report - EFT_SMS7_AP_M4_Top (B

o

BB Flow Summary

MAX V: SMST0ZT100C5
BB EpT SM57_AP M4 Top B9 Flow settings
BB Flow Non-Defautt Global Settings
B Flow Elapsad Time
B Flow O Summary Top-level Entty Name  EFT_SMS7_AP_M4_Top

‘Successful - Mon May 0B 21:45:00 2023
on  20.1.0 Build 711 06/05/2020 51 Lite Editioq
EFT_SMS7_AP_M4_Top

Family MAX YV

Device SMS70ZT100C5
‘‘‘‘‘ ¢ Models Final
Totallogic dlements 520/ 570(91 %)
Total pins 73/ 74 (89 %)
Total vieual pins o
UFM blocks 0/1(0%)

asks Compiation ue

k Tim,
* -
alan O & A A BB Find. B8 Find Next

System (2)  Processing (159)

At this point the project has been successfully compiled, synthesized and a

a

v @l installed P
~ Project Directory

~ Library
Basic Functions
osp
Interface Protocols

Processars and Peripherals

University Program

@ search for Pannesip

¥

programming file has been produce. See the next section on how to program the CPLD.

4.1.2 Programming the CPLD

Programming the CPLD is quick and easy. All that is required is a standard USB-C

cable. Connect the MegaProLogic to the PC, open up Quartus Prime, open the

programmer tool, and click the Start button. To program the CPLD, follow the steps to

install the USB Driver and the JTAG Driver Insert for Quartus Prime.
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If the project created in the previous sections is not open, open it. Click on the

Programmer button.

{3 Quartus Prima Lite Edition - C-/Usars/nelso/Documents/EPT_SMS7_AP M4, Transfer Test/EPT_SMST_AP W4 Top/EPT SMS7_AP_Md_Top - EPT SMST7_AP_Md Top - o x
File Edit View Project Assignments Processing Tools Window Help (]
& [} mamme -/ GSQOD>$ 59 QADA @
roject Navigatr Hierarchy ~ Q[Q® x| & Compilation Report - EFT_SM57_AP_M4_Top ] P Catalog nex
Entityinstance Table of Contents. e rla- Summary "y x| =
MAX V: SMS70ZT100€S B Flow summary e v @ nstalied P
B EpT_S5MST_AP_ M4 Top E Flow Settings Flow Status Successful - Mon May 0B 21:45:00 2023 v Project Direciory
R Flow Non-Default Global Settings Quartus Prime Version  20.1.0 Build 711 06/05/2020 5J Lite Editio{
B Flow Elapsed Time Revision Name EPT_SMS7_AP_M4_Top “ Library
9 Flow 05 Summary Top-level Entity Name  EPT_SMS7_AP_Md_Top Basic Functions
= FlowLog Family MaxX v osp
Fitter Timing Madels Final Processors and Peripherals
O Flow Messages Total logic slements. 520/ 570(91 %) Unwversity Program
O Flow Suppressed Messages Total pins 73/74(99%) @ Search for Pariner P
Assembler Total virtual ping o
g = Timing Analyz UFM blocks 0/1(0%)
Tasks Compilation v =(g8x
Task Tim
v e
3
»
>
»
>
« S > « > + a
= -
sl O A& A A B8 Find. B8 Find Next
2
= | Type -
. o
o full
© 293000 Quartus Prime Full compilat
£« >
L spemiz)  processing159)

100% 000015

The Programmer Window will open up with the programming file selected. Click on the
Hardware Setup button in the upper left corner.

© Programmer

File Edit View Processing Tools

[ enabl ISP to allow

Window Help

File

8 Auto Detect

" Add File

“ Add Device

when available

Device

Checksum

Usercode

Configure

94

Program/

Page

Ci/Users/nelso/Documents/EPT_SMS7_AP_M4_Transfer_Test/EPT_SMS7_AP_M4_Top/EPT_SMS7_AP_M4 _Top - EPT_SMS7_AP_M4_Top - [EPT_SM57_AP_M4_Top.cdf]* - o x

©

Mode: JTAG

Verify  Blank- Security

Check Bit

Examine Erase ISP
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The Hardware Setup Window will open. In the “Available hardware items”, double
click on “EPT-Blaster v1.0”.

Q Hardware Setup X

Hardware Settings JTAG Settings

Select a programming hardware setup to use when programming devices. This programming

hardware setup applies only to the current programmer window.

Currently selected hardware: | No Hardware h
Hardware frequency: i Hz

Available hardware items

Hardware Server Port Add Hardware...

@G-Blaster v1.0 D Local MBUSB-0
Remove Hardware

Close

If you successfully double clicked, the “Currently selected hardware:” dropdown box
will show the “EPT-Blaster v1.0 (64)”.
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» Hardware Setup

Hardware Settings JTAG Settings

Select a programming hardware setup to use when programming devices. This programming

hardware setup applies only to the current programmer window.

Currently selected hardware: |EPT-JTAG-Blaster v1.0 (64) [MBUSB-0]

No Hardware
Hardware frequency:
« EPT-JTAG-Blaster v1.0 (64) [MBUSB-0]

Available hardware items

Add Hardware...

Hardware Server Port

EPT-JTAG-Blaster v1.0 (64) Local MBUSB-0
Remove Hardware

Close

Click on the Auto-Detect button. This will verify that the EPT-Blaster driver can
connect with the MegaProLogic device.

& Programmer - C:/Users/nelso/Documents/EPT_SM57_AP_M4_Transfer_Test/EPT_SM57_AP_Md_Top/EPT_SM57_AP_M4 Top - EPT_SM57_AP_M4 Top - [EPT_SMS7_AP_Md_Top.cd
File Edit View Processing Tools Window Help

ke, Hardware Setup... |EPT-JTAG-Blaster 1.0 (64) [MBUSB-0] Mode:  JTAG =l

[ Enable real-time ISP to allow background programming when available

Erase Isp

File Device Checksum  Usercode  Program/  Verify Blank-  Examine  Security
CLAMF

'l start
Configure Check Bit
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Select the 5M570 under “Device”.

» Programmer - [Chainl.cdf]”

File Edit View Processing Tools Window Help

]

s Hardware Setup... [EPT-JTAG-Elaster v1.0 (64) [MBUSE-0] Mode: | JTAG - Progress:
[ Enable real-time ISP to allow background programming when available
T File Device Checksum  Usercode  Program/ Verify Blank-  Examine  Security Erase
Start
Configure Check Bit C
th stop c:fJolly/Products/Earth People Tachnotog O0ZETDAA  DDZE7D78 O O O O O O
8 Auto Detect crM o O o O o
UFM O O O O O
Delete
" Add File...
™ ChangeFile.. | LS
D save File
* Add Device .
i up E
" Down e
5M570ZT100
H 73 PR H
Click on the “Change File” button and browse to the output_files folder.
4 select New Programming File
& Hardware Setup... .EP‘I‘-J_'I Look in: C:\Users\nelso\Documents\EPT_SM57_AP_M4_Transfer_Test\EPT_5M57_AP_M4_Top -0 O 0
[ Enable real-time ISP to alloy = My Computer Name Size Type
a nelso db File Folder
incremental_db File Folder
b gy L ¢
Star File Folder
Y Stop <none>
w Auto Detect
X Delete
" Add File...
& save File
<
* Add Device..

TDI File name “

Files of type:  Programming Files (*.sof *.pof * jam * jbc *.ekp * jic)

Click on the EPT_5M57_AP_M4_Top.pof file to select it.
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2
0 Select New Programming File
‘f_ Hardware Setup... |[EPT-11 Look in: C:\Users\nelso\Documents\EPT_S5M57_AP_M4_Transfer_Test\EPT_S5M57_AP_M4_Top\output_files - Q J
D Enable real-time ISP to allov h My Computer Name ) Size Type
& nelso 14 KB pof File
<none>
B8 Auto Detect
X Delete
™ AddFile...
& Save File
* Add Device.. :

Toi  File name:

Files of type: | Programming Files (*.sof *.pof *.jam * jbc *.ekp * jic)

5M570Z |

Click the Open button in the lower right corner.

Xy

EE
Date Modi|
5/8/2023

Cancel

Next, selet the checkbox under the “Program/Configure” of the Programmer Tool. The

checkboxes for the CFM and UFM will be selected automatically.

4 Programmer - [Chain1.cdf]*

File Edit View Processing Tools Window Help

2 Hardware Setup... | EPT-JTAG-Blaster v1.0 (64) [MBUSE-0] Mode: | JTAG -

[ Enable real-time ISP to allow background programming when available

Vb File Device Checksum  Usercode Blank-  Examine  Security Erase
Start
Check Bit c
h st0p C:/Jolly/Products/Earth People Technolog... SM5702T100 DOZE7DAA  OD2E7D78 O [}
® Auto Detect CFM d
UFM O
Delete
™ add File
U Change File.| | L€ e
b Save File
> AddDevice_| || = amaniiaas
- T
up —: b
Wpown ||| "
5M570ZT100
TDO

Click on the Start button to to start programming the CPLD. The Progress bar will

indicate the progress of programming.
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» Programmer - [Chain1.cdf]*

File Edit WView Processing Tools Window Help

_i el ETER= IRl FT-TAG-Blaster v1.0 (64) [MBUSB-0]|

Mode: |JTAG Progress: 6%
Enable real-time ISP to allow background programming when available
" File Device Checksum Usercode | Program/  Verify Blank- = Examine | Security = Erase |
» Configure Check Bit cy
oo | | [ T T
ﬁ Auto Detect CFM
UFM
Delete
" Add File...

- ChangeFile..

4 save File
- Add Device. :w'“m':
u
TOI E
lh Up — 4 »
N

=
=
=
=
u H
u =
=
i Down I PANEEERA
5M570ZT100
TDO
4

When the programming is complete, the Progress bar will indicate success.
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& Programmer - [Chainl.cdfl* B = x

File Edit View Processing Tools Window Help

é Hardware Setup. EPT-JTAG-Blaster v1.0 (64) [MBUSBE-0] Mode: JTAG 7 Progress 100% (Successful)

[] Enable real-time ISP to allow background programming when available

wh geart File Device Checksum Usercode Program/  Werify = Blank- Examine Security  Erase I
Configure Check Bit cL
s Stop C:fJolly/Products/Earth People Technolog... SM570ZT100 002E7DAA  002E7D78 | | || | | | | | |
1
M Auto Detect crM o o
UFM O |
X Delete
I add File..

= ChangeFile.

A

Save File

roanreR s~

® Add Device ..

T
=
i Up e Al » =
H B
' Down t.uuuu:
5M570ZT100
TDO
4

At this point, the MegaProLogic is programmed and ready for use. To test that the
CPLD is properly programmed, bring up the Active Host Test Tool. Click on one of the
LED’s and verify that the LED selected lights up. Press one of the switches on the
board and ensure that the switch is captured on the Active Host Test Tool. Now you are
ready to connect to the Arduino Uno and write some code to transfer data between
microcontroller and PC.

5 Active Host Application

The Active Host SDK is provided as a dll which easily interfaces to application
software written in C#, C++ or C. It runs on the PC and provides transparent connection
from PC application code through the USB driver to the user CPLD code. The user code
connects to “Endterms” in the Active Host dll. These host “Endterms” have
complementary HDL “Endterms” in the Active Transfer Library. Users have seamless
bi-directional communications at their disposal in the form of:

e Trigger Endterm

e Transfer Endterm

e Block Endterm
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User code writes to the Endterms as function calls. Just include the address of the
individual module (there are eight individually addressable modules of each Endterm).
Immediately after writing to the selected Endterm, the value is received at the HDL
Endterm in the CPLD. The Trigger Endterms are used as “switches”. The user code can
set a Trigger bit in the CPLD and cause an event to occur. The Transfer Endterm sends
one byte to the CPLD. The Block Endterm sends a block of bytes. By using one of the
Active Host Endterms, the user can create a dynamic, bi-directional, and configurable
data transfer design.

HOST APPICATION EPM570 CPLD

USER APPLICATION TRIGGER
ENDTERM | AETIVE TRIGGER ENDTERM USER CODE
TRANSFER

Ci# WINDOWS FORM e LIBRARY 8 BIT DATA BUS
C++ CONSOLE TRANSFER S vost (el USB Woermne TRANSFER ENDTERM ]
C CONSOLE ENDTERM o 7/| DRIVER \—— ARDUINO
6 BIT CONTROL BUS
BLOCK ENDTERM
BLOCK ENDTERM ' ]

5 @

5.1 Trigger EndTerm

The Trigger EndTerm is a software component that provides a direct path from the
users application to the commensurate Trigger EndTerm in the CPLD. The Trigger has
eight bits and is intended to be used to provide a switch at the opposite EndTerm. They
are fast acting and are not stored or buffered by memory. When the user code sets a
Trigger, it is immediately passed through to the opposite EndTerm via the USB driver.
When receiving Trigger, the user application is required to respond to a callback from
the Active Host dll.

5.2 Transfer(Byte) EndTerm

The Transfer EndTerm is a software component that provides a direct path from the
users application to the commensurate Transfer EndTerm in the CPLD. It is used to
transfer a byte to and from the CPLD. Eight separate Transfer EndTerm modules can be
instantiated in the CPLD. Each module is addressed by the user application. Sending a
byte is easy, just use the function call with the address and byte value. The byte is
immediately sent to the corresponding EndTerm in the CPLD. Receiving a byte is just
as easy, a callback function is registered at initialization. When the CPLD transmits a
byte using its EndTerm, the callback function is called in the user application. The user
code must store this byte in order to use it. The incoming Transfers are stored in a
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circular buffer in memory. This allows the user code to fetch the transfers with out
losing bytes.

5.3 Block EndTerm

The Block EndTerm is a software component that provides a direct path from the users
application to the commensurate Block EndTerm in the CPLD. The Block EndTerm is
used to transfer a complete block to the CPLD. Block size is limited to 1 to 256 bytes.
Eight separate Block EndTerm modules can be instantiated in the CPLD. Each module
is addressed by the user application. Sending a block is easy, just use the function call
with the address, block length, byte array. The block is buffered into a circular buffer in
memory then transmitted via the USB bus to the Block EndTerm in the CPLD.
Receiving a block is just as easy, a callback function is registered at initialization. When
the CPLD transmits a block using its EndTerm, the callback function is called in the
user application. The incoming Transfers are stored in a circular buffer in memory. This
allows the user code to fetch the transfers with out losing bytes.

5.4 Active Host DLL

The Active_Host DLL is designed to transfer data from the CPLD when it becomes
available. The data will be stored into local memory of the PC, and an event will be
triggered to inform the user code that data is available from the addressed module of the
CPLD. This method of automatically moving data from the user code Endterm in the
CPLD makes the data transfer transparent.

ACTIVE_TRANSFER
MODULE L& DATA RCVD
T EVENT!
ADDRESS [2] o
ACTIVE_TRANSFER_ ACTIVE_HOST
LIBRARY DLL

The data seamlessly appears in Host PC memory from the Arduino. The user code will
direct the data to a control such as a textbox on a Windows Form. The transparent
receive transfer path is made possible by a Callback mechanism in the Active Host dll.
The dll calls a registered callback function in the user code. The user code callback can
be designed to generate any number of events to handle the received data.

The user application will access the CPLD by use of functions contained in the Active

Host dll. The functions to access the CPLD are:
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EPT_AH_SendTrigger ()
EPT_AH_SendByte ()
EPT_AH_SendBlock ()
EPT_AH_SendTransferControlByte()

5.4.1 Active Host Open Device

To use the library functions for data transfer and triggering, an Earth People
Technology device must be opened. The first function called when the Windows Form
loads up is the <project_name>_Load(). This function is called automatically upon the
completion of the Windows Form, so there is no need to do anything to call it. Once this
function is called, it in turn calls the ListDevices(). Use the function List Devices() to
detect all EPT devices connected to the PC.
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private void EPT_Transfer_Test_Load(object sender, .EventArgs e)

{

//String buffer
//Index registers
int Index = 8, EPTgroupNumber = 9;

/ Call the List Devices function
List<string> names = ComPortNames("8483", "6010");

// Get a list of serial port names.

string[] ports;

ports = SerialPort.GetPortNames();

if (names.Count > @)

{
foreach ( port in ports)
o
//Compare port name with the found VID/PID
//combinations. Add them to Matching port list
//and comboDeviist
if (names.Contains(port))
{
MatchingComPortList[Index] = port;
if (Index == Q)
{
PortText = “EPT JTAG Blaster " + EPTgroupNumber;
Index++;
b
else
{
PortText = "EPT Serial Communications " + EPTgroupNumber++;
Index++;
¥
cmbDevList.Items.Add(PortText);
ox.Show("No EPT Devices found!");
//SetButtonEnables_Close();
}

The ListDevices() function calls the

ports = SerialPort.GetPortNames();
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to determine the Serial devices attached to the PC. Next,

if (names.Contains(port))

iIs called inside a for loop to return the ASCII name of each Serial device attached to
the PC. It will automatically populate the combo box, cmbDevList with all the EPT
devices it finds.

cmbDevList.Items.Add(PortText);

The user will select the device from the drop down combo box. This can be seen when
the Windows Form is opened and the cmbDevList combo box is populated with all the
devices. The selected device will be stored as an index number in the variable
device_index.

ol EPT Transfer_Test

| w Open

EPT JTAG Blaster 0

EPT Serial Communications 0
Transrer commas

In order to select the device, the user will click on the “Open” button which calls the
OpenSerialPortl()

function. The device_index is passed into the function. If the function is successful, the
device name is displayed in the label, labelDeviceCnt. Next, the Open button is grayed
out and the Close button is made active.
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public bool OpenSerialPortl()

{
try

/f5et the serial port parameters

serialPort_AH.PortName = PortName;

serialPort_AH.BaudRate = Convert.ToInt32(BaudRate);

serialPort_AH.Parity = (Parity)}Enum.Parse{typeof{Parity)}, vParity);
serialPort_AH.DataBits = Convert.Tolntlé(DataBits);

serialPort_AH.StopBits = (StopBits)Enum.Parse(typeof(StopBits), StopBits);
serialPort_AH.Handshake = (Handshake)Enum.Parse(typeof(Handshake), pHandshake);

if (!serialPort_AH.IsOpen)

serialPort_AH.COpen();
btnOpenDevice.Enabled = false;
btnCloseDevice.Enabled = true;
! ftextBoxl.ReadOnly = false;
return true;
T
¥

catch (Exception ex)

MessageBox. Show(ex.Message) ;
¥

return false;

i

5.4.2 Active Host Triggers

The user application can send a trigger to the CPLD by using the
EPT_AH_SendTrigger() function. First, open the EPT device to be used with
OpenSerialPortl (). Call the function with the bit or bits to assert high on the trigger
byte as the parameter. Then execute the function, the trigger bit or bits will momentarily
assert high in the user code on the CPLD.

private woid btnTriggerl Click({cbject sender, Eventirgs e)

{

¥

To detect a trigger from the CPLD, the user application must subscribe to the event
created when the incoming trigger has arrived at the Read Callback function. The Read
Callback must store the incoming trigger in a local variable. A switch statement is used
to decode which event should be called to handle the incoming received data.

e TRIGGER_IN

EPT_AH SendTrigger((char) 1);
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i

huhiif-ﬁoid EPT_AH_Receive(byte[] receiveBytes)

TRANSFER_IN
BLOCK_IN

uint ¢, a, p, 1, index;
//Compare first byte to the incoming message code

string s = .Empty;

=L (byte b in receiveBytes)

{
5 += Format{"{@:x2}", (int)System.Convert.TolInt32(b.ToString()}))};
5 += "\r\n"j

H

/ FtbBlockRcv.AppendText(s);

//fthis

.Invoke(new MethodInvoker(delegate () { textBoxl.AppendText(s); }));

//Write the command intc the EPTReceiveDevice

c =

receiveBytes[8];

c =c & Bxf8;

/fWrite the address into EPTReceiwveDevice

a =

receiveBytes[8];

a = a & 6xa7;
EPTReceiveDevice.Address = a;
//Display Address to text box

string r = LEmpty;
ro+= .Format ("EPTReceiveDevice Address= {B:%x2}", EPTReceiveDevice.Address);
+= "yrin";
//this.Invoke(new MethodInvoker(delegate () { textBoxl.AppendText(r); }));
switch (c)
{
case @xch:
f/this.Invoke(new MethodInvoker(delegate () { textBowl.AppendText("Trigger Recieved\r\n"); }));
EPTReceiveDevice.Command = TRIGGER_IN_COMMAND;
break;
case @xdd:
f/this. Invoke(new MethodInvoker(delegate () { textBowl.AppendText("Transfer Byte Recieved\r\n®); }));
EPTReceiveDevice.Command = TRANSFER_IMN_COMMAMD;
break;
case @xed:

S /this. Invoke(new MethodInvoker(delegate () { textBowl.AppendText(“Block Recieved\rin"}; }));
EPTReceiveDevice.Command = BLOCK_IN_COMMAND;
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private woid EPTParseReceive(cbject sender, System.Eventirgs e)

{

switch (EPTReceiveData.Command)
1
case TRIGGER_OUT_COMMAND:
TriggerOutReceive();
break;
case TRANSFER_OUT_COMMAND:
TransferOutReceive();
break;
case BLOCK _OUT_COMMAND:
BLockOutReceive();
break;
default:
break;

h
}
The event handler function for the TRIGGER _IN’s uses a switch statement to
determine which trigger was asserted and what to do with it.
public woid Receive Trigger In(cbject sender, Eventirgs e)
{
switch (ept_data.Paylead)
1
case @xal:
lLableswitchl. Text
break;
case @wad:
lLableSwitch2. Text
break;
case Bxdd:
lLableSwitchl. Text .
lLableSwitch2. Text .
break;

"Switch 1%wn Pressed";

"Switch 2%n Pressed";

h

The receive callback method is complex, however, Earth People Technology has
created several projects which implement callbacks. Any part of these sample projects
can copied and pasted into a user’s project.

5.4.3 Active Host Byte Transfers

The Active Host Byte Transfer EndTerm is designed to send/receive one byte to/from
the EPT Device. To send a byte to the Device, the appropriate address must be selected
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for the Transfer module in the CPLD. Up to eight modules can be instantiated in the
user code on the CPLD. Each module has its own address.

private woid btnWriteByte Click{cbject sender, Eventirgs e)
1
int ibyte, address to dewvice;
ibyte = Convert.ToInt32({tbNumBytes.Text);
address_to_device = Convert.ToeInt32(tbAddress.Text);

EPT_AH_SendByte(address_to_device, (char)ibyte);
+
Use the function EPT_AH_SendByte() to send a byte the selected module. First, open
the EPT device to be used with OpenSerialPort1(). Then add the address of the transfer
module as the first parameter of the EPT_AH_SendByte() function. Enter the byte to be
transferred in the second parameter. Then execute the function, the byte will appear in
the ports of the Active Transfer module in the user code on the CPLD.

To transfer data from the CPLD Device, a polling technique is used. This polling
technique is because the Bulk Transfer USB is a Host initiated bus. The Device will not
transfer any bytes until the Host commands it to. If the Device has data to send to the
Host in an asynchronous manner (meaning the Host did not command the Device to
send data), the Host must periodically check the Device for data in it’s transmit FIFO. If
data exists, the Host will command the Device to send it’s data. The received data is
then stored into local memory and register bits are set that will indicate data has been
received from a particular address.

To receive a byte transfer from the Active host dll, user code must subscribe to the
event created when the incoming byte transfer has arrived at the Read Callback
function. The Read Callback must store the incoming transfer payload and module
address in a local memory block. A switch statement is used to decode which event
should be called to handle the incoming received data. The event handler function will
check for any bytes read for that address.
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private woid EPTParseReceive(cbject sender, System.Eventirgs e)

{

switch (EPTReceiveData.Command)

{

case TRIGGER_OUT_COMMAND:
TriggerOutReceive();
break;

case TRANSFER_OUT_COMMAND:
TransferOutReceive();
break;

case BLOCK _OUT_COMMAND:
BLockOutReceive();
break;

default:
break;

¥
b
The EventHandler function EPTParseReceive() is called by the Read Callback function.

The EPTParseReceive() function will examine the command of the incoming byte
transfer and determine which receive function to call.

public woid TransferOutReceive()

1
string WriteRevChar = "";
WriteRcvChar = String.Format("{28}", (int)EPTReceiveData.Payload);
thDataBytes.AppendText(WriteRcvChar + ' ');
thbaddress.Text = String.Format("{@:x2}", (uint)System.Ccnvert.ToUInt32(EPTReceiveData.Address.ToString()

For our example project, the TransferOutReceive() function writes the Transfer byte
received to a text block. The receive callback method is complex, however, Earth
People Technology has created several projects which implement callbacks. Any part of
these sample projects can copied and pasted into a user’s project.

5.4.4 Active Host Block Transfers

The Active Host Block Transfer is designed to transfer blocks of data between Host and
CPLD and vice versa through the Block EndTerm. This allows buffers of data to be
transferred with a minimal amount of code. The Active Host Block module (in the User
Code) is addressable, so up to eight individual modules can be instantiated and
separately addressed. The length of the block to be transferred must also be specified.
The Block EndTerm is limited to 1 to 256 bytes.
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To send a block, first, open the EPT device to be used with
EPT_AH_OpenDeviceBylIndex(). Next, use the EPT_AH_SendBlock() function to send
the block. Add the address of the transfer module as the first parameter. Next, place the
pointer to the buffer in the second parameter of EPT_AH_SendBlock(). Add the length
of the buffer as the third parameter. Then execute the function, the entire buffer will be
transferred to the USB chip. The data is available at the port of the Active Block
module in the user code on the CPLD.

public unsafe woid BlockCompare(cbject data)
1
int BlockAddress = (int)data;
byte[] cBuf = new Byte[device[BlockAddress].Length];

if ({device[BlockAddress].Repititions > @) &
ldevice[BlockAddress].TransferPending & !BlockTransferStop)
1
device[BlockAddress].TransferPending = true;
Buffer.BlockCopy(block_8 in_payload, @, cBuf, @,
device[BlockAddress].Length);
fixed (byte*® pBuf = cBuf)
1
EPT_AH_SendBlock({device[BlockAddress].Address,
(vold*)pBuf, (uint)device[BlockAddress].Length);
h
Thread.Sleep(1);
EPT_AH_SendTransferControlByte(({char)2, (char)2);
Thread.Sleep(1);
EPT_AH_SendTrigger({char)128);
Thread.Sleep(1);
EPT_AH_SendTransferControlByte(({char)2, (char)e);

if (BlockTransferInfinite)
device[BlockAddress].Repititions = 1;
else
device[BlockAddress].Repititions--;

¥
¥

To receive a block transfer from the CPLD Device, a polling technique is used by the
Active Host dll. This is because the Bulk Transfer USB is a Host initiated bus. The
Device will not transfer any bytes until the Host commands it to. If the Device has data
to send to the Host in an asynchronous manner (meaning the Host did not command the
Device to send data), the Host must periodically check the Device for data in its
transmit FIFO. If data exists, the Host will command the Device to send its data. The
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received data is then stored into local memory and register bits are set that will indicate
data has been received from a particular address. The receive callback function is then
called from the Active Host dll. This function start a thread to do something with the
block data.

To receive a byte transfer from the callback function, user code must subscribe to the
event created when the incoming byte transfer has arrived at the Read Callback
function. The Read Callback must store the incoming transfer payload and module
address in a local memory block. A switch statement is used to decode which event
should be called to handle the incoming received data. The event handler function will
check for any bytes read for that address.

private woid EPTParseReceive(cbject sender, System.Eventirgs e)

{

switch (EPTReceiveData.Command)
1
case TRIGGER_OUT_COMMAND:
TriggerOutReceive();
break;
case TRANSFER_OUT_COMMAND:
TransferOutReceive();
break;
case BLOCK _OUT_COMMAND:
BLockOutReceive();
break;
default:
break;
¥
b
The EventHandler function EPTParseReceive() is called by the Read Callback function.
The EPTParseReceive() function will examine the command of the incoming byte

transfer and determine which receive function to call.
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public woid Receive Block In{cbject sender, Eventirgs e)

1
device[ept_data.Address].TransferPending = false;
Thread.Sleep(5);
if (device[ept_data.Address].ContinuosCountTest == false)

1
Thread t = new Thread({new ParameterizedThreadStart({BlockCompare});
t.Start(ept_data.Address);
¥
if (device[ept_data.Address].Repititions == 8)
1
Thread u = new Thread({new ParameterizedThreadStart(Display Block _In));
u.S5tart(BlockCount);
}
else if (BlockTransferInfinite | device[ept data.Address].ContinuosCountTest)
1
if ((BlockCount ¥ 188) == @)
1
Thread u = new Thread({new ParameterizedThreadStart{Display_Block_In});
u.Start{BlockCount);
¥
}

}

For our example project, the Receive_Block_In() function writes the Transfer block
received to a text block.

6 Assembling, Building, and Executing a .NET Project on
the PC

The Active Host Application DLL is used to build a custom standalone executable on
the PC that can perform Triggers and Transfer data to/from the MEGAPROLOGIC. A
standalone project can be range from a simple program to display and send data from
the user to/from the Arduino MEGA. Or it can more complex to include receiving data,
processing it, and start or end a process on the Arduino. This section will outline the
procedures to take an example project and Assemble it, Build it, and Execute it.

This guide will focus on writing a Windows Forms application using the C# language
for the Microsoft Visual Studio with .NET Framework. This is due to the idea that
beginners can write effective Windows applications with the C# .NET Framework.
They can focus on a subset of the language which is very similar to the C language.
Anything that deviates from the subset of the C language, presented as in the Arduino
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implication (such as events and controls), will be explained as the explanation
progresses. Any language can be used with the Active Host Application DLL.

6.1 Creating a Project

Download the latest version of Microsoft Visual C# 2010 Express environment from
Microsoft. It’s a free download.

http://www.microsoft.com/visualstudio/eng/downloads#d-2010-express

Go to the website and click on the “+” icon next to the Visual C# 2010 Express.
g Visual Studio

Products ALM Download Buy

DOWNLOAD 2012 editions 2012 Express 20 Additional software

Prerelease software Readme

Visual Studio 2010 Express

(#) Visual C++ 2010 Express

(S Visual C# 2010 Express

Visual C# 2010 Express Microsoft Captions Language Interface Pack (CLIP)

Build custom applications in Visual C# a simple, powerful, type-safe. and object- The Microsoft Captions Language Interface Pack (CLIP) uses tooltip captions to

oriented language that enables rapid application ith the display for common user interface elements in the Visual Studio

and elegance of C-style languages. After installation, you can try this product for up to integrated development environment (IDE). Use CLIP as a language aid, to see

30 days. You must register to obtain a free product key for ongoing use after 30 days. translations in your own dialect, update results in your own native tongue or asa
leaming tool.

Download language

Engiish [+]

Installation options

+ Arabic - & I
+ Greek - EXMVIKGE

- Hebrew - "2V

Visual G# 2010 Express - English
Install now
G

Click on the “Install now” hypertext.

Visual C# 2010 Express

Build custom applications in Visual C#, a simple. powerful, type-safe, and object-
oriented language that enables rapid with the

and elegance of C-style languages. After installation, you can try this product for up to
30 days. You must register to obtain a free product key for ongoing use after 30 days

Download language

English [~]

Installation options

Visual C# 2010 Express - English
Install nowt
o Install now

- Hindi - Rer

- Hungarian - Magyar

+ Malay - s by

* Malayalam - 00.@2g80
- Oriya-ogel

+ Tamil - 518

- Thai - situe

Choose Language

Microsoft Captions Language Interface Pack (CLIP)

The Microsoft Captions Language Interface Pack (CLIF) uses tooftip captions to
display translations for commen user interface elements in the Visual Studic
integrated development environment (IDE). Use CLIP as a language aid, to see
translations in your own dialect, update results in your own native tongue or as a
learning tool

+ Arabic- 4,4
+ Gresk - EXAUKG

- Hebrew - "MW

+ Hindi - fewer

- Hungarian - Magyar

- Malay - s uoley

« Malayalam - 201@2g0
- Oriya - g2l

- Tamil - sI8

Do you want to run or save ves web.exe (310 MB) from download.microsoft.com?

@ Thistype of file could harm your computer.

Run Save v Cancel

Click the “Run” button.
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L& Microsoft Visual C# 2010 Express Setup L=LE]
| == QO Visual C# 2010
Express

Welcome to the Microsoft Visual C# 2010 Express installation wizard. Microsoft Visual C# 2010
Express is a fun, simple and easy-to-learn development tool for C# programmers interested in
creating Windows Forms, Windows Presentation Foundation (WPF) as well as dass libraries and
console-based applications. This wizard will guide you through the installation process. If this
product requires any prerequisites that are not currently installed on this computer, you will be
able to install those prerequisites as well.

Help Improve Setup

You can submit information about your setup experiences to Microsoft. To
participate, check the box below.

[¥] Yes, send information about my setup experiences to Microsoft Corporation.

i) For more information, click Privacy Statement

Click “Next”, accept the license agreement. Click “Next”.

L7 Microsoft Visual C# 2010 Express Setup =) X
2 s . Micrpsoft*
en i QO Visual ¢ 2010
Express

Installation location cannot be changed. Click here for more information.

Install in folder:

C:\Program Files

| Studio 10.0\ Browse

The following items will be downloaded and installed:
+ Microsoft Visual Studio 2010 Express Prerequisites x64
s Microsoft Visual C# 2010 Express

Disk space requirements: C: 767 MB
Total download size: 47 MB

[ < Previous H Install > H Cancel ]

Visual C# 2010 Express will install. This may take up to twenty minutes depending on
your internet connection.
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[} Microsoft Visual C# 2010 Express Setup = =
Microsafts
S QO Visual C# 2010
Express

Microsoft Visual C# 2010 Express has been installed successfully.

i) Visit Microsoft Update to download the latest service packs and security updates.

Exit

The installed successfully window will be displayed when Visual C# Express is ready
to use.

Once the application is installed, open it up. Click on File->New Project.

12| Microsoft Visual C¥ 2010 Expre
File | Edit View Debug Tools Window Help

A NewProject.. Ctrl+Shifts N[5 | 5 5 B B .
ﬁ Open Project... Ctrl+5Shift+Q0
5 OpenFile.. Ctrl+0

Close

Close Selution

Al Save Selected ftems Ctrl+S
Save Selected ltems As...

@ savenl Ctrl+Shift+S
Export Template...

O] Page Setup...

4 Print.. Ctrl+P
Recent Files 3
Recent Projects and Solutions 3

Exit Alt+F4

SEEYEIL

At the New Project window, select the Windows Forms Application. Then, at the
Name: box, type in EPT_Transfer_Test
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P R

Installed Templates
S _;C“ Windows Ferms Application

Online Templates ¥ weF Application Windows Forms Application i
®
=
i;ﬁ Console Application Visual G
~cH| Class Library Visual C#
WPF Browser Applicstion Visual C&
G| Empty Project Visual C=

Mame: EPT_Transfer_Test

T T

The project creation is complete.

File Edit View Project Debug Dat
HEMEE IR

A T T

EPT_Transfer Test Project Properties

% 2 Solution 'EPT_Transfer_Test (1 project) 2 Forml f=le = G | |§‘

4 ] EPT Transfer_Test
Project File EPT Transfer_Test.cspro

~ || Project File

[AZEIEY S Find Resuits

Save the project, go to File->Save as, browse to a folder to create EPT_Transfer_Test
folder. The default location is c:\Users\<Users Name>\documents\visual studio
2010\Projects.
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14| Project Location

Gl

<« Earth People Technology » EPT Transfer Test » EPT Transfer Test

v | 3 [l Search £PT Transfer Test

I| organize =

New folder

ActiveHost_1.0.06
ActiveHost 1.00.7

Boards

EPT_570_AP_Active_Transfer
EPT_570_AP_Data_Callector
EPT_FT201X Interface
EPT_FT2232 Interface
EPT_FT2232H_ITAG
EPT_FT2232H_SVF_Programmer
EPT_FT2232H_USBTransfer
EPT_Transfer_Test
EPT_Transfer Test
HSP_FT2232H_FPGA
HSP_FT2232H_SPI

Folder: EPT Transfer_Test

*  Name

No items match your search.

m

gz - (7]

Date modified Type

SelectFolder | [ Cancel

6.1.1 Setting up the C# Express Environment for x64 bit

The project environment must be set up correctly in order to produce an application that
runs correctly on the target platform. If your system supports 64 bit operation, perform
the following steps. Otherwise if your system is 32 bit skip to the Section, Assembling
Files into the Project. Visual C# Express defaults to 32 bit operation. If you are unsure
if your system supports, you can check it by going to Start->Control Panel->System and

Security->System

G )=[E » ConuolPenel »

#

- =NEey X

-

~ [ 42 |[[5earch Control Panet )

Adjust your computer’s settings

@

 /

%!

e

o)
4

System and Security
Review your computer's status
Back up your computer

Find and fix problems

Network and Internet
View network status and tasks
Choose homegroup and sharing options

Hardware and Sound
View devices and printers
Add a device

Programs

Uninstall a program

View by: Category ~

User Accounts and Family Safety
@) Add or remove user accounts
) Set up parental controls for any user

Appearance and Personalization

. Change the theme

Change desktop background
Adjust screen resolution

Clock, Language, and Region
Change keyboards or other input methods

. Ease of Access
| Let Windows suggest settings

Optimize visual display

Click on System.
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. - e =EEEET X

-} —
@th‘; » ControlPanel » System and Security » ~ [ 4| [ search Control Panel 2]
=

g

Control Panel Home Action Center

Review your computer's status and reselve issues
#) Change User Account Contrel settings
Troubleshoot common computer problems | Restore your computer to an earlier time

+ System and Security
Network and Internet

Hardware and Sound

ﬂ Windows Firewall
Programs Check firewall status | Allow a program through Windows Firewsll
User Accounts and Family System
P E
Safety w!g Y

View amount of RAM and processer speed | Check the Windows Experience Index

Appearance and . 2
#) Allow remote access | See the name of this computer | B Device Manager

Personalization

Clock, Language, and Region [y Windows Update

Turn automatic updating on or off | Check forupdates | View installed updates

Ease of Access ~f

\[J Power Options

Require a password when the computer wakes | Change what the power buttons do
Change when the computer sleeps L

a& Backup and Restore

Back up your computer | Restore files from backup

£ Windows Anytime Upgrade

<M Get more features with a new edition of Windows 7 -l

Check under System\Sysjte(n type:

L C=een x|
i

@Q 1%+ Control Panel » System and Security b System Search Cantrol Panel o]
-——
Cantrol Pencl Hogg View basic information about your computer
) Device Manager Windows edition
) Remote settings Windows 7 Home Premium
) System protection Copyright @ 2003 Microsoft Corporation. Al rights reserved.
) Advanced system settings Service Pack 1
Get more features with a new edition of Windows 7
|
System
Manufacturer: Gateway L
Model: SX2370 - =
Rating: ‘ﬂ Windows Experience Index '. ’
Processor: AMD A8-3820 APU with Radeon(tm) HD Graphics 2,50 GHz Gateway. |
Installed - able)
| System typ 64-bit Operating System I
Pen and Toweh: TABUE 15 available for this Display
Gateway support |
Website: Online support
Computer name, demain, and workgroup settings |
Computer name: Gateway-DkTp-A8 ) Change settings
See also Full computer name: Gateway-DkTp-AB
Action Center Computer description: L
Windows Update Workgroup: WORKGROUP
Performance Information and
Tools Windows activation
Windaows is activated [ S—

First, we need tell C# Express to produce 64 bit code if we are running on a x64
platform. Go to Tools->Settings and select Expert Settings
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I File Ed._rt View Project
Q- Sdd
PG| & AT @

iU B o |

—_
iod sl

i

Solution Explorer v ox

=1 in|
; Solution 'EPT _Transfer_Test' (1 project)
4 E EPT Transfer Test
> [=d Properties
> [x=3] References
> [E Forml.cs
] Program.cs

sa3unog eyeq il %0q|oo] .

Build Debug Data | Teols
Eg| :_L,l 0 -~ ﬂ; Connect to Database...

=}

[+

Window Help

=3

~ | [# |EPT_570_AP_Data_Collector

Code Snippets Manager... Ctrl+K, Ctrl+B
Cheoose Toolbox Items...
Extension Manager...

External Tools...

Settings r Basic Settings
Customize... v Expert Settings
Options... Reset,

Import and Export Settings...

Go to Tools->Options, locate the “Show all settings” check box. Check the box.

Options

4 Environment
General
Fonts and Colors
Keyboard

» Text Editor

» Debugging

Show all settings

Recent files

m |

items shown in Window menu

iterns shown in recently used lists

Visual experience

|¥] Automatically adjust visual experience based on client performance
Enable rich client visual experience
Use hardware graphics acceleration if available

Visual Studio is currently using hardware-accelerated rendering. The visual
experience settings automatically change based on system capabilities.

Show status bar
Close button affects active tool window only
[] Auto Hide button affects active tool window only

Restore File Associations

)|

Cancel I

In the window on the left, go to “Projects and Solutions”. Locate the “Show advanced
build configurations” check box. Check the box.
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Options I | ? = |
. Environment Projects location:
4 Projects and Solutions c\users\nelsonstrfgridocumentsiwvisual studic 2010\Projects E]
General .
Build and Run User project templates location:
. Text Editor chusers\nelsonstrfgridocumentsivisual studio 2010\Templates\ProjectTemp E]
» Debugging User item templates location:
> Database Tools clusers\nelsonstrfgridocumentsivisual studic 2010\ Templates\ItemTemplat E]
» Text Templating
» Windows Forms Designer Always show Error List if build finishes with errors
s
how advanced build configurations
Always show solution
[7] Save new projects when created
Warn user when the project location is not trusted
[7] Show Output window when build starts
Prompt for symbolic renaming when renaming files
[¥] Show all settings [ 0K ] l Cancel

————— =

Go to Build->Configuration Manager.

L= EPT_Transfer_Test -
File

Edit View Project Build  Debug Data Tools Window

i~ (5 G| 4 & Build Solution g -| |86 -} [ [ er
s | Iz & 4 | T Rebuild Solution = 4 [ =8
i | &2 Configuration Manager... P(
; Solution 'EPT_Transfer_Test' (1 project) a2 Forml = | = =

Fl _E EPT_Transfer_Test
»  [=d Properties
»  |+3] References
> [E] Forml.cs
<] Program.cs

saainog ejeq il %0qIoo) .

In the Configuration Manager window, locate the “Active solution platform:” label,
select “New” from the drop down box.
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Configuration _Manager
Active selution platform:

v] I).gﬁ

[Debug
86
Project contexts (check the project configurations to build or dep

Project Configuration <Edit.>
[=] [=]

EPT_Transfer_Test Debug

'J

Active solutien cenfiguration:

Close

In the New Solution Platform window, click on the drop down box under “Type or

select the new platform:”. Select “x64”.
N — 12 = |

Configuration Manager
-

Active solution cenfiguration: Active solution platform:
[Dabug '] [x86 'I
Project contexts (check the project configurations to build or deploy):

Build

B

EPT_Transfer_Test

Type or select the new platform:

B

Any CPU
Itanium
_l

Create new project platforms

[ 0K ] [ Cancel ]

|

Click the Ok button. Verify that the “Active Solution Platform” and the “Platform” tab

are both showing “x64”.
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Configuration Manager @g
Active solution configuration: Active selution platform?
[Release /] [)@4 \ v]
Project contexts (check the project configurations to build okdeploy]: )

Project Configuration Platform Build
EPT_Transfer_Test Release 04 |z|

Close

Also, select “Release” under “Active solution configuration”. Click Close.
Then, using the Solution Explorer, you can right click on the project, select Properties
and click on the Build tab on the right of the properties window.

#| EPT_Transfer_Test - Mici al C# 20101

File Edit View Project Build Debug Data Tools Window Help
E-;ﬂi‘]'ljlg@‘*fﬁﬁ5|4'f”"-;ﬂ'__$‘b‘Release '||xﬁ4 'HQ

P2 & 3| T oo k| S e B 2 4D star |H[E| G| 2

Solution Explorer - 1 > B Forml.cs [Design] <
=2 = ;
_; Solution 'ERPT_Transfer_Test' (1 project) [ o2 Forml IEI@

4 E EPT_Transfer_Tes* —
> [=d] Properties [ Build
> [x3] References Rebuild

> [E Forml.cs :.$ Publich...
) Program.cs

s22ino5 eyeq 1l x0qoo]

Add >
Add Reference...

Add Service Reference...

Set as StartUp Project

Debug 3
# Cut Ctrl+X
T4 Paste Ctrl+V
X Remove Del
Rename

Properties Alt+Enter

Verify that the “Platform:” label has “Active (x64)” selected from the drop down box.
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sa2unog ejeq gl x0g00L .

~| | % |EPT_570_AP_Data_Collector

|| o e Bl B

onfiguration: | Active (Release) =] (Pratiorm: [active p64) D)
eeeee

Debug Conditional compilation symbols:

[] Define DEBUG constant

Define TRACE constant

Click on the Save All button on the tool bar. The project environment is now setup and
ready for the project files. Close the Project.

6.2 Assembling Files into the Project

Locate the EPT USB-CPLD Development System CD installed on your PC. Browse to
the EPT_Transfer_Test folder where the Project files reside (choose either the 32 bit or
64 bit version, depending on whether your OS is 32 or 64 bit), copy the*.cs files, and
install them in the top level folder of your EPT_Transfer_Test project. These files are:

Active_transfer_xxx.cs

Forml.cs

Form1.Designer.cs
Program.cs
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buv\ « Earth People Technology » EPT USB-CPLD Development System CD » Projects ActiveHost 648it » EPT Transfer Test » EPT Transfer Test » S
rganize v nclude in library + are with = urn ew folder
org Include in library Share with 8 New fold
4 |J EPT USB-CPLD Development System CD “  Name - Date modified Type Size
> )\ Arduino_IDE
Dr e bin File folder
ocumentation
on obj File folder
rivers
Properties File folder
> )\ Projects_ActiveHost 328it et N e
. £) active,transfer_x64. 7
D':Jms::\ ‘mf:zt'm“ & EPT Transfer Test.csproj 5K
civeHost 9
- = EPT_Transfer_Test.csproj.user 1k8
EPT_Data Collector 2 o v
£) Form.cs
A EATE=EATS E| &) Form1.Designer.cs 36 KE
4 || EPT Transfer_Test i Form oen
orml resk 6
bin
' ] Program.cs 3LLMPM  Visual C# Sourcef.. 1k8
obj
Properties

EPTActiveHostConsoleClient
Projects_Arduino
> 1L Projects HDL
Quartus_Programmer -

10 items State: 28 Shared

6.2.1 Changing Project Name

***NOTE***

If you named your project something other than EPT_Transfer_Test, you will have to
make changes to the *.cs files above. This is because Visual C# Express links the
project files and program files together. These chages can be made by modifying the
following:

1. Change namespace of Form1l.cs to new project name.
2. Change class of Form1.cs to new project name.
3. Change constructor of Form1.cs to new project name.

‘ “T$EPT_FT2232 Interface.EPT_FT2232_Interface
—lusing System;
using System.Drawing;
using System.Collections;
using System.Windows.Forms;
using System.Data;
using System.Threading;
using System.Runtime.InteropServices;
using System.Diagnostics;

1

—Inamespacef EPT_FT2232_Interface
{
2

= public partial class system.Windows.Forms.Form
{ 3
= public PT_FT2232_Interfacely
1

InitializeComponent();

for (int 1 = @; 1 < device.length; ++i)

device[i] = new Transfer();
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4. Change EPT_Transfer_Test_Load of Forml.cs to new <project name>_Load

// Main object loaggg

private void T_FT2232_IntErfacE|_LUa ohyject sender, System.Eventirgs e)
1

// Call the List Devices function
ListDevices();

h

5. Change namespace of Form1.Designer.cs to new project name.
6. Change clase of Form1.Designer.cs to new project name.

| Si5EPT FT2232 Interface.EPT ET2032 Interface -| S¥InitializeCompans
—namespafﬂ{. EPT_FT2232_Inter‘Face >
{ 5
= partial class
{ 6

= [// <summary>
'// Required designer wvariable.
[/ </ summary>
private System.ComponentModel.TContainer components = null;

= F <summary>

f Clean up any resources being used.
/ </ summary>

/// <param name="disposing">true if managed resources should be disposed; otherwise, false.</param>
= protected override void Dispose(bocl disposing)

if (disposing && (components != null))
{
components.Dispose();
¥
base.Dispose(disposing);

}

7. Change the this.Name and this.Text in Form1Designer.cs to new project name.
8. Change this.Load in Form1Designer.cs to include new project name.

this.Controls.Add{this.btnTrigger3);
this.Controls.Add{this.btnTrigger2);
this.Controls.Add({this.btnTriggerl);
this.Controls.Add{this.btnCloseDevice);
this.Controls.Add(this.btnOpenDevice);
this.Controls.Add(this.cmbDeviist);
this.Controls.Add{this.LEDBox);
this.Contrels.Add{this.gbTriggerout);
this.Controls.Add
this.Controls, Add TEoapo

this.Name EPT_FT2232 Interface”; 8
this.Text ="“8RL FT2232 Interfzcgl

this.Load += new System.EventHandler(thisgEPT_FT2232 Interface_Load
this.LEDBox.Resumelayout(false);

this.LEDBox.PerformLayout();
this.ghTriggerOut.ResumeLlayout(false);
this.ghTransferControl.Resumelayout(false);

this.gbTransferControl.PerformLayout();
this.groupBoxl.ResumeLayout(false);
this.groupBoxl.PerformLayout();
this.Resumelayout(false);
this.PerformLayout();

9. Change namespace in Program.cs to new project name
10. Change Application.Run() in Program .cs to new projectname.
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using System;

using System.Cellections.Generic;
using System.Lling;

using Syétem.l\lindows.Forms;

namespace {LPT_FT2232_Interface
{

static class Program

1
/ <summary>
// The main entry point for the application.
/1] </summary>
[5TAThread]
static void Main()
{
¥
b

}

6.2.2 Add Files to Project
Open the EPT_Transfer_Test project. Right click on the project in the Solutions

Explorer. Select Add->Existing Item.

File Edit View Project Build Debug Data Tocls Window Help

i S # a9 - E - EE | P [Release ~| |64 -| | # [epT_snt
P & AT | DB e R R 2 e | HE D[,
P on e o [romie et < I
g g Solution 'EPT_Transfer_Test' (1 project) [ o2 Forml [ = =]
g PRE:] [PT,Transfer,'_uf ’
a4 > [=d| Properties [ Build
2 > [:3] References Rebuild
o > [ElFormles | @l publish...
9 L
a ] Program.cs '
® Add Y] MNewltem.. Ctrl+Shift+ A
Add Reference... 2 Existing Item... Shift+Alt+A
Add Service Reference... 4 Mew Folder
Set as StartUp Project 2] Windows Form...
Debug * | & UserControl...
$ Cut Chrl+X “¢  Class... Shift+Alt+C
14 Paste Crl+V
*  Remove Del
Rename

Properties Alt+Enter

Browse to the EPT_Transfer_Test project folder and select the active_transfer_xx.cs
file (choose either the 32 bit or 64 bit version, depending on whether your OS is 32 or
64 bit). Click Add.
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- Properties ~

-4 Solution 'EPT_Transfer_Test' (1 project)
4 P EPT_Transfer_Test
=ij Properties
<3 References
1 Forml.cs
%) Forml.Designer.cs
%) Forml.resx
) Program.cs

1aiodig aseqeieq

@ 34Emors

Description

1\ 0 Warnings | i) 0 Messages

The name 'm_hPort’ does not exist in the current
The name 'fContinue’ does not exist in the curre
The name 'FT_Close’ does not exist in the current
The name 'm_hPort’ does not exist in the current @

28 Error List Rligh

The name ‘'m_hPort” does not exist in the current context

Organize v New folder

[ Microsoft Visual C= 2010 Express
Projects

r Favorites
Bl Desktop
& Downloads
%# Dropbox
. Recent Places
79 Libraries

*& Homegroup

% Computer

File name: active_transfer.cs

Forml.cs

Properties
4] active_transfer.cs
¢4 Forml.cs
%] Form1.Designer.cs
54 Forml.resx
) Program.cs

Visual C= Files (*.cs;".resc™.setti v

Add v Cancel

The name of the
file containing b...

EPT_Transfer_Test

In the C# Express Solution Explorer, you should be able to browse the files by clicking
on them. There should be no errors noted in the Error List box.

File Edit View Project Debug Dats Tools Window Help

-S| B[ b Bl |[REF R

i by A I

Solution Explorer

R Formi.cs [Design]

active_transferes  Forml.cs

[E= e

+ Properties ~ I

BlaEE8

$EPT Transfer_Test.EPT Transfer_Test

~[ 4 components

) Solution 'EPT_Transfer_Test' (1 project)
4 (] EPT Transfer_Test
» [ Properties
> [l References
[=] active _transfer.cs
PRSI
% Forml Designer.cs
% Forml.resx
] Program.cs 5

210/ aseqeieq g

F ——

3] Solution Explorer [ZEEERD 100 %

Error List

@ OErmors | 1\ 2Warnings | (i) 0 Messages
Description

RG] = Find Results

Sinamespace EPT Transfer Test

partial class EPT Transfer Test
{
<summary>
Required designer variable.
</summary>

private System.Componentodel.IContainer components = null;

<summary>
Clean up any resources being used.
</summary>

<param name="disposing”>true if managed resources should be disposed; other

protected override void Dispose(bool disposing)

{
if (dispesing 8% (components != null))

components.Disposa();

il n

File Line
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6.2.3 Adding Controls to the Project

Although, the C# language is very similar to C Code, there are a few major differences.
The first is C# .NET environment is event based. A second is C# utilizes classes. This
guide will keep the details of these items hidden to keep things simple. However, a brief
introduction to events and classes will allow the beginner to create effective programs.

Event based programming means the software responds to events created by the user, a
timer event, external events such as serial communication into PC, internal events such
as the OS, or other events. The events we are concerned with for our example program
are user events and the timer event. The user events occur when the user clicks on a
button on the Windows Form or selects a radio button. We will add a button to our
example program to show how the button adds an event to the Windows Form and a
function that gets executed when the event occurs.

The easiest way to add a button to a form is to double click the Form1.cs in the Solution
Explorer. Click on the "#Z button to launch the Toolbox.
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Mic
File Edit View Project Debug Data Tools Window Help
fglel- S & a9 - | b [ [toottip || e BB -
e & 2| T o BEIEFETER
Solution Explorer * 1 X Forml.es Form1.Designer.cs Forml.cs [Design] ¢ [ElafURIEnE S te] ~ Toolbox > X

[ EEE N b Al Windows Forms =

g Solution 'EPT_Transfer_Test' (1 project), ot Active Host == = 4 Common Controls

= 47 &2 & e ofla = &f af
o3 1) B one 30 g | & & 8 et

5u0jdx3 3seqeieq e

4 (ZH EPT Transfer Test Rk Pointer F
> [=dl Properties E Button
» [ig] References M CheckBox L
(5] active_transfer.cs CheckedListBox
a4 [E] Forml.cs !
§ . ComboBox
'] Forml.Designer.cs F DsteTimePick
9 FormlL.resx ateTimePicker
] Program.cs Transfer Single Byte Transfer Multiple Bytes A Label
Wiie [ LoopBack | A LinkLabel
ListBox
Send Byte 255 Address 2 H ListView
Receive Byte ] MaskedTextBox
m MonthCalendar
== Motifylcon
5 timerlUse [[Z  MumericUpDown
(@  PictureBox
« 1l ] »
= = - @0 ProgressBar
L-g Solution Explorer [ S@FERUEN o . -
Error List > Ix
& 0Errors | 1\ 2 Warnings | (i) 0 Messages
Description File ° Line Column Project °

IEY LY & Find Results

Locate the button on the Toolbox, grab and drag the button onto the Form1.cs [Design]
and drop it near the top.
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EPT_Transfer_Test - Microsoft Visual C3

File Edit WView Project Debug Data Format

idE-ESdd ¥ an|g-o-|
(g & | T @ w

o
&
&
&
]
]
b
o
-
3
3

Solution Explorer
SlaElEE
; Solution "EPT_Transfer_Test' (1 project)
a E EPT_Transfer_Test
> [=d| Properties
» |3l References
(5] active _transfer.cs
a4 [E] Forml.cs
%] Forml.Designer.cs
%] Forml.resx
4] Program.cs

< [ ] »
L‘-‘g Solution Explorer L3

Error List
& 0Errors | 1\ 2 Wamings | (i) 0 Messages

Description

IR & Find Results

e e T

~ 0 X Forml.cs*

2010 Expres:

Tools  Window

b ‘ (E] |tuu|t|p

o | e B

Form.Designer.cs*

s sl erer |RHE| |2

Forml.cs [Design]* < ElaGURIELEE N

al Active Host

Transfer Single Byte

Close

Wite:

Send Byte 235
Receive Byte

B timerUse

LoopBack

Address 2

= e

() Number
) Serial
() Description
Transfer Multiple Bytes
File

Line

m

E

y

Toolbox
> All Windows Forms
4 Commen Controls

k Pointer
Button
CheckBox
CheckedListBox
ComboBox
E DateTimePicker
A Label
A LinkLabel
=3 ListBox
A ListWiew
[e-]  MaskedTextBox
m MonthCalendar
5 Motifylcon
[f2 MumericUpDown
[ﬂ PictureBox
im0 ProgressBar
o o o
Calumn Project .

Go to the Properties box and locate the (Name) cell. Change the name to

“btnOpenDevice”. Locate the Text cell, and change the name to Open.
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L#| EPT_Transfer_Test - Mice

File Edit View Project Debug Data Format Tools Window Help

A Sl 8 a9 - -] b | @ [ootip

PEC (12 & 3| T ek |03 B R e 0 B | & &7 &% er |[H[E| a2

=& EEE
3 Solution "EPT_Transfer_Test' (1 project)
4 (5 EPT Transfer_Test

Solution Explorer * 1 X Forml.cs® Forml.Designer.cs™ Forml.cs [Design]” X [ElafRicht - fd

R BIE

a.l Active Host

> All Windows Forms
4 Common Contrals

Pointer

Button
CheckBox
CheckedListBox

> |=d Properties
|« References v
E active_transfer.cs
5] Forml.cs
‘%] Forml.Designer.cs
‘%] Forml.resx
] Program.cs

J2101di 3seqeieq Sy

ComboBox
DateTimePicker

Transfer Single Byte Transfer Muttiple Bytes Label
LinkLabel

Wre (oopBack ] bk Bye |
ListBox

Send Byte 259 Address 2 222 e
Receive Byte MaskedTextBox
MonthCalendar
MNotifylcon

MNumericUpDown

SrrilElBEE

@ fimerlJSB
PictureBox

D [ Bl k3 Bl BT[]

ProgressBar
£ Solution Explorer [ eEEIEM .

Error List
@ 0Errors | 1\ 2 Warnings | Li) 0 Messages

X - - . -
Description Column Project

YIS = Find Results

Double click on the Open button. The C# Explorer will automatically switch to the
Form1.cs code view. The callback function will be inserted with the name of the button
along with “ click” appended to it. The parameter list includes (object sender,
System.EventArgs e). These two additions are required for the callback function to
initiate when the “click” event occurs.

Private void btnOpenDevice_click(object sender, System.EventArgs e)

There is one more addition to the project files. Double click on the Form1.Designer.cs
file in the Solution Explorer. Locate the following section of code.
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.'I. .'l-

// btnOpenDevice

.'I. .'I-

this.
this.
this.
this.
this.

this

this.

btnOpenievice
btnOpenDevice
btnOpenDevice
btnOpenDevice
btnOpenDevice

.btnOpenDevice.
btnOpenDevice.

.Location = new System.Drawing.FPoint(248, 13);

.Name = "btnOpenDevice™;

.5ize = new System.Drawing.5ize(58, 23);

.TabIndex = 2;

.Text = "Open”;

UseVisualstyleBackColor = true;

Click += new System.EventHandler(thil.btnOpenDevice Click);

This code sets up the button, size, placement, and text. It also declares the
“System.EventHandler()”. This statement sets the click method (which is a member of
the button class) of the btnOpenDevice button to call the EventHandler —
btnOpenDevice_Click. This is where the magic of the button click event happens.

private wvoid btnOpenDevice Click(chject sender, Eventirgs e)

{

//Open the Device
OpenDevice();

}

private wvoid btnCloseDevice Click{cbject sender, Eventirgs e)

1

if (EPT_AH CloseDeviceByIndex(device index) != @)

{

btnBlkCompared.Enabled = false;
btnBlkComparelf.Enabled = false;
btnTriggerl.Enabled = false;
btnTrigger2.Enabled = false;
btnTrigger3.Enabled = false;
btnTriggerd4.Enabled = false;
btnLEDReset.Enabled = false;

h

btnOpenDevice.Enabled = true;
btnCloselevice.Enabled = false;

}

When btnOpenDevice Click is called, it calls the function “OpenDevice()”. This
function is defined in the dll and will connect to the device selected in the combo box.
This is a quick view of how to create, add files, and add controls to a C# project. The
user is encouraged to spend some time reviewing the online tutorial at
http://www.homeandlearn.co.uk/csharp/csharp.html to become intimately familiar with

Visual C# .NET programming. In the meantime, follow the examples from the Earth
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People Technology to perform some simple reads and writes to the EPT USB-CPLD
Development System.

6.2.4 Adding the DLL'’s to the Project
Locate the EPT USB-CPLD Development System CD installed on your PC. Browse to
the Projects_ActiveHost Open the Bin folder, copy the following files:

e ActiveHostXX.dll

o ftd2xxXX.dll
and install them in the bin\x64\x64 folder of your EPT_Transfer_Test project.

@Uv\ <« EPT USB-CPLD Development System CD » Projects_ActiveHost 64Bit » EPT_TransferTest » EPT Transfer Test b bin b 164 b Release -
Organize v €7 Openwith..  Sharewith v Bum  Mewfolder
Arduino IDE * Name - Date modified
Documentation
%) ActiveHostsd.dll 44 PM 7 KB
Drivers = . —
Projects ActiveHost 32Bit A ake
: M am 56 KB
o 871 EPT_Transfer_Testvshost.exe 11:721PM  Application 12KB
e || EPT_Transfer_Testwshost.exe.manifest 0AM  MANIFEST File 1K8
- ’2 |15] fd2edd.dil 1/18 PM  Application extens... 252 K8
bin
Debug
Release
64
Debug
Release
obj
Properties -
2 items selected State: 3 Shared Size: 278 KB Shared with: Homegroup
= Date modified: 1/18/2013 3:54 PM - 3/2... Date created: 3/2/2013 11:20 PM

Save the project.

6.2.5 Building the Project

Building the EPT_Transfer_Test project will compile the code in the project and
produce an executable file. To build the project, go to Debug->Build Solution.
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=] EPT Transter Test - Microse C=rEa

File Edit View Project | Debug | Data Tools Window Help

i~ (5 i @ | & P StartDebugging £5 | 58 3 B L
P % Ry ax 2| = | &5 Build Solution F6
fif Solution Explorer = Steplnto L Designer.cs Forml.cs [Design]* active_transfer.cs* ~ Toolbox
o =| (7 Stepon F10
: FIFEIEE s EPT Transfer Test 5% binClose_Click{object sender, Systerm Eventhn <] - 657"
g -7 Selution 'EPT_Tran Toggle Breakpoint F9 lock Transfer Control E3
L . EPT Transfer_ Windowe » ic bool BlockTransferInfinite = false;
5 . & Properties ic bool BlockTransferReps = false;
2 .l References Clear All DataTips ic beol BleckTransferstop = false;
B | Export DataTips ...
ES] active tran i " ate void btnOpen Click(object sender, System.fventirzs &) |
4[] Forml.cs Import DataTips ...
b= N
é Eﬂfmi[ Opfions and Setings.- Open_Selected Device();
+] Forml.d

1
& Program.cs
o private void btnClose_Click(object sender, System.Eventirgs e)
1 - Properties > X
if (m_hPort != @)
{
fContinue = false; ==
// it will stop in x seconds - not sure if this is proper
Thread.Sleep(888);
FT_Close(m_hPort);
m_hPort = @;

e radiumber. Checked = true; o
3 Solution Explorer [Z3aRETI W% ~ ¢ [ v

Error List > i x
Q 0Enors | 1\ 2Wamings | (i) 0 Messages

Description Fle Line” Column | Project

IEYEHEEY & Find Results

Ready Ln58 Col35 Ch3s INS

The C# Express compiler will start the building process. If there are no errors with code
syntax, function usage, or linking, then the environment responds with “Build
Succeeded”.

Find Results

D | @B | =

&

F_f..; Error List _ﬂ Find Results

Build succeeded

6.2.6 Testing the Project

Once the project has been successfully built, it produces an *.exe file. The file will be
saved in the Release or Debug folders.
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@Uv\ <« EPT USB-CPLD Development System CD » Projects_ActiveHost 64Bit » EPT_Transfer_Test » EPT_Transfer_Test » bin » x64 b Release -
- - -
Organize » Open Share with = Burn Mew folder
Arduino_IDE “ Mame ’ Date modified Type Size
| Documentation i
N %] ActiveHosts4.dIl 3/2/2013%44PM  Application extens... 27KB
| Drivers
’ . 27 EPT_Transfer_Test.exe 3/2/201311:28PM  Application 28 KB
| Projects_ActiveHost_32Bit = e
%] EPT Transfer_Test.pdb 3/2/201311:28 PM  Program Debug D... 56 KB
Projects_ActiveHost 64Bit i
[57 EPT_Transfer_Test.vshost.exe 3/2/201311:21PM  Application 12KB
ActiveHost_10.0.8 ) o ) K i
|| EPT_Transfer_Test.vshost.exe.manifest 8/31/200912:40 AM  MANIFEST File 1Ke
. EPT_Data_Collector § A ,
%] ftd2ed.di 1/18/2013 354 PM Application extens... 252KB
EPT_Transfer_Test 7
EPT_Transfer_Test E ‘
| bin =
Debug
Release
B4
Debug
Release
obj
| Properties -
| EPT_Transfer Test.exe State: 2B Shared Size: 280 KB Shared with: Homegroup
. Application Date modified: 3/2/2013 11:28 PM Date created: 3/2/201311:29 PM

The EPT_Transfer_Text.exe file can now be tested using the MEGAPROLOGIC board.
To test the file, connect the MEGAPROLOGIC to the Windows PC using Type A to
USB-C cable. Make sure the driver for the board loads. If the USB driver fails to load,
the Windows OS will indicate that no driver was loaded for the device. Go to the folder
where the EPT_Transfer_Test.exe file resides, and double click on the file. The
application should load with a Windows form.
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85! EPT _Transfer_Test - m] X
[ ~] [ open
Dis-Connected
Transfer Controls LED Controls
Send Byte: [ 255 Address [ 2]  Receive Byte L0
— = LED1 LED1 LED1
Green Red Biue
—_— LED 2
Muttiple Byte: 55 88 LED 2 LED 2
Green Red Biue
LED3 LED3 LED3
Green Red Blue
PushButton Controls Siide Switch
Switches Slide Slide LED 4 LED 4 LED 4
Switch Switch Green Red Blue
1 2
GPIO Controls

OK Cancel

With the application loaded, select the EPT Serial Communications x board from the
dropdown combo box.
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o) EPT_Transfer_Test - [m] X
] Open
PTITAG Blaster 0 3
EPT Serial Communications 0 Dis Connected
Traks BT . LED Controls
4 LED's
Send Byte: [ 255] Address | 2|  Receive Bjte
LED1 LED1 LED1
Green Red Blue
LED 2
Muttiple Byte: 55 88 LED 2 LED 2
St Red Blue
LED3 LED3 LED3
Green Red Blue
PushButton Controls Slide Switch
Switches Slide Slide LED 4 LED 4 LED 4
Switch Switch Green Red Blue
1 2
GPIO Controls
Hi
Lo
O Infinite
@® Single

OK Cancel

Next, click on the Open button.
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a5l EPT_Transfer_Test - m] X

EPT Serial Communications O

Dis-Connected
Transfer Controls LED Controls
3 LED's
Send Byte: | 255 Address | 2|  Receive Byte
- LED 1 LED 1 LED 1
4 Green Red Blue
5 LED 2
Multiple Byte: 55 88 LED 2 LED 2
Green Red Blue
LED 3 LED 3 LED 3
G Red Bl
PushButton Cortrols Side Switch el > =
Switches Slide Slide LED 4 LED 4 LED 4
Switch Switch Green Red Blue
1 2

GPIO Controls

O Infinite
@ Single

OK Cancel

The “Device Connected” label should be seen to indicate the Windows App is now
connected to the MegaProLogic.
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o5l EPT_Transfer_Test = m] X
EPT Serial Communications 0 v e Close
Transfer Controls LED Controls
2 LED:
Send Byte: Address Receive Byte y
o LED 1 o LED 1 on LED 1
Byte N | Green | | Red Biue
3 LED 2
Mutiple Byte: LED 2 LED 2
On | Green |On | poy“ |On | goo
Multi Byte Rt
o LED3 o LED3 on LED3
" | Green ™ | Red Blue
PushButton Controls Slide Switch
Switches Slide Slide LED 4 LED 4 LED 4
Swich | - _| Swich On | Green |O" | Red O | Bue
1 2
Rst Read Rst Blinky!
GPIO Controls
Start Al
|+ |HE]

O Infinite
@ Single

Click on one of the LED buttons in the middle of the window. The corresponding LED
on the MegaProLogic board should light up.
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o) EPT_Transfer_Test - m] X
IEPT Serial Communications 0~ ‘ Ope: Close
Device Connected
Transfer Controls LED Controls
Send Byte: Address Receive Byte LEDS
LED 1 0 LED 1 LED 1
Byte On | Green [O" | Red |7 | Bie
g LED 2
Mutiple Byte: LED 2 LED 2
On | Green|[OF | |req * |00 | Boe
Muti Byte =
o on]| LED3 LED3 [ | LED3
" | Green " | Red Blue
PushButton Controls Slide Switch
Switches Slide Slide LED 4 LED 4 LED 4
Swtch | - _ | Switch On | Green [O7 | Red || Bue
1 2
Rst Read Rst Blinky!
GPIO Controls
Start = = IR
oE Lo
O Infinite n
@® Single

STECHNOLOG : 1} =
.-' EPT-SMST-AP-M " 2 i - Sl

= 3 - R0 |

/0 YoLT 4 =

OK Cancel

i

iiimli““‘

CACICCR

®
®
®
®
®
LJ
®
®
®
®
®
®
L)

(1] 1/0 voLT
- L& SELECT

for
)
®
©
O
©
®
®©

Clink on the Blinky button for a light show.
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a5 EPT _Transfer_Test - [m] X

|EPT Serial Communications 0+ Close
Device Connected
Transfer Controls LED Controls
Send Byte: [ 25| Address [2]  Receive Byte ' Lo
. LED1 LED1 LED1
Byte On | Green On Red |07 | Blue
[ LED 2
Mutiple Byte: |55 88 LED2 LED2
L On  Green On | pi” On | g0
Mutti Byte Rst
LED3 LED3 LED3
On Green O Red On Blue
PushButton Controls Slide Switch
Switches Slide Slide LED 4 LED 4 LED 4
Swich .| Swtch On | Green |07 | Red | O" | Bue

To exercise the Single Byte Transfer EndTerm, click the “Byte” button in the Transfer
Controls group. Type in several numbers separated by a space and less 256 into the
Multiple Byte textbox. Then hit the Multi Byte button. The numbers appear in the
Receive Byte textbox.
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o EPT Transfer Test - o X 85 EPT Transfer Test — O X
EPT Seal Commurvcations 0 Cose EPT Serial Communications 0 v s
Devce Comected Device Connected
Transter Controls LED Cortrols Transfer Controls LED Controls
Send Byte: | 255 Address | 2|  Receive Byte e Send Byte: | 255| Address [ 2| | Receive Byte |. 255 L
LED1 LEDY LED1 LED1 LED 1 LED1
O | Geen |0 | Red O | Bue O | Gren || Red |00 | Bue
ED2 LED2
Mutple Byte: [55 82 - LED2 LED2 Mutiple Byte: LED2 LED2
On | Gren On | pig® On | pod On | Gren |OFf | p2g%|On | goo
M Bte = Mt Byte =
&) 2 (o] 2 ] 22 (] 2 ]
PushButton Controls Side Swich PushButton Controls Side Swich
Swtches Sude Side LED4 LED 4 LED4 Switches Side Side LED 4 LED 4 LED 4
Swech Swich O | Gren |97 Red || Bue Swich | - | Swich O | Green |0 Red |0
1 2 1 2
Ret Resd Rt Binky! Rt Read st Binky!

GPIO Controls
Statt

O Infinte
@© Singe

oK Cancel

To exercise the Block Transfer EndTerm, click the “Start” button in the GPIO Controls
group. The MegaProLogic will sample the state of each Input pin of the CPLD that is

connected to a board edge connector. The Transfer Test Window will display the results
of each pin, Hi or Lo
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85! EPT_Transfer_Test - o X
|EPT Serial Communications 0 | Close
Device Connected
Transfer Controls LED Controls
Send Byte: | 255| Address | 2|  Receive Byte 2
— T o LED1 LED1
Byte On | Green |On ;E(?‘ On | Bue
] LED 2
Mutiple Byte: |55 88 LED 2 LED 2
l On | Green On Red On Blue
Muti Byte Rst
LED3 LED 3 LED3
On Green On Red On Blue
PushButton Controls Slide Switch
Switches Slide Slide LED 4 LED 4 LED 4
Swtch Swich O | Gren |O" | Red | O" | Bue
1 2
Rst Read Rst Blinky!
A H
{1+ BT

The results of each pin are displayed next to the image of the MegaProLogic in separate
buttons.
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85! EPT_Transfer_Test

- ] X
{EPT Serial Communications 0 Close
Device Connected
Transfer Controls LED Controls
Send Byte: 255! Address D‘ Receive Byte LED's
— - LED 1 LED 1
Byte On | Green On lﬁid?] On | Bue
[ecega LED 2
Muttiple Byte: |55 88 LED 2 LED 2
l ] On | Green (On | p=y“|On | pgoo
Multi Byte Ret
LED3 LED3 LED3
On Green On Red On Blue
PushButton Controls Slide Switch
Switches Slide Slide LED 4 LED 4 LED 4
Switch | . . Switch On | Green |97 | Red |O" | Bue
1 2
Rst Read Rst Blinky!
GPIO Controls
AAANAARNARN AR AR nn
m oy
B L

fif o 5 55 Goe PO

— e 44444
EJ_ ’F ¢ v‘ C ' €

*"*—-:lT i SELECT o | i
@‘ e b
b wisi 3% U yowry s v fiiiiiid a0 s

OK Cancel

Use a jumper cable to connect between +3.3V and any of the Input pins to see the
display detect a high on the selected pin.
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RTI OPL!
ECHNOLOGY
)

= 'Y epT-sNs7

| 10 voLT
3 lastueer

o) EPT_Transfer_Test - m} X
iEPT Serial Communications 0 v Close
Device Connected
Transfer Controls LED Controls
Send Byte: | 255 Address [ 2|  Receive Byte LED
7 = LED1 LED1
Byte On | Green On hig‘ On | Bue
| LED2
Muttiple Byte: |55 88 LED 2 LED2
L H On | Green On 4" |On | goo
Mutti Byte Rst
On LED3 On EESJ On léife)J
PushButton Controls Slide Switch
Switches Slide Siide LED4 LED 4 LED4
Swich | - .| Swich On | Green |9 | Red |07 | Bue
Switch 2 1 2
Pressed
Rst Read Rst Blinky!
GPIO Controls
AARNAARAARN AAAAARAARN AN
m oy
[+ T

I
il L

T .

OK Cancel
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Click on the “Infinite” radio button and “Start” to see a simple logic analyzer.
[m} X

o) EPT _Transfer_Test -

EPT Serial Communications 0 v Close
Device Connected
Transfer Controls LED Controls
Send Byte: [ 255] Address | 2|  Receive Byte LED's
. . LED1 LED1 LED1
Byte On | Green On Red On | Bie
] LED 2
Mutiple Byte: |55 88 LED 2 LED 2
L J On | Green On | pli® On | g0
Muti Byte Rst
LED3 LED3 LED3
On | Green (9" | Red |97 | Bue
PushButton Controls Slide Switch
Switches Slide Slide LED4 LED4 LED 4
Swtch | .| Swich On | Green |97 | Red |7 | Bue
Switch 2 1 2
Pressed
Rst Read Rst Blinky!
GPIO Controls
AAAAAAARN AARAAARAARN AR
oy
|+ [NT]

OK Cancel

Press the PCB switches on the MegaProLogic to view the Switch Controls in action.
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85! EPT_Transfer_Test - [m] X

[EPT Seral Communications 0 | Close
Device Connected
Transfer Controls LED Controls
Send Byte: | 255 Address [ 2|  Receive Byte =226
¥ LED1 1 LED1
Byte On | Green On RLEeg On | Bie
LED 2
Muttiple Byte: |55 88 LED 2 LED 2
] On | Green (On | pli” On | pgoo
Muti Byte =
LED3 LED 3 LED3
On Green On Red On Blue
PushButton Controls Slide Switch
Switches Slide Slide LED 4 LED 4 LED 4
Swich |- .| Swich On | Green |0 | Red |9 | Bue
Switch 2 1 2
Pressed
Rst Read fat Blinky!
GPIO Controls
AMAANANARANARN ARNAARAARNARN nn

a3
5z

OK Cancel

7 Designing a Simple Data Collection Sampler

The Data Collection Sampler is a very simple introductory project that will guide the
user in the creation of an overall design using the Arduino Programming Language,
Verilog HDL, and C# Language. These elements will run on the Arduino Platform,
MEGAPROLOGIC-M4 CPLD, and a Windows PC respectively.
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The first order of business is to layout the design. Start with the Arduino, and create a
simple bit output using a random number generator. Next, use the EPT Active Transfer
Library to create a byte transfer module to read the byte from the Arduino and send it to
the Host PC. Finally, use EPT Active Host to accept the byte transfer from EPT Active
Transfer, and display in a textbox. This is just the hierarchical system level design. In
the following sections, we will fill in the above blocks.

7.1.1 The Arduino Microcontroller Board

Using the features and capabilities of the Arduino development system, the user will
develop the source code using the “Wiring” programming language and download the
resulting binary code from the Processing development environment to the Flash
memory of the microcontroller.

7.1.2 Create Data Generator

To keep the design simple, no external data source will be used. We will create a data
source using the Arduino, then transmit this data to the MegaProLogic board. To create
the data source, we will use the random() function. This function generates pseudo
random numbers from a seed value. We will give the randomSeed() function a fairly
random input using the value from the analogRead(). This will give different values
every time the random() function is called. We will limit the random number output
from the function to 8 bits. The random() function will be called once per iteration of
the loop() function.

The randomSeed() function must be called during the setup() function. It takes as input
parameter the output of the Analog Pin 1. The output of this Pin 1 will have a small
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amount of random noise on it. Because of this noise, the randomSeed() function will
produce a different seed every time the sketch is initialized.

vold setup ()
{

randonieed (analogRead (1))

'

7.1.3 Select1/0’s for Fast Throughput on Arduino

An 8 bit port is used to connect the 8 bit byte from the random function output to the
input of the MegaProLogic. There is also a one bit control line which will be used to
inform the CPLD that a byte is ready to be written to the USB.

|
START-STOP
PORT A

Arduing Mega 2560

LB_BYTE_D[0D]

LB_BYTE_C

0 C_ENABLE

= 0ASE0S GOGE0A80 ASDRGEOR

LB_BYTE_B|[0]

Each port is controlled by three registers, which are also defined variables in the
Arduino language. The DDR register, determines whether the pin is an INPUT or
OUTPUT. The PORT register controls whether the pin is HIGH or LOW, and the PIN
register reads the state of INPUT pins set to input with pinMode(). The maps of the
ATmega328 chips show the ports.

DDR and PORT registers may be both written to, and read. PIN registers correspond to
the state of inputs and may only be read.
PORTA maps to Arduino digital pins 0 to 7

DDRA - The Port A Data Direction Register - read/write

PORTA - The Port A Data Register - read/write
PINA - The Port A Input Pins Register - read only
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The ports and pins for the Data Collection Sampler project must be initialized in the
setup() function. The setup function will only run once, after each powerup or reset of
the Arduino board.

vold setup ()

i
DDEL = B11111111; //%et Fort A4 as outputs
PORTA &= B11111111; //Turn on Fort A pins

After the setup() function executes, the PORTA is ready to be assigned the results of
our random() function. And the AO pin will be used to latch the value on PORTA pins
into the CPLD.

7.1.4 Coding the Arduino Data Sampler

Now that we have the data generator and the ports defined, we can add some delays in
the loop() function and make a simulated data collector. Because Start and Stop buttons
will be added to the C# Windows Form, the Data Collector code will need to monitor a
single pin output from the MEGAPROLOGIC. This output pin (from the

MEGAPROLOGIC) becomes an input to the Arduino and is used in conditional switch.
volid loop ()

{

Ji%anmple the 3tart/Stop switch
Affrom the EPT-570-4PF
gtartitopEit = digitalRead(inPing);

delay(500): //Delay 500 ns

if(startitopBit)

{
This code will sample the Start/Stop switch which is an output from the
MEGAPROLOGIC on J5 PIN 3. On the Arduino, this is PIN 19 of the Digital pins.
Each iteration of the loop() function, the startStopBit variable stores the state of
DigitalPin19. Then, a delay of 500 milliseconds is added. The delay() function pauses
the program for the amount of time (in milliseconds) specified as parameter. Next, the
startStopBit is checked with a conditional switch. If the bit is set, the conditional branch
is entered and the random number is sent to the MEGAPROLOGIC. If the bit is not set,
the end of the loop() function is reached and it branches to the top of the loop().
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We will also add an LED Pin that will blink so that we can have a visual indication that
the project is working.

We want to add a delay so that the data from the generated displays on the Windows PC
long enough for our eyes to verify that the data is updating correctly. This delay should
be one second in total. So, the data will change then stay stable in the textbox for one
second before changing again.

For the LED to blink correctly, it should turn on, delay for half a second then turn off
and delay for half a second. If we don’t use half second intervals for the LED blink, the

LED will appear to not change at all. It will look like it stays on all the time or off all
the time.

So, the code looks like this:
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J,-'*
Copyright Earth People Technology Inc. =013

Ilata Collector Random Seed
Platform: EPT-570-AP-M4
*/
int sgtartitopBit = 0;
int count = 0;
13:

int inPind = 19;
int C_Enahle = 37;

int ledPin

vold setup )

{
DDRA = B11111111; //%et Port A as outputs
PORTA &= B11111111; //Turn on Fort 4 pins

pintode {C_Enable, OUTFUT);
pinMode {ledPin, OUTFOT) ;
pinMode {inPind, OUTFUT) :

randomSeed(analohRead(l]];

woid loop ()
{

FAf%anple the 3tart/3top switch
Aifrom the EPT-570-4P
startitopBit = digitallead({inPing):

delay(500); //Delay 500 ns

if[atartitopEit)

i
Jf Write a randon number from 0 to 299
J7to the input of the EPT-570-4F
PORTA = random(255);
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A48et the Write Enable Pin High
digitallrite (C_Ensahle, HIGH):

J/5et the LED Pin High
digitalllrite (ledPin, HIGH):

delay(500); f/Delay 500 ms

A45et the LED Pin Low
digitalllrite (ledPin, LOW):
F#5et the Write Enahle Pin Low
digitalWrite (C_Enahle, LOW):

'

Notice that PORTA equals the return of random(255). The parameter passed to the
random() function is the maximum decimal value of the return value. In our case we
want the maximum value to be an 8 bit value, B11111111 = Oxff = 255(decimal). Also,
note that the C_Enable write enable signal for the CPLD has back to back instructions
turning it on then off immediately. Because the ATMega328 chip takes approximately
160 clock cycles to execute the digitalWrite() function and affect the Pin at C_Enable,
this produces a write enable pulse of 10 microseconds.

10 us
C_ENABLE
PORT A RANDOM VALUE -

The RANDOM VALUE will be stable before the C_Enable asserts thus guaranteeing a
successful transfer of data from Arduino to CPLD.

7.1.5 Building Arduino Project

Building the Arduino project is the process of converting (compiling) the code you just
wrote into machine level code that the processor can understand. The Arduino IDE is
the software tool that does the compiling. The machine level code is a set of basic
instructions that the processor uses to perform the functions the user code. Browse to
the \Projects_Arduino\Arduino_Data_Collector_Code\ folder of the EPT USB-CPLD
Development System CD. Copy Arduino_Data_Collector_Code_M4.ino .
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To compile your code,
e Open up the Arduino IDE

» Computer » Jolly Laptop PC (C) » Jolly » Products » Arduine » arduino-101 »

Organize ~ [E) Open Bumn New folder

o me
Drivers X
drivers
FunctionalSp
exampl
License
hardw:
Products | ‘
java
Altera
N lib
ting
; tibrar
Arduing
reference
. arduino-1.01
tools
MEGA 2560
ar
Uno
Atmel - .=
%) cvawin.
(& sketch_oct?7a | Arduino 1.0.1 = Shared witl
File Edit Sketch Tools Help

sketen_oct27a

e Paste your code into the Sketch.
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Lookin: |, Arduino_Data_Collector_Code - &

P Name ’ Date modified Type

e {"JArduing Data Collector Code.no, 1073373013 831 AR TN File
Recent Places

Desktop

Libraries

L&_'

Computer

File Edit Sketch Tools Help

Arduino_Data_Collector_Code §

Network I
File|| Earth People Technology Inc.

Flell  paca collector Randow Seed

Platform: Uno
*

int count = 0
int ledPin = 13;

void setup ()
{
DDRD =

pinMode (A0, OUTPUT] ;
pinfode (ledPin, OUTFUT) ;

B11111111; //3et Port D as outputs
PORTD &= Bl1111111l; //Turn on Fort D pins

"
Arduino_Data_Collector Code | Arduino Lm-gﬂ ]

m

Click the Verify button

Arduino_Data_Collector_Code §
Ie
Earth People Technology Inc.

Data Collector Random Seed

Platform: TUno
=

int count =
int ledPin

woid setup()

{
DDRD = BLL111111: //Set Pore D as cutpucs
FORTD &= B11111111; //Turn om Fort D pins

pinMods (A0, OUTPUT):
pinkode{LledPin, OUTEUT);

-
Arduino_Data_Collector_Code | Arduino 1.0.1 _El_ﬂ_g

File Edit Sketch Tools Help

m

The sketch will compile
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e If there are no errors, the compiling will complete successfully

Arduino Uno on COMAE

Now we are done with compiling and ready to program the Arduino

7.1.6 Programming the Arduino

Programming the Arduino is the process of downloading the user’s compiled code into
the Flash memory of the Atmel ATMega328 chip. Once the code is downloaded, the
Arduino IDE resets the chip and the processor starts executing out of Flash memory.

To program the Arduino
e Connect the USB cable from PC to Arduino

—

e Load the Arduino USB driver according to the manual

e Plug in your board and wait for Windows to begin it's driver installation
process. After a few moments, the process will fail, despite its best efforts

e Click on the Start Menu, and open up the Control Panel.

e While in the Control Panel, navigate to System and Security. Next, click on
System. Once the System window is up, open the Device Manager.
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e Look under Ports (COM & LPT). You should see an open port named "Arduino

MEGA (COMxx)"

e Right click on the "Arduino MEGA (COmxx)" port and choose the "Update

Driver Software" option.

e Next, choose the "Browse my computer for Driver software" option.
e Finally, navigate to and select the MEGA's driver file, named

"ArduinoMEGA.inf", located in the "Drivers" folder of the Arduino Software

download (not the "FTDI USB Drivers" sub-directory).
e Windows will finish up the driver installation from there.

. _j
"= Device Manager

File Action View Help

=% | FEHEIE B KS

R

EEE) -

4 -2 NelsonsTrfgr-PC

545 Batteries

> % Computer

> g Disk drives
> B, Display adapters
> - DVD/CD-ROM drives
> &% Human Interface Devices
> g IDE ATA/ATAPI controllers
> -4 Imaging devices
»-&F Jungo
> Keyboards
> Il Mice and other pointing devices
- Monitors
- Network adapters
T Ports (COM & LPT)
{5 Arduino UNO R3 (COMA4E)
> [} Processors
>-% Sound, video and game controllers

e

> .78 System devices
>~ § Universal Serial Bus controllers

e Once the driver is loaded, we can set the COM Port. Click on Tools and select

.
@ || Update Driver Software - Arduina UNO R3 {COM46) I

Search for driver software in this location:

Browse for driver software on your computer

Select the folder that contains drivers for your hardware.

4 | Arduino
4 | arduino-0023
a

| drivers
\. FTDIUSB Drivers
> o examples
> |0 hardware

I java
> L lib
> U libraries

> . reference

| tools

Folder:  drivers

Serial Port, then click the available port.
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-
Arduino_Data_Collector_Code | Arduino 1.0,
File Edit Sketcl

Auto Format
Archive Sketch
Fix Encoding & Reload

Arduino_Data_|

ris

Serial Monitor Ctrl+Shift+M o
Earth FPeoply
Board 3
Data Coll
e ke Serial Port v v | comas
Platform: 0 E
Programmer 4

7
Burn Bootloader
int count = 0;
int ledPin = 13; L

woid setup ()

{
DDED = B11111111; //%et Fort [ as outputs
PORTD &= BLLL11111; //Turn on Port D pins

pinMode (40, OUTEUT) ;
pinMode (ledPin, OUTPUT)

e To load the code, click on the Upload button.

Arduino_Data_Collector Code | Arduino Luz_[gl_‘g
File Edit Sketch Tools Help

Arduing_Data_Collector_Code §

i* -

Earth People Technology Inc.

Data Collector Random Seed

m

Flatform: Uno
i

int count = 07
int ledPin = 13; —

woid setup ()

{
DDED = BL1111111; //3et Port D as outputs
PORTD &= B11111111; //Turn on Fort D pins

pinMode (A0, OUTETT) ;
pintode (ledPin, OUTEUT)

Page

159



@ !EAR'I;HPE|OPLE
& 6 n o o g vy

USB CPLD Development System User Manual

When the code has completed loading, the Arduino IDE will automatically command
the processor to start executing the code. The L LED will blink at one second intervals.

MADE ®

INITALY 888
3
- n -40 »
- )
| e

7.1.7 CPLD Active Transfer Coding and Initiation

The MEGAPROLOGIC will accept the data collected by the Arduino and
transfer it to the PC. It is designed to plug directly into the Arduino MEGA and there is
no need for external wires to be added. The Active Transfer Library can be used to send
the data to the PC. This library has been designed to make it easy to transfer data to and
from the PC via the USB. The user must create some interface code between the
incoming data and the Active Transfer Library. We will now go through exercise of
creating the CPLD code for the Data Collector Sampler.

7.1.8 CPLD: Define the User Design.

In this step we will define the user’s code and include modules from the EPT
Active Transfer Library. The Active Transfer Library contains a set of files with a
“.vgm” name extension which select particular operations to perform (e.g., byte
transfer, block transfer, trigger). The active_transfer_library.vgm file must be included
in the top level file of the project. The function modules will connect to the
active_transfer_library and provide a path to connect user code to the library. All of
these files are available on the Earth People Technology website.
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TRIGGER ENDTERM
ACTIVE TRANSFER SINGLE TRANSFER
LIBRARY ENDTERM USER G

BLOCK ENDTERM

We will build our CPLD project using Quartus Prime software from Altera. The
primary file defining the user’s CPLD project is named “EPT_570_AP_M4_Top.v”. It
defines the user code and connects the active_transfer_library and active_transfer logic
functions. In order to route the pins of the Arduino to the CPLD, the Pin Planner tool is
used. This tool allows the user to match internal net names to the pins of the CPLD.

Our project needs to accept an 8 bit value on the J3 connector and a write enable on Pin
3 of J5. For this, we can use the active_transfer.vgm module as the interface to the
active_transfer_library. It accepts a single byte and latches it with a single enable net.
Because the active_transfer_library runs at 66 MHz we will need to write some code
ensure that the slower C_Enable signal from the Arduino can latch the data into the
active_transfer module.
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INPUT/OUTPUT PINS

i

TOP LEVEL |

T T

ACTIVE TRANSFER USER CODE

LIBRARY
TRIGGER IN
TRIGGER OUT

TRANSFER IN
T? TRANSFER OUT
(‘ UC_0UT(21..0] >
i | [ |
< UC_IN[22..0] >

CPLD: Coding up the DesignThe first thing to do is to create a top level file for the
project. The top level file will include the input and outputs for the CPLD. These are
declared according to the Verilog syntax rules. We won’t go through all the rules of
Verilog here, but feel free to explore the language more thoroughly at

www.asic-world.com/verilog/

We need to add the inputs and outputs for active_serial_library, user code, leds, and
switches. Each port is described as input, output or inout. It is followed by the net type
wire or reg. If it is a vector, the array description must be added.
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module EPT_SMS7_AP M4 Top (

input wire CLK_€€MHZ,
input wire RST,

' /UART COMMAND BUS

output wire UART_OUT,
input wire UART_IN,

input wire LB XIOLxa,
LB_XIOLC,

LE_XICH,

input wire
input wire

L S S

input wire LB _CoMM,
input wire LB AD,
input wire LB ICH,
//Transceiver Control Signals
output wire TR _DIR 1,
output wire TR OE_1,
output wire TR_DIR 2,
output wire TR_OCE 2,
output wire TR_DIR 3,
output wire TR_OCE_3,
output wire TR_DIR 4,
output wire TR OE_4,
output wire TR_DIR 5,
output wire TR OE S
Page

163



@ !EAR'I;HPEPPLE
8 © n o O g Yy

USB CPLD Development System User Manual

Next, the parameter’s are defined. These are used as constants in the user code.

//Header Bytes for the Transfer Loopback detection

parameter TRANSFER CONTRCL_EYIEL =
parameter TRANSFER CONTROL BYTEZ =
parameter TRANSFER CONTROL EYTE3 =

/S /5tate Machine Transfer Loopback detection

parameter TRANSFER CONTRCL IDLE = O,
TRANSFER CONTROL HDR1 = I,
TRANSFER CCONTROL HDRZ = 2,
TRANSFER _DECODE BYTE = 3,
TRANSFER CONTROL SET =

parameter GLOBAL RESET COUNT =
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Next is the Internal Signal and Register Declarations.

R R R R R R A R R R R R A AR R R AR R R AR AR RR

* Internal Signals and Registers Declarations

SRR R R R R R R A R A A R A A R R R A R A AR A R R A A A R R A A AR A AR A AR R R AR AR AR R R AR AR

wire CLE_&&;
wire RET:
wire [ 0] Uc_IN:
wire [21:0] uc_ouT:
1=
trigger out;
trigger in byte;
trigger_in store;
reg led reset;

reg switch reset;

wire transfer out;

reg transfer out_reg;

wire transfer in received;
wire [7:0] transfer in byte:

wire [7:01 transfer out byte;

reg [2:0] transfer to_host_ counter;
reg [2:0] transfer to_ host_state;

reg transfer in loop back;

reg transfer in received reg:
reg [2:0] transfer control state;
reg [7:0] transfer control byte;

Write from Arduino
transfer write reg;
transfer write;

transfer write byte;

wire reset;

reg [11:0] reset counter;
redg reset_signal_reg:;

S Input/Cutput Signals
reg start_stop_cntrl;
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Next, add the assignments. These assignments will set the direction of the bus
transceivers that interface to the Arduino I/O’s. The transceivers also include an output

xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx

* Signal Assignments

assign LE BYTE A[7:0] =

assign TR DIR 1 = ; /1l =4 to Br 0=0B to A
assign TR CE 1 =

assign TR_DIR_E = :ff1 = A to B 0 =B to &
assign TR _OE_2 =

as=ign IR _DIR 3 = : /fl =4 to Bf 0 =B to A
assign TR CE 3 =

//Clock and Reset

assign CLE 66 = aal[l]:

assign R5T = reset;

assign reset = reset_signal_ reg;

/{Transfer registers

assign transfer out = transfer out reg | tranzfer write;
assign transfer out byte = transfer write byte;

S/LED3 is used to signify to the user that the 5tart
f/switch is enabled

assign LED3 = =start stop_cntrl ?

The reset signal is generated by a counter that starts counting upon power up. When the
counter reaches GLOBAL_RESET_COUNT.
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xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx

always=s @ (posedge CLE_IN or negedge 2a[C])
begin
if(laa[C0])
kegin
reset_signal_reg <=
reset_counter <=
end
else
begin
if( reset_counter < GLOBAL RESET COUNT )
begin
reset signal reg <=
reset_counter <= reset_counter +
end
else
begin
reset_signal reg <=
end
end

The four LED’s are set by the bottom four bits of the active trigger output register.
These trigger outputs can be set by using a function in the Active_Host DLL on the PC.
The Data Collector project will use LED3 to indicate the state of the Start/Stop signal.

f/ALED2 is used to signify to the user that the Start

ffswitch is enabled

as=ign LED3 = ~2tart stop cntrl:
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always @(trigger in byte or led reset or LED or R3T)
begin
if(!R5T)
LED[Z:0] =
else if(led reset)
LED[Z2:0] =
else if(trigger in byte[3:0])
begin
case(trigger in byte[2:0])

LED[O]

LED[1]

LED[Z]
defanlt:
LED[2:0] = LED[2:0]:

endcase
end

end

The two user switches are connected to the input trigger register. Pressing a switch will
send a trigger to the PC to be decoded by the Active_Host DLL.
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always @ (posedge CLE IN or negedge RST)
kegin
if ('RST)
begin
trigger out <=
end
el=e
bkegin
if(!5W_USER_1 )
trigger out <=
else 1if(!SW_USER 2 )
trigger_out <=
else if(switch_reset)
trigger out <=
el=se
trigger_out <=
end
end

Next, we will add the transfer detection signal from the Arduino. This block will require
three registers.
e transfer_write_reg —This is a latch register to hold the state of the C_Enable.
e transfer_write —This register is used to start the active_transfer single byte write
to the PC.
e transfer_write_byte —This is an 8 bit register to hold the value of the Data
Collection output.
This block will compare the input signal on LB_BYTE_B[0] to a high. The
LB_BYTE_B [0] pin is routed to Pin 3 of J5 which is routed to the C_Enable of the
Arduino Data Collector. When this bit goes high, the priority encoder goes into
statement 1 and sets transfer_write_reg and transfer_write high and latches the value on
the LB_BYTE_CJ7:0] pins to the transfer_write_byte register. By setting
transfer_write_reg high, the priority encoder goes into statement 2 which will set
transfer_write register to low and stay in statement 2 of the priority encoder. The back
to back high and low on the transfer_write register will cause the active_transfer
module to latch the value of transfer_write_byte into the active_transfer_library module
and sets up the byte transfer to the PC. When the LB_BYTE_B[0] - C_Enable pin goes
low, the encoder will reset transfer_write_reg and transfer_write to low. The encoder
goes back to waiting for the LB_BYTE_B[0] - C_Enable to assert high.
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always @ (posedge CLE 66 or negedge RST)
begin
if (!RST)
begin
transfer write reg <=
tranzsfer write <=
transfer write byte <=
TR DIR 4 <= ; /1l =R to B 0 =B to B
TRE_CE_4 <=
LE BYTE D[0] <= start stop cntrl:
LE BYIE D[7:1] <=
end
else
begin
if(LB_BYTE E[C] & !'transfer write_ reg)
begin
IR CE & <=
LE BYIE D <=
transfer write_ reg <=
transfer write <=
transfer write byte <= LB BYTE C:
end
else if(LE BYTE E[C] & transfer write_reg)
begin
transfer write reg <=
transfer write <=
end
else if(!LE BYTE B[C] & transfer write_reg)
begin
transfer write reg <=
transfer write <=
transfer write byte <=
end
else
begin
TR DIR 4 <= /1 =R toB;r 0O=EBE to R
IR CE & <=
LE_BYTE_D[C] <= start_stop cntrl;
LE_BYTE D[7:1] <= :
end
end

enci
The 8 bit transceivers are used to connect the +3.3Volt Input/Outputs of the CPLD to
the +5Volt Input/Outputs of the Arduino. These 8 bit transceivers incorporate a
Direction bit and an Output Enable bit. To guide signals from the CPLD to the Arduino,
we turn the Direction bit to “B to A”

TR_DIR_1 <= 1°b0;
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and the Output Enable on.
TR_OE_1 <= 1’b0; (Output Enables are asserted with a zero)

The start_stop_cntrl signal is set by using the TRANSFER_CONTROL state machine
in the following section.

Next, we add a TRANSFER_CONTROL state machine to read the Control Register
from the Host PC using the active_transfer EndTerm. This state machine will decode
the 8 bit control register only after a sequence of three 8 bit bytes in the order of 0x5a,
0xc3, 0x7e. The operation of the state machine is as follows.

e The TRANSFER_CONTROL state machine will stay in the idle state of the
parallel encoder until a byte from the active_transfer transfer_to_device register
receives a 0Ox5a.

e This will cause the transfer_control_state to be changed to
TRANSFER_CONTROL_HDRI1.

e The state machine will stay in the TRANSFER_CONTROL_HDR1 state until
the next byte is read from the active_transfer.

e |f the byte from transfer_to_device is a 0xc3, the transfer_control_state will be
changed to TRANSFER_CONTROL_HDR2.

e If the byte from transfer_to_device is not a Oxc3, the transfer_control_state will
go back to idle.

e Inthe TRANSFER_CONTROL_HDR?2 state , the state machine will stay in this
state until the next byte from the active_transfer is received.

e If the byte from transfer_to_device is a Ox7e, the transfer_control_state will be
changed to TRANSFER_DECODE_BYTE.

e If the byte from transfer_to_device is not a Ox7e, the transfer_control_state will
go back to idle.

e Inthe TRANSFER_DECODE_BYTE state , the state machine will stay in this
state until the next byte from the active_transfer.

e The next byte transferred from active_transfer will be decoded as the Control

Register.
The bits of the Control Register are defined below.
Register Bits Description Assertion
Control 0 Start Stop Cntrl High
1 Not Used
2 LED Reset High
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g

y

Switch Reset

Transfer In Loop Back

High
High

Not Used

Not Used

Not Used

NN OB lWw

Not Used

Control Register from Transfer In

always (@ (posedge CLE 66 or negedge R5T)
begin
if (I1R5T)
begin
transfer_in_received_reg <= H
transfer control state <= TRANSFER CONTROL_ IDLE:
transfer_in loop back <= H
led reset <= H
switch reset <= H
start_stop cntrl <= ;
end
else
begin
if(transfer in received & !transfer in received reg)
kbegin
transfer in received_reg <= H
case (transfer_ control_state)
TRRNSFER CONTROL IDLE:
if((transfer in byte =— TRANSFER_CONTROL EYTE1l))
transfer control state <= TRANSFER CONTROL HDRI1:
else if((transfer_in byte != TRRNSFER_CONTIRCL_EBYTEL))
transfer control state <= TRANSFER CONTROL IDLE:
else
transfer control state <= TRANSFER CONTROL IDLE:
TERNSFER CONTROL HDR1:

if{({transfer in byte = TRANSFER CONTROL BYTEZ))
transfer control_ state <= TRANSFER_CCONTRCL HDR2Z:
else if((transfer in byte != TRANSFER CONTROL_BYTEZ))

transfer control_ state <= TRANSFER_CCONTRCL IDLE;
else
transfer control_ state <= TRANSFER_CCONTRCL HDRL:
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TRANSFER CCONTRCL_HDR2:
if ((transfer in byte — TRANSFER CONTROL BYTE3))
transfer control state <= TRANSFER DECODE EYTE:
else if((transfer in byte != TRANSFER CONTROL_BYTE3))
transfer control state <= TRANSFER CONTROL_IDLE;
else
transfer control state <= TRANSFER CCONTROL_HDRZ;
TRANSFER_DECCDE_BYTE:
begin
start_stop_cntrl <= transfer in byte[0]:
led reset <= transfer in byte[2];
switch_reset <= transfer in byte[2]:
transfer_ in loop back <= transfer in byte[<];
transfer control state <= TRANSFER CONTROL SET:
end
TRANSFER CONTROL_SET:
begin
transfer control_ state <= TRANSFER CONTROL_IDLE:;
end
endcase
end
else if(!transfer in received & transfer in received reg)
transfer in received reg <= :

end

Next, up is the instantiation for the active_transfer_library. The ports include the input
and output pins and the two buses that connect the active modules. These buses are the
input UC_IN[23:0] and output UC_OUT[21:0].

active_serial library ACTIVE SERIAL LIBRARY INST

(

.aa (aa) ,

.UART_OUT (UART_OUT) ,

.UART_ IN (uart_txd),

.UC_IN (UC_IN),

.UC_OUT (uc_out) //,
/ .STATE OUT (active serial state out),
ko TEST_ OUT (a ::i':%_: rans fer_:est_:ut )

)
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Finally, we instantiate the Active EndTerms. For the Data Collection project, we only
need active_transfer and active_trigger EndTerms. The uc_out port for both modules
must be shared. Since they both drive this bus, a bus wide wired-or circuit is used so
that they don’t drive each other. The active_transfer EndTerm has a port for the address
(uc_addr). This allows the PC to address up to 8 different modules. Just add a three bit
address to this port and the PC must add this same address to communicate with this
module.

'f Instantiate the EFT Active Modules

wire [22%2-1:0] wuc _out_m;
eptWireOR # (.N(2)) wireOR (UC_OUT, uc out m);
active_trigger ACTIVE TRIGGER_INST
(
.uc_clk (CLE_IN),
.uc_reset (RST) ,
.uc_in (UC_IN),
/f.uc_out (UC_oUuT) ,
.uc_out (uc_out m[ O +: 1),
.trigger to_host (crigger_ out),
.trigger to_device (trigger_in byte)
)
active_ transfer ACTIVE TRANSFER INST
(
uc_clk (CLE_IN),
.uc_reset (RET) ,
.uc_in (UC_IN),
ff .uc_out (UC_0oUT) ,
.uc_out (uc_out m[ 1% +: 1),
.3tart_transfer (transfer out),
.transfer received (transfer in receiwved),
.uc addr { Y.
.transfer to host (transfer out byte),
.transfer to_device (transfer in byte)

Next, we are ready to compile and synthesize.
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7.1.9 CPLD: Compile/Synthesize the Project

The Quartus Prime application will compile/ synthesize the user code,
active_transfer_library, and the active EndTerms. The result of this step is a file
containing the CPLD code with “*.pof™. First, we need to create a project in the Quartus
Prime environment. Follow the directions in the section: “Compiling, Synthesizing, and
Programming CPLD”.

Bring up Quartus Prime, then use Windows Explorer to browse to
c:/altera/xxx/quartus/qdesigns create a new directory called: “EPT Data Collector”.

arnas
1 m

Open Quartus Prime by clicking on the icon . s -

Under Quartus, Select File->New Project Wizard. The Wizard will walk you through
setting up files and directories for your project.

Directory, Name, Top-Level Entity [page 1 of 5]

What is the working directory for this project?

C:faltera/12, 1sp1/quartus/qdesigns/EFT_Data_Collector E
What is the name of this project?

EPT_S70_AF_U2_Top )
What is the name of the top-evel design entity for this project? This name is case sensitive and must exactly match the entity name in the design file.
EPT_S70_AP_U2_Tap ()

Use Existing Project Settings...

< Back H MNext = ]l Finish H Cancel H Help
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At the Top-Level Entity page, browse to the
c:\altera\xxx\quartus\qdesigns\EPT_Data_Collector directory to store your project.
Type in a name for your project “EPT_570_AP_M4_Top”.

Follow the steps up to Add Files. At the Add Files box, click on the Browse button and
navigate to the project Data Collector install folder in the dialog box. Browse to the
\Projects HDL\EPT 570 AP_Data_ Collector \EPT_570_AP_M4 Top folder of the
EPT USB-CPLD Development System CD. Copy the files from the \src directory.
Active_transfer.vgm

Active_trigger.vgm

Active_transfer_library.vgm

eptWireOr.v

EPT 570 AP_M4 Top.v

Add the files:
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" Settings - EPT_S70_AP_M4_Top

Category:
General Files
Files
Libraries Select the design files you want to indude in the project. Click Add All to add all design files in the project directary to the project.

[N

Operating Settings and Conditions

Voltage File name: E]

Temperature
Compilation Process Settings
Early Timing Estimate . fsrcfeptireOR. Y Verilog HOL File <Mone = Default
Incremental Compilation .. ferc/EFT_570_AP_M4 Top.v Verilog HOL File <Mone > Default
Physical Synthesis Optimizations . fsrcfactive_trigger.vam Verilog Quartus Mapping File <Mone >
EDA Tool Settings .fsrcfactive_transfer_library.wgm Verilog Quartus Mapping File <Mone =
Design Entry/Synthesis ..fsrcfactive_transfer.vgm Verilog Quartus Mapping File <Mone =
Simulation
Formal Verification
Board-Level
Analysis & Synthesis Settings
VHDL Input
Verilog HOL Input
Default Parameters
Fitter Settings
TimeQuest Timing Analyzer
Assembler
Design Assistant
SignalTap II Logic Analyzer
Logic Analyzer Interface
PowerPlay Power Analyzer Settings
S5M Analyzer

File Name Type Library  Design Entry/Synthesis Tool HDL Version

[N

N

N

[ W Buy Software ] [ oK ] [ Cancel ] Apply

Continue following the instructions by adding a device and finishing the project
instantiation. Then, bring up the Pin Planner.
e Under Assignments, Select Import Assignments.

e At the Import Assignment dialog box, browse to the
\Projects HDL\EPT_ Data_Collector \EPT_5M57_AP_M4_Top folder of the
EPT USB-CPLD Development System CD. Select the Quartus Specification
file, “EPT_5M57_AP_M4_Top.qgsf” file.

e Click Ok. Under Assignments, Select Pin Planner. Verify the pins have been
imported correctly.

Next, we need to add the Synopsys Design Constraint file. This file contains timing
constraints which forces the built in tool called TimeQuest Timing Analyzer to analyze

the path of the synthesized HDL code with setup and hold times of the internal registers.
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It takes note of any path that may be too long to appropriately meet the timing
qualifications. For more information on TimeQuest Timing Analyzer, see

http://www.altera.com/literature/hb/qts/qts_qii53018.pdf?GSA_pos=1&WT.0ss_r=1&
WT.oss=TimeQuest Timing Analyzer

Browse to the

\Projects HDL\EPT _5M57_AP_M4 Data_CollectonEPT_5M57_AP_M4_Top folder
of the EPT USB-CPLD Development System DVD. Select the
“EPT_570 AP_M4 Top.sdc” file

g = | C:olly\Products\Earth People Technology\MEGAPROLOGIC_USB_CPLD_PROJECT.4.0_DVD\Projects HDL\EP
I v shae
« « 4 [ > ThisPC > Windows (C) > Jolly > Products > Earth People Technology > MEGAPROLOGIC_USB_CPLD_PROJECT 40_DVD > Projects HDL > EPT_SMS7_AP_M4 Dats_Collector > EPT_SMS7_AP_MA4_Top
MAXPROLOGIC_FPGA_ PROJECT_40_DVD A [ Name . Type Size
MEGAMAX_CPLD_SYSTEM_PROJECT.40_DVD @ e folder
MEGAMAX_CPLD_SYSTEM_PROJECT_4.5_DVD incremental_db File folder
MEGAPROLOGIC_USE_CPLD_PROJECT_4.0_DVD output files File folder
Documentation simulation File folder
{3) EPT_SMS7_AP_M4_Top.qpf QPF File 2K
] EPT_SMS7_AP_M4_Top.qsf QSF File 7KB
7] EPT_SMST_AP_M4_Top.quis QWS File 2k8
| EPT_SMS7_AP_M4_Top.sdc SDC File 4KE
Projects_ HDL ] EPT_SM57_AP_M4_Top_sssignment_defaults.qdf QDF File 55K8

EPT_5M57_AP_MA4 Dats_Collector
EPT_5MS57_AP_M4_Top
db
nnnnnnnn tal_db
output files
simulation
ModelSim

sim

test
Testbench

Copy the file and browse to c:\
intelFPGA _lite\xxx\quartus\qdesigns\EPT_Data_Collector directory. Paste the file.
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L e—

2 4

7

PLE

O g Yy

_% o[ || » Computer » Gateway(C:) » altera » 121spl » quartus b qdesigns » EPT_Data Collector » EPT_S70_AP_M4_Top » 2|
— =
Organize [ ] Open Burn New folder =~ 0 @
bin - Name ’ Date modified Type Size -
bing4 || 1 _anu_ar e 1upaiamsy 2/a4/euia Liia P 2129 FiE Lne
common || EPT_570_AP_M4_Top fit.summary 3/14/201311:28 PM  SUMMARY File 1KB
— || EPT_570_AP_M4_Top.flow.rpt 3/14/201311:28 PM  RPT File 8 KB
drivers |;| || EPT_S70_AP_M4_Top.jdi 3/14/201311:28 PM IDIFile 1KB
dsp_builder 7| L EPT 570_AP_M4 Top.map.pt 3/14/201311:28 PM  RPT File 42KB L
eda || EPT_570_AP_M4 Top.map.smsg 3/14/201311:28 PM  SMSG File 1KB
extlibe? || EPT_570_AP_M4_Top.map.summary 3/14/201311:28 PM SUMMARY File 1KB
ibrarics || EPT_570_AP_M4_Top.pin 3/14/201311:28 PM  PINFile 15KB
\mf || EPT_570_AP_M4_Top.pof 3/14/201311:28 PM  POF File 15KB
P EPT_S70_AP_MA4_Top.qpf 3/9/20138:57PM  QPFFile 2KB L
| EPT Data Collector || EPT_570_AP_M4_Top.qsf 3/10/20131:29PM  QSF File 6KB
| EPT Transfer_Test || EPT_570_AP_M4_Top.qsf.bak 013853PM  BAK File IKB
fir filter ||| EPT_570_AP_M4_Top.sde 3/3/201310:31PM  SDC File 1KB
| T || EPT_570_AP_M4_Top.sta.rpt 3/14/201311:28 PM  RPT File 138 KB
TG || EPT_570_AP_M4_Top.sta.summary 3/14/201311:28 PM  SUMMARY File 1KB A
sonc builder - |1 EPT_570_AP_M4_Top_assignment_defaul.. 3/10/20131:28PM  QDF File 56 KB =
EPT_570_AP_M4_Top.sdc Date modified: 3/3/2013 10:31 PM Date created: 3/14/2013 11:33 PM
SDC File Size: 317 KB

and select the Start Compilation button.

This will cause the compile and synthesization process. After successful completion, the

screen should look like the following:
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HDL/EPT_Data_Collector/EPT_570_AP_M4_Top/EPT_570_AP_M4_Top - .. | El-EH g

-# Quartus I 64-Bit - C:/Jolly/Products/Earth People Technol

2 Search altera.com @
NS E@ & el 9 o [rPranmenein JEY ¢S D r 7 B0 S &P ALAle
|| |Project Navigator 1ax | ig Compilation Report - EFT_570_AP_M4_Top B
Entity Table of Contents aa
/% MAX II: EPM570T100CS 5 Flow Summary Flow Status Successful - Thu Mar 14 23:28:43 2013
b Eﬁ EPT_S70_AP_M4_Top 2 Flow Settings Qua.n.:us II 54-Bit Version 12.1 Build 243 01/31/2013 5P 1 5] Web Edition
Revision Name EPT_S570_AP_M4 Top
= Flow Non-Default Global Settings Top-evel Entity Name EPT_S70_AP_M4_Top
E2 Flow Elapsed Time Family MAX II
E= Flow 05 Summary Device EPMS570T100CS
| Flow Log Timing Models Final
b [ Analysis & Synthesis Total logic elements 283570 (50 %)
> (3 Fither Total pins 61/76(80%)
Total virtual pins 1]
» [ Assembier UFM blacks 0/1(0%)
i ) > [ TimeQuest Timing Analyzer
Ay Hierarchy | E|Fles | & Design &4 Quartus T ﬂ
EEs — @ Ful Compilation was successful (41 warnings)
Flowe: [Camulahan I‘QI
« 4 B Compile Design L
« > B Analysis & Synthesis o
I « » B Fitter (Place & Route) o
« > B Assembler (Generate programming files) Of J
« > TimeQuest Timing Analysis il
» B EDA Netlist Writer
w Program Device (Open Programmer)
< T | bl 1 ] »
; @ [ﬁ T <<search>> %
Tl Type 1D Message o
> \I) 332146 Worst-case recovery slack is 7.215
> \l) 332146 Worst-case removal slack is 2.495
> \I) 332146 Worst-case minimum pulse width slack is 7.309
\D 332001 The selected device family is not supported by the report_metastability command.
\i) 332102 Design is not fully constrained for setup requirements
\D 332102 Design i3 not fully constrained for hold reguirements
> \I) Quartus II 64-Bit TimeQuest Timing Analyzer was successful. 0 errors, 5 warnings
= \l) 293000 Quartus II Full Compilation was succeasful. 0 errorsa, 41 warnings |_|
o -
gl i ,
]
= System /\_Processing (101) f
100% 00:00:13

If the synthesis fails, you will see the failure message in the message window. Note that
in addition to fatal errors, the compile process can produce “warnings” which do not
necessarily prevent execution of the code but which should be corrected eventually.

At this point the project has been successfully compiled, synthesized and a
programming file has been produced. See the next section on how to program the
CPLD.

7.1.10 CPLD: Program the CPLD

The final step is programming the “*.pof” file into the CPLD. Follow the section:
“Programming the CPLD”.
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—-_—,

Connect the MegaProLogic to the PC,

Open up Quartus Prime,

Open the programmer tool

In the upper left corner of the Programmer Tool, there is a button labeled
“Hardware Setup”. Verify that EPT-Blaster v1.0b” has been selected. If not,
go to the section JTAG DLL Insert to Quartus Prime and follow the
directions.

e Check the box under Program/Configure

e Click the Start button.

When the programming is complete, the Progress bar will indicate success.
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:@ Programmer - Ci/Jolly/Products/Earth People Technology/EPT USB-CPLD Development System CD/Projects HDL/EPT Data Collect... l o[ e

File Edit View Processing Tools  Window Help 5 Search altera.com ‘{_')

2, Hardware Setup...| EPT-Blaster v1.30 [MBUSB-0] Mode: |ITAG - Progress: 100% (Successful)

[ Enable real-time ISP to allow background programming (for MAX 1T and MAX V devices)

EET— File Device Checksum Usercode Program/ Verify Blank- Examine Secul
Il Start Configure Chedk Bi
EPT_570_AP_M4_Top.pof EPM570T100 00313403 FFFFFFFF ]

A
£ @ B O
3 auto Detect LM (o] ]
 Delete
[ Add File...
P
| Change File. .. v — .
Al Save File pr
[ Add Device...
fhu : AOERAE
40 Down _— E| v E _‘

#ill Stop

At this point, the MEGAPROLOGIC is programmed and ready for use.

7.1.11 PC: Design the Project

The final piece of the Data Collection Sampler is the PC application. This application
will fetch the data from the CPLD of the MEGAPROLOGIC and display it on the

screen. It includes user code, windows form, and the Active_Host DLL.

ACTIVE_TRANSFER = =
- s DATA RCVD ——
— EVENT! =)
woressZ1| ¥ ol A Y 4. B VT

ACTIVE_TRANSFER _ ACTIVE_HOST
LIBRARY DLL

The Active_Host DLL is designed to transfer data from the CPLD when it becomes
available. The data will be stored into local memory of the PC, and an event will be
triggered to inform the user code that data is available from the addressed module of the
CPLD. This method, from the user code on the PC, makes the data transfer transparent.
The data just appears in memory and the user code will direct the data to a textbox on
the Windows Form.

The Data Collector project will perform the following functions.
e Find MEGAPROLOGIC Device.
e Open MEGAPROLOGIC Device.
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e Start the Arduino data collection process.
e Wait for data from MEGAPROLOGIC.
e Display data from MEGAPROLOGIC in textbox.

7.1.12 PC: Coding the Project

The user code is based on the .NET Framework and written in C#. The language is great
for beginners as it is a subset of the C++ language. It has the look and feel of the
familiar C language but adds the ease of use of classes, inheritance and method
overloading. C# is an event based language which changes the method of writing code
for this project. See the section “Assembling, Building, and Executing a .NET Project
on the PC” for a better description of event based language programming.

To start the project, follow the section “Assembling, Building, and Executing a .NET
Project on the PC”. Use the wizard to create project called “Data_Collector”. When the

wizard completes, the C# Express main window will look like the following.
-lusing bystem;

using System.Drawing;

using System.Collections;

using System.Windows.Forms;

using System.Data;

using System.Threading;

using System.Runtime.InteropServices;
using System.Diagnostics;

-Inamespace Data_Collector

1

- public partial class Data Cocllector : System.Windows.Forms.Form

{

+ public Data_[nllectnr()[::

These statements setup the namespace and the class for the project. There are several
other files that are created by the wizard such as Form1.Designer.cs, Program.cs,
Form1.resx. We don’t need to go into these support files, we will just focus on the
Forml.cs as this is where all the user code goes.

The project environment must be set up correctly in order to produce an application that

runs correctly on the target platform. Visual C# Express defaults new projects to 32 bits.
If you OS is a 64 bit platform, use the following directions to set up a 64 bit project.
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First, we need tell C# Express to produce 64 bit code if we are running on a x64
platform. Go to Tools->Settings and select Expert Settings

Data_Collector - Microsoft Visual C# 2010 Expres
File Edit View Project Build Debug Data Tools | Window Help
Pedi- S a4 2 ]9 - @ - T Connectto Database... -|| (3 EPT_570_8P Dats Collector - || 53l 7 (39 5 BB

Solution Explorer

‘ & (2] Choose Toolbox Items...

; Solution 'Data_Collector' {1 project) E‘& Extension Manager...
4 (] Data_Collector s€) ~|  Platform: | Active (x86) -

External Tools...

% (& Cade Snippets Manager... e FormlDesignercs  Formlics  Forml.cs [Design]

> [=d| Properties

s32unog eeq 1l %0q|oo] .

> [:3] References Settings v Basic Settings
5] active transfer.cs Customize... v Expert Settings
4 [E] Forml.cs
%) Forml.Designer.cs . L=k
= [ Define DEBUG constz .
+
] Program.cs Resources Import and Export Settings...
Define TRACE constant
Setti
e Allow unsafe code
Reference Paths Optimize code
Signing Errors and wamings
sy Waring s

Recent files

4 Environment

General M) | items shown in Window menu
Fonts and Colors
Keyhoard 10 iterns shown in recently used lists
» Text Editor
» Debugging Visual experience

[#] Automatically adjust visual experience based on client perfformance
Enable rich client visual experience

Use hardware graphics acceleration if available

Visual Studio is currently using hardware-accelerated rendering. The visual
experience settings automatically change based on system capabilities.

Show status bar
Close button affects active tool window enly
[] Aute Hide button affects active toel window only

Restare File Associations
(| show all settings [ oK ] [ Cancel I

In the window on the left, go to “Projects and Solutions”. Locate the “Show advanced
build configurations” check box. Check the box.
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Options I | ? = |
. Environment Projects location:
4 Projects and Solutions c\users\nelsonstrfgridocumentsiwvisual studic 2010\Projects E]
General .
Build and Run User project templates location:
. Text Editor chusers\nelsonstrfgridocumentsivisual studio 2010\Templates\ProjectTemp E]
» Debugging User item templates location:
> Database Tools clusers\nelsonstrfgridocumentsivisual studic 2010\ Templates\ItemTemplat E]
» Text Templating
» Windows Forms Designer Always show Error List if build finishes with errors
Fl1 slbens |
Always show solution
[7] Save new projects when created
Warn user when the project location is not trusted
[7] Show Output window when build starts
Prompt for symbolic renaming when renaming files
[¥] Show all settings [ 0K ] l Cancel

————— =

Go to Build->Configuration Manager.

File Edit View Refactor Project | Build Debug Window Help
TalEb = N IR Build Solution 6 86 - @ [t
5 3 o B A 2 B Rebuild Solution

Solution Explorer

| | §| Bl= Configuration Manager... Lo

Data Tools

v

% Publish Data_Collector

; Solution 'Data_Collector' (1 project) //Parameters
Pl _E Data_Collector public const byte TRIGGER_OUT_COMMAND =

public const byte TRANSFER_OUT_COMMAND =

> [Zd] Properties
public const byte BLOCK_OUT_COMMAND = @x

» ] References
E active_transfer.cs
4 [E Formles // Main object loader

‘%] Forml.Designer.cs = private void Data_Collector_Load (object
] Program.cs { -

/I Call the List Devices function
ListDevices();

// Main connection function

RN A G U Y

In the Configuration Manager window, locate the “Active solution platform:” label,
select “New” from the drop down box.
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Configuration Manager

Active solution configuration: Active solution platform:

[Release '] Enﬂﬁ 'J
. . #B6
Project contexts (check the project configurations to build or dep
Project Cenfiguration <Edit...>
Data_Collector Release lz‘ B6 lz‘

Close

In the New Solution Platform window, click on the drop down box under “Type or
select the new platform:”. Select “x64”.

=
Configuration Manager —
-

Active solution configuration: Active solution platform:

[Release '] [xBG ']
Project contexts (check the project configurations to build or deploy):

Data_Collector

Type or select the new platform:

o

Any CPU
Itanium
El——

Create new project platforms

[ o ][ cencer |

Close

Click the Ok button. Verify that the “Active Solution Platform” and the “Platform” tab
are both showing “x64”.
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Canfiguration Manager @g

Active solution configuration: )mh@rm:
Release A [xﬁél \ ']

Project contexts (check the project configurations to bui\dér deploy): \
Project Configurati Platform Build
Data_Collector Release E‘ 04 lz‘

Close

Click Close.
Then, using the Solution Explorer, you can right click on the project, select Properties
and click on the Build tab on the right of the properties window.

W Solution Explorer M [ cctive_transfer.cs  Forml..cs [Design]
Elsinllel= 3 Data_Collector.Data_Collector ~| @ TRIGGER_OUT_COMMAND
-4 Soluticn 'Data_Collector' (1 project) //Parameters
4 [ Data_Collectar nublic const byte TRIGGER_OUT_COMMAND = @x1;
> =i Prop Y Build ublic const byte TRANSFER_OUT_COMMAND = @x2;
. [ Refel o ublic const byte BLOCK OUT COMMAND = @x4;
El 2t @ publish...
4 Elform = , ¥ Main object loader
=L rivate void Data_Collector_Load (cbject sender, System.Eventirgs e)
@] Prog  Add Reference... -

Add Service Reference...
// €all the List Devices function

Set as StartUp Project ListDevices();

Debug 3

% Cut Ctrl+X

4 Paste Ctrl+V Main connection function

'l [ Del rivate unsafe Int32 ListDevices()
i Tnt32 result;

[ Properties Alt+Enter Tnt32 num_devices;

Int32 iCurrentIndex;

// Open the DLL
result = EPT_AH Open(null, null, null);
if (result I= @)

{

Verify that the “Platform:” label has “Active (x64)” selected from the drop down box.
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Solution Explorer

~ Solution 'Data_Collector' (1 project) Application
4 (@ Data Collector Configuration: | Active (Release) | Platform: [Active (64) -
Build

~ 1 x (ISR rormi.cs  active transfercs  Formil.cs [Design]

. [ Properties
>[5 References G |

E'II active_transfer.cs e e
4 [E] Forml.cs

Conditional compilation symbols: |

F Debug
%] Forml Designer.cs [7] Define DEBUG constant
@) Program.cs Resources
Define TRACE constant
Settings.
g Allow unsafe code
Reference Paths Optimize code
Signing Errors and warmings
S Warming leve

Publish N :

nnnnnnnnnnnnnnnnn

Next, unsafe code needs to be allowed so that C# can be passed pointer values from the
Active Host. Right click on the “Data Collector” project in the Solution Explorer. Select
Properties.

File Edit View Project Build Debug Data Tools Window Help

;ﬂJ'LjHﬂ|:‘3 —_1_'H’||'J1 .ru-\::j-_‘:'l)|p

B afFlEs|Z2|083a53 Q.
V2*W Solution Explorer MY Data_Collector active_transfer.cs Forml.Designer.cs
= =
2 '-._é|| éj E ‘)LgData_Cc:Hectcr.Data_CcHectcr
E— ; Solution 'Data_Collector' (1 project) —lusing System;
* 4 _E Data_Collec*~ ucina Sustam, Collections.Generic;
= . = Properti [ Build .ComponentModel;
e » i3l Referenc Rebuild .gata%
g #] active_tr .% Publish 'L;:\"J-”E;
g A I .
A 4[] Forml.c T qf
a i Add p BText;
‘#] Forn .Windows.Forms;
] Program Add Reference... .Threading;
Add Service Reference... .Runtime.InteropServices;
X .Diagnostics;
Set as StartUp Project
Debug » ita_Collector
% Cut G artial class Data_Collector : F
4 Paste Ctrl+V
X Remove Del ic Data_Collector()
Rename InitializeComponent();
= Properties Alt+Enter

for (int i = @; i < EPTTransmit

EPTTransmitDevice[i] = new

}

Now we are ready to start coding.

Next, we add two classes for our device. One class stores the information useful for our
device for Transmit to the EndTerms such as, address of module, length of transfer etc.

Page

188



@ !EAR'I;HPEPPLE
8 © n o O g Yy

USB CPLD Development System User Manual

f//Create an array of the Transfer Class for device
Transfer[] EPTTransmitDevice = new Transfer[8];

The next class is used to store parameters for receiving data from the device.

f//Create a Receive object of the Transfer Class.
Transfer EPTReceiveData = new Transfer();

The first function called when the Windows Form loads up is the
Data_Collector_Load(). This function is called automatically upon the completion of
the Windows Form, so there is no need to do anything to call it. Once this function is
called, it in turn calls the ListDevices(). Use the function List Devices() to detect all
EPT devices connected to the PC.

JJJJJJ

int Index = 8, EPTgroupNumber = 9;

Get 3 list of serial port names.
string[] ports;

ports = 1 t.GetPorthames();
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if (names.Count > ()
{
foreach (String port in ports)
{
f/Compare port name with the found VID/SPID
ffeombinations. Rdd them to Matching port list
/fand comboDevlist
if (names.Contains(port))
{
MatchingComPortlist[Index] = port:

if (Index == 0}

{
PortText "EFT JIAG Blaster " + EFTgroupNumber;
Index++;

1

else

{

PortText "EFT Serial Communications ™ + EPTgroupNumber++;
Index++;

}
crkDevlist.Items.Add (PortIext)

}

else

MessageBox.Show ("No EPT Devices found!™):

The ListDevices() function calls the
ports = SerialPort.GetPortNames();
to determine the Serial devices attached to the PC. Next,

if (names.Contains(port))

is called inside a for loop to return the ASCII name of each Serial device attached to
the PC. It will automatically populate the combo box, cmbDevList with all the EPT
devices it finds.

cmbDevList.Items.Add(PortText);

The user will select the device from the drop down combo box. This can be seen when
the Windows Form is opened and the cmbDevList combo box is populated with all the
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devices. The selected device will be stored as an index number in the variable

device_index.

o=l EPT Transfer Test

w Cpen

EPT JTAG Blaster O

EPT Serial Communications 0
TransrerCartmons

In order to select the device, the user will click on the “Open” button which calls the

OpenSerialPortl()

function. The device_index is passed into the function. If the function is successful, the
device name is displayed in the label, labelDeviceCnt. Next, the Open button is grayed
out and the Close button is made active.

public bool OpenSerialPortl()

{
try
{

[/5et the seri
serialPort_AH.
serialPort_AH.
serialPort_AH.
serialPort_AH.
serialPort_AH.
serialPort_AH.

al port par
PortMame =
BaudRate =
Parity = (P
DataBits =
StopBits =
Handshake =

am=ters

Porthame;

Convert.ToInt32(BaudRate);

arity}Enum.Parse(typeof({Parity), vParity);

Convert.Tolntlé(DataBits);
(5topBits)Enum.Parse(typeof(5topBits), StopBits);
(Handshake )Enum. Parse(typeof(Handshake), pHandshake);

if (!serialPort_aH.IsOpen)

serialPort_AH.Cpen();
btnOpenDevice.Enabled = false;
btnCloseDevice.Enabled = true;
/ ftextBoxl.ReadOnly = false;

return true;

¥
h

catch (Exception ex)

i

MessageBox.Show(ex.Message);

¥

return false;
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When EPTReadFunction() callback is called and passed parameters from the Active
Host dll, it populates the EPTReceiveData object. It then calls EPTParseReceive()

function. This function uses a case statement to call the TransferOutReceive() function.
private wvoid EPTParseReceive()

{
switch (EPTReceiveData.Command)
{
case TRANSFER_OQUT _COMMAND:
TransferOutReceive();
break;
default:
break;
¥
¥

TransferOut Receive() creates a string from the EPTReceiveData.Payload parameter.
Then sends the string to the textbox, tbDataBytes.

public woid TransferOutReceive()

i
string WriteRcwChar = "";
WriteRcvChar = String.Format("{@}", (int)EPTReceiveData.Payload);
thDataBytes.AppendText(WriteRcwChar + " ")

h

Controls such as buttons are added to the Form1.cs[Design] window which allow
turning on and off signals. These include
e btnWriteByte
btnTransferReset
btnOk
btnClose
btnResetBlock

Refer to section 6.1.4 Adding Controls to the Project for details about using the
ToolBox to place controls on a design. The btnWriteByte click event calls the
EPT_AH_SendTransferControlByte(). This function is used to turn on/off bits in the
Control Register in the CPLD code. The btnWriteByte will set the start_stop_cntrl
signal in the CPLD to one. This signal starts the Arduino Data Collector sending its
random word to the CPLD.
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private wvoid btnWriteByte Click{cbject sender, Eventirgs e)
1
int address_to_device;
address_to_device = Convert.ToInt32(tbAddress.Text);
EPT_AH SendTransferControlByte((char)2, (char)l);

}

The btnTransferReset sets the start_stop_cntrl bit in the Control Register to zero. This
action will cause the Arduino Data Collector to stop sending the random word to the
CPLD.
private void btnTransferReset_Click({object sender, Eventhrgs e)
1
int address_to_dewvice;
address_to_device = Convert.ToInt32(tbAddress.Text);
EPT_AH SendTransferControlByte((char)address_to_dewvice, (char)@);

}

The btnResetBlock button will clear the toDataBytes textblock. The Clear() method is
inherited from the textbox class.
private woid btnResetBlock Click(cbject sender, Eventar

1
¥

The btnOk and btnClose buttons are used to end the application. It calls the function
EPT_AH_CloseDeviceBylndex() to remove the device from the Active Host dll. The
buttons btnOpen and btnClose have their Enabled parameter set to true and false
respectively. The Enabled parameter controls whether the button is allowed to launch an
event or not. If it is not enabled, the button is grayed out. At the end of each click event,
the Application.Exit() method is called. This exits the form.

gs e)

thDataBytes.Clear();

Page

193



@ TEAR'I;HPEl()PLE
e C i o g Yy

USB CPLD Development System User Manual

private woid btnOk Click{cbject sender, Eventirgs e)
1
EPT_AH CloseDeviceByIndex(device index);
btnOpenDevice.Enabled = true;
btnCloselevice.Enabled = false;

lblDeviceConnected. Text = "
Application.Exit();

¥

}
private woid btnCancel Click({cbject sender, Eventirgs e)
1
EPT_AH CloseDeviceByIndex(device index);|
btnOpenDevice.Enabled = true;
btnCloselevice.Enabled = false;
lblDeviceConnected.Text = "";
Application.Exit();
}

This is all that is needed for the Data Collector project. The Arduino will generate a
random 8 bit word. It then transmits that word to the CPLD using the A0
(WRITE_ENABLE) signal. The CPLD transmits the 8 bit word to the PC using the
ACTIVE TRANSFER module of the Active_Transfer Library. The dll reads the 8 bit
word into local memory. It then calls the Callback function, EPTReadFunction. The 8
bit is finally displayed to screen using the MessageBox.Show().

7.1.13 PC: Compiling the Active Host Application

Building the Data_Collector project will compile the code in the project and produce an
executable file. It will link all of the functions declared in the opening of the
Data_Collector Class with the Active Host dll. The project will also automatically link
the FTD2XX.dll to the object code. Follow section: Assembling, Building, and
Executing a .NET Project on the PC. Browse to the
\Projects_ActiveHost_xxBit\EPT_Data_Collector \Data_Collector\ folder of the EPT
USB-CPLD Development System CD. Copy the following files into the project.

e Active_transfer_xxx.cs

e Data_Collector.csproj

e Data_Collector.csproj.user

e Forml.cs
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e Forml.Designer.cs
e Program.cs
To build the project, go to Debug->Build Solution.

=4 Data_Collector - Microsoft Visu. Exp

File Edit View Refactor Project Build @ Debug Data Tools Window Help
kR == W= N REEEN Build Solution F6 || |68 ~| | (# |btnOp
P R A O | === Y Rebuild Solution

%l Publish Data_Collector

Solution Explorer

B | 5 (2] | == Configuration Manager... Lo Te
g Solution 'Data_Collector' (1 project) —lusing System;
4 _E Data_Collector using System.Collections.Generic;

using System.ComponentModel;
using System.Data;
) ing System.Drawing;
E active_transfer.cs Ezi:g Sizt:: L;:::}ng'
- H
4 Q.Forml.cs . using System.Text;
%] Forml.Designer.cs using System.Windows.Forms;
] Program.cs using System.Threading;
using System.Runtime.InteropServices;
using System.Diagnostics;

> [=d| Properties
> [+3] References

sa2unog ejeq 1l x0q|oo] .

—Inamespace Data_Collector

{

= public partial class Data_Collector : Form

{

= public Data_Collector()

InitializeComponent();

The C# Express compiler will start the building process. If there are no errors with code
syntax, function usage, or linking, then the environment responds with “Build
Succeeded”.

Find Results

SEESIEY L

F_‘; Error List _ﬂ Find Results

Build succeeded

If the build fails, you will have to examine each error in the “Error List” and fix it
accordingly. If you cannot fix the error using troubleshooting methods, post a topic in
the Earth People Technology Forum. All topics will be answered by a member of the
technical staff as soon as possible.

At this point, the environment has produced an executable file and is ready for testing.
Next, we will connect everything together and see it collect data and display it.
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7.1.14 Connecting the Project Together

Now we will connect the Arduino, EPT 570-AP-M4, and the PC to make a Data
Collector. First, connect a USB cable from a USB port on the PC to the Arduino.

‘ Look in: Arduino_Data_Colector_Code > 02 @

Name - Date modified Type
~» | Arduino_Data_Collector_Code.ino 10/23/20128:31 AM  INO File

i

Select the file and click Open. The sketch will now populate the Arduino IDE window.
Compile and Download the sketch into the Arduino microcontroller using the Upload
button.
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. .
Arduino_Data_Collector Code_M4 | Arduing | 5 S
— N

File Edit Sketch Tools Help

Arduino_Data_Collector_Code_M4
J,-’*
Copyright Earth People Technology Inc. 2013

»

Data Collector Random Seed

Platform: EFT-570-4F-Md

m

*

int startStopBit = 0;
int count = 0;

int ledPin = 13;

int inPing = 19;

int C_Enahle = 37;

woid setup()

i
DDR4 = E11111111; //%et Port A as outputs
PORTA &= BL1111111; //Turn on Port 4 pins

pinMode (C_Enable, OUTPUT):
pinMode (ledPin, OUTPUT):
pinMode (inPing, OUTPUT):

Arduine Uno on COM

The Arduino IDE will compile the project, then transmit the machine level code into the
ATMega328 SRAM to start the program. When this is complete, the Yellow L LED
will blink about once per second.
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If this LED is blinking at the rate of once per second, the Arduino and the Data
Collector project are ready for the EPT 570-AP-M4 code.

The CPLD should already be programmed with its Data Collector Project. If it isn’t,
follow the instructions in section 3.1.10.

Open the EPT Data Collector on the PC by browsing to the Data Collector project
folder. Locate the executable in the \bin\x64\Release folder.

T Ne——
@uv . % EPT USB-CPLD Development System CD » Projects_ActiveHost 84Bit » EPT_Data_Collector » Data_Collector » bin » x54 » Release v |
— =
Organize * Open Share with » Burn New folder
EPT USB-CPLD Development System CD ~ Name ’ Date modified Type Size
Arduino_IDE = . n q =7
| |%| ActiveHost4.dll 3/2/2013 9:44 PM Application extens... 27T KB
Documentation
- |[=1 Data_Collector.exe 3/3/20131231 AM  Application 15 KB
rivers
& Data_Collector.pdb 3/3/20131231 AM  Program Debug D... 40KE
Projects_ActiveHost_32Bit R R . ~
) 5] Data_Collector.vshost.exe 3/3/201312:18 AM  Application 12KB
Projects ActiveHost_64Bit .
|| Data_Collector.vshost.exe.manifest 8/31/2009 12:40 AM  MANIFEST File 1KB
ActiveHost 1.00.8 .
L (%] ftdZod4.dll 1/18/2013 3:54 PM Application extens... 252KB
. EPT_Data_Collector
Data_Collector 3
bin b
| Debug
Release
 xo4
Release
obj
Properties
. EPT_ Transfer_Test <
")l Data_Collector.exe State: 2B Shared Size: 150 KB Shared with: Homegroup
. Application Date modified: 3/3/201312:31 AM Date created: 3/3/2013 12:37 AM

Initiate the application by double clicking the application icon in the \Release folder of
the project. The application will open and automatically load the Active Host dil. The
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application will locate the EPT_5M57-AP-M4 device. Next, the combo box at the top
will be populated with the name of the device.

o5 Data Collector El@

EPT USB <-> JTAG&Serial Cable B
Cpen Close

Receive Byte i 2

Select the EPT-5M57-AP device and click the Open button. If the Active Host
application connects to the device, a label will indicate “Device Connected”. Next,
select the address of the Active Transfer module in the CPLD. In our case it is “2”.

ac’ Active Host =N B =

EPT USB <-> JTAG&Serial Cab Device Connected

| Cpen | | Close |

Address 2

Received Data Start Stop

QK Cloze

]
f

7.1.15 Testing the Project

To test our Data Collector project, just click on the Start button. As soon as the device
connects, the data from the Arduino will appear in the received data textBox.
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o5 Active Host o || = || 23

EPT USB <-> JTAG&Serial Cab  Device Connected

e GDS_E Address 2
Received Data Start Stop

o
36
Ta
ce
15
T8

QK Close

And that’s all there is to the Data Collector Project. It’s up to the user to use this project
as a base to create much larger projects. You can easily make a volt meter using this
project by turning off the Random number generator in the Arduino and reading the

Analog Pins. Also, reformat the textBox display that it shows in decimal instead of the
Hexadecimal display.
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APPENDIX |
List of Abbreviations and Acronyms
EPT Earth People Technology
FIFO First In — First Out
FTDI Future Technology Device International
HSP Hyper Serial Port
12C Inter-Integrated Circuit
JTAG Joint Test Action Group
PC Personal Computer
CPLD Complex Programmable Logic Device
USB Universal Serial Bus
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